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Preface 

Overview 

Thank you for choosing INVT Flex series I/O system. 

INVT Flex series I/O system is a flexible, reliable, and efficient signal transmission system with a more 

reliable structural design. The system is able to access to multiple standard communication networks, 

respond in microseconds, and equipped with rich signal modules to meet various industrial automation 

needs while saving cabinet space, helping you develop more competitive personalized solutions. 

 

Target audience 

Personnel with electrical professional knowledge (such as qualified electrical engineers or personnel with 

equivalent knowledge). 

 

About documentation obtaining 

In addition to this user guide, you can also obtain product documentation and technical support from our 

website: 

Visit www.invt.com, choose Support > Download, enter a keyword, and click Search. 

 

Change history 

The manual is subject to change irregularly without prior notice due to product version upgrades or other 

reasons. 

No. Change description Version Release date 

1 First release. V1.0 September 2023 

2 

 Added description information to section 2.1.1.4. 

 Added section 2.3 EtherNet/IP communication 

coupler. 

 Added expansion module content to sections 3.1.2, 

3.2.2, 3.3.2, and 3.9. 

 Added FK1200 related content to section 4.2.1.1. 

 Added five 32-point module models to section 

4.2.2.1. 

 Added PROFINET communication coupler to 

section 5.4.1. 

 Added terminal definition and wiring content to 

sections 5.4.2.2, 5.4.3.2, 5.4.4.2, and 5.4.10. 

 Updated chapter 6 Communication coupler 

configuration. 

 Added chapter 8 EtherCAT functions. 

V1.1 August 2024 

3 

 Added section 2.4 ModbusTCP communication 

coupler. 

 Added section 6.4 ModbusTCP configuration 

 Added sections 6.1.1.9 Counting and 

measurement module (FL6002), 6.1.1.10 Counting 

and measurement module (FL6112), 6.1.1.11 

Counting and measurement module (FL6121) 

V1.2 January 2025 

https://www.invt.com/
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No. Change description Version Release date 

 Added sections 6.2.1.12 Analog input 

module—FL3404(8ADV), 6.2.1.13 Analog input 

module—FL3504(8ADI), 6.2.1.17 Counting and 

measurement module—FL6002-2ES, 6.2.1.18 

Counting and measurement module—FL6112-2EI, 

and 6.2.1.19 Counting and measurement 

module—FL6121-1EI. 

 Added chapter 7 Common functions of Ttools-IO 

software. 

 Added appendix A Address mapping table 

instructions 
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1 Safety precautions 

1.1 What this chapter contains 

Read this manual carefully and follow all safety precautions before moving, installing, operating and 

servicing the active power filter. Otherwise, equipment damage or physical injury or death may be caused. 

We shall not be liable or responsible for any equipment damage or physical injury or death caused due to 

failure to follow the safety precautions. 

1.2 Safety level definition 

To ensure personal safety and avoid property damage, you must pay attention to the warning symbols and 

tips in the manual. 

Warning 

symbols 
Name Description 

 Danger 
Severe personal injury or even death can result if related requirements 

are not followed. 

 Warning 
Personal injury or equipment damage can result if related requirements 

are not followed. 
 

1.3 Personnel requirements 

Trained and qualified professionals: People operating the equipment must have received professional 

electrical and safety training and obtained the certificates, and must be familiar with all steps and 

requirements of equipment installing, commissioning, running and maintaining and capable to prevent any 

emergencies. 

1.4 Safety guidelines 

General principles 

 

 Only trained and qualified professionals are allowed to carry out related 

operations. 

 Do not perform wiring, inspection or component replacement when power 

supply is applied. Ensure that all the input power supplies are disconnected 

before wiring and inspection. 

 The product design is applied to indoor electrical environments at overvoltage 

category II. Ensure that the power supply system of the product has lightning 

protection devices to prevent lightning overvoltage from being applied to the 

power input or signal I/O terminals of the product so as to avoid equipment 

damage. 

 Do not modify the product unless authorized; otherwise fire, electric shock or 

other injury may result. 

 Prevent cables and other conductive parts from falling into the product. 

 Do not contact the product with damp objects or body parts. Otherwise, electric 

shock may result. 
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Delivery 

 

 Select appropriate tools for product delivery, and take mechanical protective 

measures like wearing safety shoes and working uniforms to avoid personal 

injury. 

 Protect the product against physical shock or vibration. 
 

Installation 

 

 Do not install the product on inflammables. In addition, prevent the product from 

contacting or adhering to inflammables. 

 Do not run a damaged or incomplete product. 

 

 Install the product in a lockable control cabinet of at least IP20, which prevents 

the personnel without electrical equipment related knowledge from touching by 

mistake, since the mistake may result in equipment damage or electric shock. 

Only personnel who have received related electrical knowledge and equipment 

operation training can operate the control cabinet. 

 During installation, ensure that the modules are tightly connected and fastened. 

Insecure connection may cause problems such as communication failure and 

fall-off. 

 After installation, ensure that there are no obstructions on the vents of the 

product; otherwise, the chips of the product may be burned due to overheating 

and poor heat dissipation, which causes system control failure and misoperation. 
 

Wiring 

 

 Before wiring, clearly understand the necessary information including interfaces, 

power supply types, and specifications, and comply with relevant standards and 

requirements to ensure that the system wiring is correct. 

 To ensure personal safety and equipment use safety, reliably ground the product 

using cables with proper diameters and specifications. 

 Route the control signal and communication signal cables separately from cables 

with strong interference such as power cables. 

 Apply fastening means to long-distance or heavy cables. 

 

 Cut off all power supplies connected to the product before performing wiring. 

 Before power-on for running, ensure that each module terminal cover is properly 

installed in place after the installation and wiring are completed. This prevents a 

live terminal from being touched. Otherwise, physical injury, equipment fault or 

misoperation may result. 

 Install proper protection components or devices when using external power 

supplies for the product. This prevents the product from being damaged due to 

external power supply faults, overvoltage, overcurrent, or other exceptions. 
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Commissioning and running 

 

 Before power-on for running, ensure that the working environment of the 

product meets the requirements (See section 4.1.2 Installation environment and 

site for details), and a protection circuit has been designed to protect the product 

so that the product can run safely even if an external device fault occurs. 

 When the output units such as relays and transistors of the product are damaged, 

the output cannot be controlled to be On or Off as configured. 

 For modules or terminals requiring external power supply, configure external 

safety devices such as fuses or circuit breakers to prevent damage caused due to 

external power supply or device faults. 

 In the external circuit of the product, configure an emergency braking circuit, a 

protection circuit, a circuit for interlocking between forward and reverse 

operations, and an anti-equipment-damage switch for interlocking between the 

position upper limit and lower limit. 

 To ensure the safe running of equipment, design external protection circuits and 

safety mechanisms for output signals related to major accidents. 

 Design proper external control circuits to ensure the proper running of 

equipment, since outputs may be out of control when the control circuit has an 

exception. 

 

Maintenance and component replacement 

 

 Keep the product and its parts and components away from combustible 

materials and ensure they have no combustible materials adhered. 

 Before carrying out product maintenance or component operations, cut off all 

power supplies connected to the product. 

 Prevent the screws, cables and other conductive parts from falling into the 

product during maintenance or component replacement. 

 During maintenance and component replacement, take proper anti-static 

measures on the product and its internal parts. 

Note  Use proper torque to tighten screws. 
 

Disposal 

 

 The product contains heavy metals. Dispose of a scrap product as industrial 

waste. 

 

 Dispose of a scrap product separately at an appropriate collection point but not 

place it in the normal waste stream. 
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2 Communication coupler specifications 

2.1 EtherCAT communication coupler 

2.1.1 FK1100 

2.1.1.1 Basic information 

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

FK1100
EtherCAT  coupler    /24VDC

SN:I06228000058
Ver:A.BB.CC

Power supply for
unwired terminalUnit power supply

24V 24V

0V 0V

PE PE

 
 

Model Ordering code Description Applicable model 

FK1100 11016-00005 
Communication coupler, EtherCAT; 

4VDC; RoHS 

Applicable to INVT and third-party 

EtherCAT master devices 
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2.1.1.2 Component description 

Status 
indicator

Type-C 
interface

EtherCAT 
interface

24V power 
interface

 
 

Interface Definition 

Status indicator 

PWR: Power indicator 

(Green) 

Off The power connection is abnormal. 

On The power connection is normal. 

RUN: Run indicator 

(Green) 

Off 
The communication coupler module is in 

INIT state. 

Blinking 
The communication coupler module is 

Pre-Operational state. 

Single 

flash 

The communication coupler module is in 

Safe-Operational state. 

On 
The communication coupler module is 

Operational state. 

ERR: Fault indicator 

(Red) 

Off 
The EtherCAT communication is in normal 

state. 

Blinking 

A status conversion command that cannot 

be executed has been received through the 

EtherCAT communication. 

Single 

flash 

The network is disconnected, and the 

communication coupler module 
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Interface Definition 

encounters a synchronization error. 

Double 

flash 

A Watchdog error occurs to the EtherCAT 

communication. 

SF: Fieldbus fault 

indicator (Red) 

Off The equipment running is normal. 

Blinking Configuration error occurs. 

On 
A communication coupler FPGA fault 

occurs. 

USB type-C 

interface 
Used for single board software upgrade 

EtherCAT 

interface 

IN: EtherCAT input port 

OUT: EtherCAT output port 

24V power 

interface 
24VDC power input interface of module 

 

2.1.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

24V - - 24V 

0V - - 0V 

 
- - 

 

 

 Terminal wiring 

Unit Power 
supply

(24VDC)

Power supply for 
unwired 
terminal

24V24V

0V 0V
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2.1.1.4 Hardware specifications 

Item Specification 

Rated input voltage 24VDC (20.4VDC–28.8VDC) 

Rated input current 0.8A (Typical value at 24VDC) 

Backplane fieldbus 

output rated voltage 
5VDC (4.75VDC–5.25VDC) 

Backplane fieldbus 

output rated current 
2.5A (Typical value at 5VDC) 

Isolation The input power is not isolated. 

Power supply 

protection 
Protection against overcurrent, reverse connection, and surges 

 

2.1.1.5 Software specifications 

Item Specification 

Alias access 

Supporting EtherCAT alias access and site alias setup on backend. Alias 

range: 1–65535 

Note: The expansion modules connected behind the EtherCAT 

communication coupler do not support alias access or setup. 

Quantity of input PDO Up to 768 bytes 

Quantity of output 

PDO 
Up to 768 bytes 

Input mailbox size Up to 128 bytes 

Output mailbox size Up to 128 bytes 

Max. number of 

expansion modules 
16 

Supported min. 

synchronization 

period 

512μs 

 

2.1.1.6 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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2.2 PROFINET communication coupler 

2.2.1 FK1200 

2.2.1.1 Basic information 

QC

PASSo H SR

i

Shenzhen INVT Electric co.,Ltd
www.invt.com Made in china

FK1200
PROFINET  Coupler  /24VDC

SN:I06228000058

Power supply for
unwired terminalUnit power supply

24V 24V

0V 0V

PE PE

 
 

Model Ordering code Description Applicable model 

FK1200 11016-00012 
Communication coupler, PROFINET, 

24VDC; RoHS 

Applicable to PROFINET master 

devices 
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2.2.1.2 Component description 

Status 
indicator

Type-C 
interface

PROFINET 
interface

24V power 
interface

 

Interface Definition 

Status indicator 

PWR: Power 

indicator (Green) 

Off The power connection is abnormal. 

On The power connection is normal. 

RUN: Run 

indicator (Green) 

Off Initial state 

Fast 

blinking 
Waiting for connection/Connecting. 

Slow 

blinking 
Safe mode 

On The communication is normal. 

ERR: Fault 

indicator (Red) 

Off In normal state 

Fast 

blinking 
A communication fault occurred. 

Slow 

blinking 
An expansion module fault occurred. 

SF: Fieldbus fault 

indicator (Red) 

Off The equipment running is normal. 

Blinking Configuration inconsistency. 

On An extended function fault occurred. 

USB type-C interface Used for single board software upgrade 

PROFINET interface 
P1: PROFINET interface 1 

P2: PROFINET interface 2 

24V power interface 24VDC power input interface of module 
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2.2.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

24V - - 24V 

0V - - 0V 

 
- - 

 

 

 Terminal wiring 

Unit Power 
supply

(24VDC)

Power supply for 
unwired 
terminal

24V24V

0V 0V

 
 

2.2.1.4 Hardware specifications 

Item Specification 

Rated input voltage 24VDC (20.4VDC–28.8VDC) 

Rated input current 0.8A (Typical value at 24VDC) 

Backplane fieldbus 

output rated voltage 
5VDC (4.75VDC–5.25VDC) 

Backplane fieldbus 

output rated current 
2.5A (Typical value at 5VDC) 

Isolation The input power is not isolated. 

Power supply 

protection 
Protection against overcurrent, reverse connection, and surges 

 

2.2.1.5 Software specifications 

Item Specification 

Communication mode RT mode 

Min. communication 

period 
1ms 

I&M data From I&M0 to I&M3 

PROFINET version V2.43 

Expansion capability Supporting 16 modules 

PROFINET interface 

quantity 
2 

PROFINET switch 

function 
Supporting the function of networking 

Supported open IE TCP/IP, SNMP, and LLDP 

Alarm/Diagnosis/Status 

information 
Supported. Function codes can be uploaded from the local to the PLC. 

Physical layer 100BASE-TX 

Communication rate 10Mbit/s (Standard Ethernet); 100Mbit/s (PROFINET) 

Communication 

method 
Full duplex 
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Item Specification 

Topological structure Linear, star, or tree topology 

Transmission medium Category-5 or higher network cables 

Transmission distance Less than 100m between two nodes 

Startup with priority Reserved 

Port disabling Not supported 

Supporting device 

replacement without 

configuration 

Supported (PN module of the same type) 

Restoring factory 

settings 
Supported 

 

2.2.1.6 Environment specifications 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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2.3 EtherNet/IP communication coupler 

2.3.1 FK1300 

2.3.1.1 Basic information 

QC

PASSo H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

FK1300
EtherNet/IP  Coupler  /24VDC

SN:I06228000058

Power supply for
unwired terminalUnit power supply

24V 24V

0V 0V

PE PE

 
 

Model Ordering code Description Applicable model 

FK1300 11016-00018 
Communication coupler; 

EtherNet/IP; 24VDC; RoHS 

Applicable to EtherNet/IP master 

devices 
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2.3.1.2 Component description 

Status 

indicator

Type-C 

interface

EtherNet/IP 

interface

24V power 

interface

 

Interface Definition 

Status indicator 

PWR: Power indicator 

(Green) 

Off The power connection is abnormal. 

On The power connection is normal. 

NS_R: Network status 

indicator (Green) 

Off 
No IP address configured, no Ethernet 

connection. 

Blinking at 

1Hz 
Not connected 

Steady on Connected 

NS_E: Network status 

indicator (Red) 

Off The network is working properly. 

Blinking at 

1Hz 
Connection timed out. 

Steady on Duplicate IP address 

SF: Fieldbus fault 

indicator (Red) 

Off The device is normal. 

Blinking at 

1Hz 
Configuration error occurs. 

Blinking at 

0.5Hz 

Exception in communication coupler MPU 

device initialization. 

On 
A communication coupler FPGA fault 

occurs. 
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Interface Definition 

USB type-C 

interface 

For functions such as single-board software upgrades, EDS file export, and 

IP/MAC address configuration 

EtherNet IP 

interface 

P1 interface 

Network 

port 

indicator 

(Green) 

Off 
Link indicator, indicating Ethernet 

connection not established. 

On 
Link indicator, indicating successful 

Ethernet connection. 

Network 

port 

indicator 

(Yellow) 

Off 
ACK indicator, indicating no data 

interchange. 

On 
ACK indicator, indicating data 

interchange performed. 

P2 interface 

Network 

port 

indicator 

(Green) 

Off 
Link indicator, indicating Ethernet 

connection not established. 

On 
Link indicator, indicating successful 

Ethernet connection. 

Network 

port 

indicator 

(Yellow) 

Off 
ACK indicator, indicating no data 

interchange. 

On 
ACK indicator, indicating data 

interchange performed. 

24V power 

interface 
24VDC power input interface of module 

 

2.3.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

24V - - 24V 

0V - - 0V 

 
- - 

 

 

 Terminal wiring 

Unit Power 
supply

(24VDC)

Power supply for 
unwired 
terminal

24V24V

0V 0V

 
 

2.3.1.4 Hardware specifications 

Item Specification 

Rated input voltage 24VDC (20.4VDC–28.8VDC) 

Rated input current 0.8A (Typical value at 24VDC) 

Backplane fieldbus 

output rated voltage 
5VDC (4.75VDC–5.25VDC) 

Backplane fieldbus 

output rated current 
2.5A (Typical value at 5VDC) 
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Item Specification 

Isolation The input power is not isolated. 

Power supply 

protection 
Protection against overcurrent, reverse connection, and surges 

 

2.3.1.5 Software specifications 

Item Specification 

Fieldbus protocol EtherNet/IP 

Fieldbus velocity 10/100Mbps, self adaptive, full duplex 

Max. number of I/O 

expansion modules 
32 

Max. number of 

output/input bytes 
Input: 504 bytes; Output: 504 bytes 

Network topology Linear, star, tree topology, or ring 
 

2.3.1.6 Environmental requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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2.4 ModbusTCP communication coupler 

2.4.1 FK1400 

2.4.1.1 Basic information 

QC

PASSo H SR

i

Shenzhen INVT Electric co.,Ltd
www.invt.com Made in china

FK1400
ModbusTCP  Coupler  /24VDC

SN:I06228000058

Power supply for
unwired terminalUnit power supply

24V 24V

0V 0V

PE PE

 

Model Ordering code Description Applicable model 

FK1400 11016-00029 
Communication 

coupler;ModbusTCP;24VDC;RoHS 

Applicable to ModbusTCP master 

devices 
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2.4.1.2 Component description 

Status 

indicator

Type-C 

interface

ModbusTCP  

interface

24V power 

interface

 

Interface Definition 

Status indicator 

PWR: Power indicator 

(Green) 

Off The power connection is abnormal. 

On The power connection is normal. 

RUN: Network 

operation status 

indicator (green) 

Off Not connected to the network. 

Blinking 

(500ms) 
Waiting for connection/Connecting. 

On The communication is normal. 

ERR: Network error 

status indicator (red) 

Off The network is working properly. 

Blinking 

(500ms) 

The network is disconnected abnormally 

after successful connection. 

On IP conflict. 

SF: System fault 

indicator (red) 

Off The equipment is normal. 

Blinking 

(500ms) 
Configuration error occurs. 

Blinking 

(1000ms) 

Exception in communication coupler MPU 

device initialization. 

On 
A communication coupler initialization 

failure occurs. 

USB type-C 

interface 

For functions such as single-board software upgrades, EDS file export, and 

IP/MAC address configuration 
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Interface Definition 

ModbusTCP 

interface 

P1 interface 

Network 

port 

indicator 

(Green) 

Off 
Link indicator, indicating not 

connected to the network. 

On 
Link indicator, indicating connected 

to the network. 

Network 

port 

indicator 

(Yellow) 

Off 
ACK indicator, indicating no data 

interchange. 

On 
ACK indicator, indicating data 

interchange performed. 

P2 interface 

Network 

port 

indicator 

(Green) 

Off 
Link indicator, indicating not 

connected to the network. 

On 
Link indicator, indicating connected 

to the network. 

Network 

port 

indicator 

(Yellow) 

Off 
ACK indicator, indicating no data 

interchange. 

On 
ACK indicator, indicating data 

interchange performed. 

24V power 

interface 
24VDC power input interface of module 

 

2.4.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

24V - - 24V 

0V - - 0V 

 - -  

 

 Terminal wiring 

Unit Power 
supply

(24VDC)

Power supply for 
unwired 
terminal

24V24V

0V 0V

 

Note: 

 The terminal PE must be properly grounded through the cable, with a grounding impedance of less 

than 4Ω. 

 Try to configure an independent system power supply for the coupler to avoid mixing with the external 

field power supply of the expansion module. 

2.4.1.4 Hardware specifications 

Item Specification 

Rated input voltage 24VDC (-15%–+20%) 
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Item Specification 

Rated input current 0.8A 

Backplane fieldbus 

output rated voltage 
5VDC (4.75VDC–5.25VDC) 

Backplane fieldbus 

output rated current 
2.5A (Typical value) 

Isolation No isolation 

Power supply 

protection 
Protection against reverse connection and overcurrent 

 

2.4.1.5 Software specifications 

Item Specification 

Max. number of client 

connections 
5 

TCP Keepalive Enabled 

Supported function 

codes 
01/02/03/04/05/06/15/16/23 

IP address settings Set through the Ttools-IO software 

Diagnostic function Supported 

Physical layer 100BASE-TX 

Communication rate 10M/100Mbps, self adaptive 

Communication 

method 
Full duplex 

Topological structure Linear, star, or tree topology 

Transmission medium Category-5 or higher network cables 

Transmission distance Max. segment length is 100 meters. 
 

2.4.1.6 Environmental requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 2000m (80kPa) 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3 I/O module specifications 

3.1 Digital input module (FL100x) 

3.1.1 FL1001 (1600D) 

3.1.1.1 Basic information 

FL1001
16xDigital  Input

24VDC，0.5A

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

0

1

2

3

4

5

6

7

8

DI10

DI11

DI12

DI13

DI14

DI15

DI16

DI17

SS

DI0

DI1

DI2

DI3

DI4

DI5

DI6

DI7

SS

BA

PNP NPN

 
 

Model 
Ordering 

code 
Description Applicable model 

FL1001 11016-00004 

Digital input module, 16 channels, 

supporting the source and sink 

types, 500mA@ 24 VDC inputs; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.1.1.2 Component description 

Status indicator

Color meaning

User terminal

Signal indicator

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): Incorrect parameter 

settings. 

Off: The module works normally. 

Signal 

indicator 

00–07: Green 

10–17: Green 

Each corresponds to a 

channel of input signal. 

On: The input is valid. 

Off: The input is invalid. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

0. 0.

0. 0.
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3.1.1.3 Terminal definition and wiring  

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DI10 

DI1 A1 B1 DI11 

DI2 A2 B2 DI12 

DI3 A3 B3 DI13 

DI4 A4 B4 DI14 

DI5 A5 B5 DI15 

DI6 A6 B6 DI16 

DI7 A7 B7 DI17 

SS A8 B8 SS 

 

 Terminal wiring 

DI0

DI7

DI10

DI17

In
te

rn
a
l circu

it

SS

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

24VDC24VDC

Source inputSink input
 

 

3.1.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 5VDC (4.75VDC–5.25VDC) 
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Item Specification 

rated voltage 

Fieldbus input power 

rated current 
150mA (Typical value at 5VDC) 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of 

module 
Not supported 

 

3.1.1.5 Input specifications 

Item Specification 

Input type Digital input 

Input mode Source type/Sink type 

Input channels 16 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Input current (Typical) 7mA (Typical value at 24VDC) 

ON voltage >15V 

OFF voltage <5V 

Hardware response 

time ON/OFF 
100μs/100μs 

Software filter time Supported 

Input resistance Reference value is about 3.4kΩ. 

Isolation Optocoupler 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When each terminal is operating at 55℃, it is derated to 75% (with no 

more than 12 input points of ON at the same time), or the temperature 

drops by 10℃ when all input points are ON. 
 

3.1.1.6 Software specifications 

Item Specification 

Software input filter 

time 

Setting range: 1–65535 (default: 1000); unit: 10μs; 1000 indicates 10ms. 

Able to set two groups of filter parameter. Every eight channels use a 

group of filter parameter. 

Input port exception 

detection and 

indication 

None 

Input channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of Diagnosis information will be uploaded by default. 
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Item Specification 

diagnosis reporting 

In stop mode 
Output will not be refreshed, while input supports refreshing in 

Safe-operational state. 

I/O mapping Supporting the mapping method of bitwise access 
 

3.1.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.1.2 FL1002 (3200D) 

3.1.2.1 Basic information 

2

Made in Chinawww.invt.com

Shenzhen INVT Electric Co.,Ltd.

FL1002

SN:I06228000058

DI6 DI16

DI7

SS0

DI17

SS0

A B

8

7

6

DI4

DI2

DI14

DI12

DI3

DI5

DI13

DI15

3

5

4

DI0 DI10

DI1 DI11

0

1

PNP NPN

2

DI26 DI36

DI27

SS1

DI37

SS1

C D

8

7

6

DI24

DI22

DI34

DI32

DI23

DI25

DI33

DI35

3

5

4

DI20 DI30

DI21 DI31

0

1

32xDigital Input

24VDC,0.5A 

NPNPNP

o H SR

QC

PASS

i

 
 

Model 
Ordering 

code 
Description Applicable model 

FL1002 11016-00016 

Digital input module, 32 channels, 

supporting the source and sink 

types, 500mA@ 24 VDC inputs; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.1.2.2 Component description 

Status 
indicator

Signal 
indicator

Color 
meaning

User 
terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): Incorrect parameter 

settings. 

Off: The module works normally. 

Signal 

indicator 

00–07: 

Green 

10–17: 

Green 

20–27: 

Green 

30–37: 

Green 

Each corresponds to a 

channel of input 

signal. 

On: The input is valid. 

Off: The input is invalid. 
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Name Description 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, 

thermocouple) 
 Analog output 

 

3.1.2.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DI10 

DI1 A1 B1 DI11 

DI2 A2 B2 DI12 

DI3 A3 B3 DI13 

DI4 A4 B4 DI14 

DI5 A5 B5 DI15 

DI6 A6 B6 DI16 

DI7 A7 B7 DI17 

SS A8 B8 SS 

DI20 C0 D0 DI30 

DI21 C1 D1 DI31 

DI22 C2 D2 DI32 

DI23 C3 D3 DI33 

DI24 C4 D4 DI34 

DI25 C5 D5 DI35 

DI26 C6 D6 DI36 

DI27 C7 D7 DI37 

SS C8 D8 SS 
 

0. 0.

0. 0.
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 Terminal wiring 

A/B terminal C/D terminal 

DI0

DI7

DI10

DI17

In
te

rn
a
l circu

it
SS

Optocoupler 
isolation

24VDC24VDC

Source inputSink input

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

 

DI20

DI2

7

DI30

DI37

In
te

rn
a
l circu

it

SS

24VDC24VDC

Source inputSink input

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

 
 

3.1.2.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
150mA (Typical value at 5VDC) 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of 

module 
Not supported 

 

3.1.2.5 Input specifications 

Item Specification 

Input type Digital input 

Input mode Source/Sink 

Input channels 16 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Input current (Typical) 7mA (Typical value at 24VDC) 

ON voltage >15V 

OFF voltage <5V 
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Item Specification 

Hardware response 

time ON/OFF 
100μs/100μs 

Software filter time Supported 

Input resistance Reference value is about 3.4kΩ. 

Isolation Optocoupler 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When each terminal is operating at 55℃, it is derated to 75% (with no 

more than 12 input points of ON at the same time), or the temperature 

drops by 10℃ when all input points are ON. 
 

3.1.2.6 Software specifications 

Item Specification 

Software input filter 

time 

Setting range: 1–65535 (default: 1000); unit: 10μs; 1000 indicates 10ms. 

Able to set two groups of filter parameter. Every eight channels use a 

group of filter parameter. 

Input port exception 

detection and 

indication 

None 

Input channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output will not be refreshed, while input supports refreshing in 

Safe-operational state. 

I/O mapping Supporting the mapping method of bitwise access 
 

3.1.2.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.2 Digital output module (source type) (FL200x) 

3.2.1 FL2002 (0016DP) 

3.2.1.1 Basic information 

FL2002
16xDigital  Output(PNP)

24VDC，0.5A

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

0

1

2

3

4

5

6

7

8

DO10

DO11

DO12

DO13

DO14

DO15

DO16

DO17

0V

DO0

DO1

DO2

DO3

DO4

DO5

DO6

DO7

24V

BA

L
O

A
D

 
 

Model 
Ordering 

code 
Description Applicable model 

FL2002 11016-00006 

Digital output module, with 16 

channels of PNP transistor output, 

500mA @ 24 VDC; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.2.1.2 Component description 

Status indicator

Signal indicator

Color meaning

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): No power connected 

externally or incorrect parameter settings. 

Off: The module works normally. 

Signal 

indicator 

00–07: Green 

10–17: Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

0. 0.

0. 0.
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3.2.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DO0 A0 B0 DO10 

DO1 A1 B1 DO11 

DO2 A2 B2 DO12 

DO3 A3 B3 DO13 

DO4 A4 B4 DO14 

DO5 A5 B5 DO15 

DO6 A6 B6 DO16 

DO7 A7 B7 DO17 

24VDC A8 B8 COM 

 

 Terminal wiring 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

24V

DO17

DO10

DO7

DO0
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3.2.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
150mA 

Terminal input power 

rated voltage 
24VDC (20.4VDC–28.8VDC) 

Terminal input power 

rated current 
2A (Typical value at 24VDC) 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 

3.2.1.5 Output specifications 

Item Specification 

Output type Digital output, high-edge output 

Output mode Source type 

Output channel 16 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistance 

load) 
0.5A/point, 2A/module 

Output load (Inductance 

load) 
7.2W/point, 12W/module 

Output load (Light load) 5W/point, 18W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 
100Hz for resistance load, 0.5Hz for resistance load, and 100ms for 

light load 

Isolation Yes 

Output action display When the output is in driving state, the output indicator is on. 

Input derating None 

Protection function Short-circuit protection and overcurrent protection 
 

3.2.1.6 Software specifications 

Item Specification 

Stop/offline output 

mode 

Keeping output, clearing output, or outputting the preset value, which 

is configured on a point basis 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

None 

Output channel logic 

level configuration 
Not supported 
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Item Specification 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
 

3.2.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.2.2 FL2003 (0032DP) 

3.2.2.1 Basic information 

2

Made in Chinawww.invt.com

Shenzhen INVT Electric Co.,Ltd.

FL2003

SN:I06228000058

DO6 DO16

DO7

24V

DO17

0V

A B

8

7

6

DO4

DO2

DO14

DO12

DO3

DO5

DO13

DO15

3

5

4

DO0 DO10

DO1 DO11

0

1

2

DO26 DO36

DO27

24V

DO37

0V

C D

8

7

6

DO24

DO22

DO34

DO32

DO23

DO25

DO33

DO35

3

5

4

DO20 DO30

DO21 DO31

0

1

32xDigital Output(PNP)
24VDC,0.5A

L
O

A
D

L
O

A
D

o H SR

i

QC

PASS

 
 

Model 
Ordering 

code 
Description Applicable model 

FL2003 11016-00013 

Digital output module, with 32 

channels of PNP transistor output, 

500mA @ 24 VDC; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.2.2.2 Component description 

Status 
indicator

Signal 
indicator

Color 
meaning

User 
terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): No power connected 

externally or incorrect parameter settings. 

Off: The module works normally. 

Signal 

indicator 

00–07: Green 

10–17: Green 

20–27: Green 

30–37: Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 

User 

terminal 
External wiring I/O terminal 
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Name Description 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

3.2.2.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DO0 A0 B0 DO10 

DO1 A1 B1 DO11 

DO2 A2 B2 DO12 

DO3 A3 B3 DO13 

DO4 A4 B4 DO14 

DO5 A5 B5 DO15 

DO6 A6 B6 DO16 

DO7 A7 B7 DO17 

24VDC A8 B8 COM 

DO20 C0 D0 DO30 

DO21 C1 D1 DO31 

DOI22 C2 D2 DO32 

DO23 C3 D3 DO33 

DO24 C4 D4 DO34 

DO25 C5 D5 DO35 

DO26 C6 D6 DO36 

DO27 C7 D7 DO37 

24VDC C8 D8 COM 
 

0. 0.

0. 0.
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 Terminal wiring 

A/B terminal C/D terminal 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

24V

DO17

DO10

DO7

DO0

 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

24V

DO37

DO30

DO27

DO20

 
 

3.2.2.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
150mA 

Terminal input power 

rated voltage 
24VDC (20.4VDC–28.8VDC) 

Terminal input power 

rated current 
2A (Typical value at 24VDC) 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.2.2.5 Output specifications 

Item Specification 

Output type Digital output, high-edge output 

Output mode Source type 

Output channel 32 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistance 

load) 
0.5A/point, 2A/module 

Output load (Inductance 

load) 
7.2W/point, 12W/module 
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Item Specification 

Output load (Light load) 5W/point, 18W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 
100Hz for resistance load, 0.5Hz for resistance load, and 100ms for 

light load 

Isolation Yes 

Output action display When the output is in driving state, the output indicator is on. 

Input derating None 

Protection function Short-circuit protection and overcurrent protection 
 

3.2.2.6 Software specifications 

Item Specification 

Stop/offline output 

mode 

Keeping output, clearing output, or outputting the preset value, which 

is configured on a point basis 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

None 

Output channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
 

3.2.2.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.3 Digital output module (sink type) (FL210x) 

3.3.1 FL2102 (0016DN) 

3.3.1.1 Basic information 

FL2102
16xDigital  Output(NPN)

24VDC，0.5A

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

0

1

2

3

4

5

6

7

8

DO10

DO11

DO12

DO13

DO14

DO15

DO16

DO17

COM

DO0

DO1

DO2

DO3

DO4

DO5

DO6

DO7

COM

BA

L
O

A
D

 
 

Model 
Ordering 

code 
Description Applicable model 

FL2102 11016-00003 

Analog output, 16-channel NPN 

transistor output, 500mA @ 24VDC; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.3.1.2 Component description 

Status indicator

Signal indicator

Color meaning

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): Channel 

overheat/overcurrent alarm or incorrect 

parameter settings. 

Off: The module works normally. 

Signal 

indicator 

00–07: Green 

10–17: Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

0. 0.

0. 0.
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3.3.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DO0 A0 B0 DO10 

DO1 A1 B1 DO11 

DO2 A2 B2 DO12 

DO3 A3 B3 DO13 

DO4 A4 B4 DO14 

DO5 A5 B5 DO15 

DO6 A6 B6 DO16 

DO7 A7 B7 DO17 

COM A8 B8 COM 

 

 User terminal wiring 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

DO17

DO10

DO7

DO0

COM
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3.3.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
200mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.3.1.5 Output specifications 

Item Specification 

Output type Digital output, low-edge output 

Output mode Sink 

Output channel 16 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistance 

load) 
0.5A/point, 4A/module 

Output load (Inductance 

load) 
7.2W/point, 24W/module 

Output load (Light load) 5W/point, 18W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 
100Hz for resistance load, 0.5Hz for resistance load, and 100ms for 

light load 

Isolation Yes 

Output action display When the output is in driving state, the output indicator is on. 

Input derating None 

Protection function Short-circuit protection and overcurrent protection 
 

3.3.1.6 Software specifications 

Item Specification 

Stop/offline output 

mode 

Keeping output, clearing output, or outputting the preset value, which 

is configured on a point basis 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

Overheat/overcurrent detection and protection on a module basis 

Output channel logic 

level configuration 
Not supported 
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Item Specification 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
 

3.3.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.3.2 FL2103 (0032DN) 

3.3.2.1 Basic information 

2

Made in Chinawww.invt.com

Shenzhen INVT Electric Co.,Ltd.

FL2103

SN:I06228000058

DO6 DO16

DO7

COM0

DO17

COM0

A B

8

7

6

DO4

DO2

DO14

DO12

DO3

DO5

DO13

DO15

3

5

4

DO0 DO10

DO1 DO11

0

1

2

DO26 DO36

DO27

COM1

DO37

COM1

C D

8

7

6

DO24

DO22

DO34

DO32

DO23

DO25

DO33

DO35

3

5

4

DO20 DO30

DO21 DO31

0

1

32xDigital Output(NPN)
24VDC,0.5A

L
O

A
D

L
O

A
D

o H SR

i

 
 

Model 
Ordering 

code 
Description Applicable model 

FL2103 11016-00017 

Analog output, 32-channel NPN 

transistor output, 500mA @ 24VDC; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.3.2.2 Component description 

Status 
indicator

Signal 
indicator

Color 
meaning

User 
terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): Channel 

overheat/overcurrent alarm or incorrect 

parameter settings. 

Off: The module works normally. 

Signal 

indicator 

00–07: 

Green 

10–17: 

Green 

20–27: 

Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 
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Name Description 

30–37: 

Green 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, 

thermocouple) 
 Analog output 

 

3.3.2.3 Terminal definition 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DO0 A0 B0 DO10 

DO1 A1 B1 DO11 

DO2 A2 B2 DO12 

DO3 A3 B3 DO13 

DO4 A4 B4 DO14 

DO5 A5 B5 DO15 

DO6 A6 B6 DO16 

DO7 A7 B7 DO17 

COM A8 B8 COM 

DO20 C0 D0 DO30 

DO21 C1 D1 DO31 

DOI22 C2 D2 DO32 

DO23 C3 D3 DO33 

DO24 C4 D4 DO34 

DO25 C5 D5 DO35 

DO26 C6 D6 DO36 

DO27 C7 D7 DO37 

COM C8 D8 COM 
 

0. 0.

0. 0.
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 Terminal wiring 

A/B terminal C/D terminal 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

DO17

DO10

DO7

DO0

COM

 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

DO37

DO30

DO27

DO20

COM

 
 

3.3.2.4 Power supply specifications 

Item Specification 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 300mA 

Terminal input power rated voltage None 

Terminal input power rated current None 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

3.3.2.5 Output specifications 

Item Specification 

Output type Digital output, low-edge output 

Output mode Sink 

Output channel 32 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load (Resistance 

load) 
0.5A/point, 4A/module 

Output load (Inductance 

load) 
7.2W/point, 24W/module 

Output load (Light load) 5W/point, 18W/module 

Hardware response time 

ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 100Hz for resistance load, 0.5Hz for resistance load, and 100ms for 
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Item Specification 

light load 

Isolation Yes 

Output action display When the output is in driving state, the output indicator is on. 

Input derating None 

Protection function Short-circuit protection and overcurrent protection 
 

3.3.2.6 Software specifications 

Item Specification 

Stop/offline output 

mode 

Keeping output, clearing output, or outputting the preset value, which 

is configured on a point basis 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

Overheat/overcurrent detection and protection on a module basis 

Output channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
 

3.3.2.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.4 Digital output module (FL2201) 

3.4.1 FL2201 (0008DR) 

3.4.1.1 Basic information 

FL2201
8xRelay  Output
AC:230V 2A / DC:24V 2A

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

B

0

1

2

3

4

5

6

7

8

COM0

NC

COM0

NC

COM0

NC

COM0

NC

NC

Y00

NC

Y01

NC

Y02

NC

Y03

NC

NC

A D

0

1

2

3

4

5

6

7

8

COM1

NC

COM1

NC

COM1

NC

COM1

NC

NC

Y04

NC

Y05

NC

Y06

NC

Y07

NC

NC

C

LOAD LOAD

 
 

Model 
Ordering 

code 
Description Applicable model 

FL2201 11016-00009 
Digital output, 8 relay outputs, dry 

contacts,3A@30VDC/250VAC;RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.4.1.2 Component description 

Color 
meaning

Status 
indicator

Signal 
indicator

User 
terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Slow blinking (500ms): Incorrect parameter 

settings. 

Fast blinking (100ms): The module is offline. 

Off: The module works normally. 

Signal 

indicator 

00–07: 

Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, 

thermocouple) 
 Analog output 

 

0. 0.

0. 0.
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3.4.1.3 Terminal definition 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

Y00 A0 B0 COM0 

- A1 B1 - 

Y01 A2 B2 COM0 

- A3 B3 - 

Y02 A4 B4 COM0 

- A5 B5 - 

Y03 A6 B6 COM0 

- A7 B7 - 

- A8 B8 - 

Y04 C0 D0 COM1 

- C1 D1 - 

Y05 C2 D2 COM1 

- C3 D3 - 

Y06 C4 D4 COM1 

- C5 D5 - 

Y07 C6 D6 COM1 

- C7 D7 - 

- C8 D8 - 
 

 Terminal wiring 

In
te

rn
a
l circu

it

LOAD

LOAD

COM1

Y07

Y00

AC

DC

COM0

K0

K7

AC

DC
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3.4.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
300mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.4.1.5 Output specifications 

Item Specification 

Output mode Relay N.O. 

Output channel 8 

Contact load (Resistance 

load) 
3A 250VAC/30VDC 

Max. switching voltage 250VAC/125VDC (@0.3A) 

Max. switching current 3A 

Contact resistor <100mΩ (1A 6VDC) 

Min. load 5VDC 10mA 

Isolation Strong current isolated from weak current 
 

3.4.1.6 Software specifications 

Item Specification 

Stop/offline output 

mode 

Keeping output, clearing output, or outputting the preset value, which 

is configured on a point basis 

Preset value of 

stop/offline output 
Single-point 0 or 1 

Output channel 

exception detection 

indication 

Not supported 

Output channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Not supported 

In stop mode 
Output according to the stop/offline output mode and preset value, 

without refreshing any more 

I/O mapping Supporting the mapping method of bitwise access 
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3.4.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.5 Analog input module (FL3xxx) 

3.5.1 FL3003 (4AD) 

3.5.1.1 Basic information 

FL3003
4xAnalog  Input

Voltage&current  24bit

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

0

1

2

3

4

5

6

7

8

I0+

PE

I1+

PE

I2+

PE

I3+

PE

NC

VI0+

VI0-

VI1+

VI1-

VI2+

VI2-

VI3+

VI3-

NC

BA

I

V

 
 

Model 
Ordering 

code 
Description Applicable model 

FL3003 11016-00011 

Analog input module, 4 channels, 16-bit 

resolution, room-temperature accuracy 

of±0.1%FS; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.5.1.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): ADC chip fault or 

incorrect parameter settings. 

Off: The module works normally. 

Signal 

indicator 
00–03: Green 

Channel status 

indicator 

On: The channel is enabled. 

Slow blinking (500ms): Input signal Incorrect 

parameter settings. 

Fast blinking (100ms): Offline at the voltage 

mode. 

Off: The channel is disabled. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 Analog input (voltage,  Analog output 

0. 0.

0. 0.
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Name Description 

current, thermocouple) 
 

3.5.1.3 Terminal definition 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

VI0+ A0 B0 I0+ 

VI0- A1 B1 PE 

VI1+ A2 B2 I1+ 

VI1- A3 B3 PE 

VI2+ A4 B4 I2+ 

VI2- A5 B5 PE 

VI3+ A6 B6 I3+ 

VI3- A7 B7 PE 

- A8 B8 - 

 

 Terminal wiring 

Figure 3-1 Voltage input wiring 

VI0+

I0+

VI0-

ADC

Filter 
n

etw
o

rk

Shield 
layer of 
cable

 

Figure 3-2 Current input wiring 

I0+

I0-Shield 
layer of 
cable

Two-wire system 
4-20mA 

sensor/transmitter

+

-

S

+

Power
24VDC

 

I0+

I0-
Shield layer 

of cable

Three-wire system 
4-20mA 

sensor/transmitter

+

-

+
S
-

Power
24VDC

  

I0+

I0-
Shield layer 

of cable

Four-wire system 
4-20mA 

sensor/transmitter

+

-

+

Power
24VDC -

S-

S+
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3.5.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
200mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.5.1.5 Input specifications 

Item Specification 

Input type Analog input 

Input mode Voltage/current 

Input channels 4 

Resolution 16-bit 

Conversion time 320μs/channel 

Voltage input range 0–5V, 0–10V, -5–+5V, -10–+10V 

Voltage input impedance 2.4MΩ 

Voltage input accuracy 

(25℃) 
±0.1% 

Voltage input accuracy 

(in full temperature 

range) 

±0.2% 

Voltage input limit ±12V 

Voltage input diagnosis Disconnection detection supported 

Current input range ±20mA, 0–20mA, 4–20mA 

Current input resistance 240Ω 

Current input accuracy 

(at 25℃) 
±0.1% 

Current input accuracy 

(in full temperature 

range) 

±0.2% 

Current input limit ±24mA 

Current input diagnosis Not supported 

Isolation 
No isolation between interface channels; voltage isolated from 

interface; interface isolated from bus 

Input action display None 

Input derating None 
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3.5.1.6 Software specifications 

Item Specification 

Configuration of 

independent channel 

enabling 

Supported 

Configuration of 

diagnosis reporting 
Supported 

Configuration of 

enabling diagnosis 

detection 

Voltage-side disconnection, over-range detection, and over-limit 

detection 

Mode switchover 

configuration 
0–5V, 0–10V, ±5V, ±10V, 4–20mA, 0–20mA, ±20mA 

Filter parameter 

configuration 

Software filter time can be set through the host controller, which 

ranges from 1 to 255, with the sampling period as the unit. 

Configuration of 

enabling over-limit 

detection 

Supported 

Configuration of 

enabling peak holding 
Not supported 

Configuration of 

conversion digital range 
±20000 

Sampling time 4 channels at 1.28ms 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Stop mode Present value kept, without refresh 
 

3.5.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.5.2 FL3404 (8ADV) 

3.5.2.1 Basic information 

FL3404
8xVoltage Input
16bit

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china
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V1+
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Model 
Ordering 

code 
Description Applicable model 

FL3404 11016-00026 

Analog input module, 8 channels, 

voltage signal, 16-bit resolution, 

room-temperature accuracy of 

±0.15%FS; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.5.2.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): ADC chip fault or 

incorrect parameter settings. 

Off: The module works normally. 

Signal 

indicator 
00–07: Green 

Channel status 

indicator 

On: The channel is enabled. 

Slow blinking (500ms): Input signal Incorrect 

parameter settings. 

Fast blinking (100ms): Offline at the voltage 

mode. 

Off: The channel is disabled. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

0. 0.

0. 0.
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3.5.2.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

V1+ A0 B0 V1- 

V2+ A1 B1 V2- 

V3+ A2 B2 V3- 

V4+ A3 B3 V4- 

V5+ A4 B4 V5- 

V6+ A5 B5 V6- 

V7+ A6 B6 V7- 

PE A7 B7 PE 

V1+ A8 B8 V1- 

 

 Terminal wiring 

Figure 3-3 Voltage input wiring 

VI0+

VI0-

ADC

Filter 
n

etw
o

rk

Shield 
layer of 
cable

 
 

3.5.2.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
200mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
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3.5.2.5 Input specifications 

Item Specification 

Input type Analog input 

Input mode Voltage (differential) 

Input channels 8 

Resolution 16-bit 

Conversion time <170μs/channel 

Voltage input range 0–5V, 0–10V, -5–+5V, -10–+10V 

Voltage input impedance 1MΩ 

Voltage input accuracy 

(25℃) 
±0.15% 

Voltage input accuracy 

(in full temperature 

range) 

±0.3% 

Voltage input limit ±15V 

Voltage input diagnosis Disconnection detection supported 

Isolation 
No isolation between interface channels; voltage isolated from 

interface; interface isolated from bus 

Input action display None 
 

3.5.2.6 Software specifications 

Item Specification 

Configuration of independent 

channel enabling 
Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Over-range detection, and over-limit detection 

Mode switchover 

configuration 
0–5V, 0–10V, ±5V, ±10V 

Filter parameter 

configuration 

Software filter time can be set through the host controller, which 

ranges from 1 to 255, with the sampling period as the unit. 

Configuration of enabling 

over-limit detection 
Supported 

Configuration of enabling 

peak holding 
Not supported 

Configuration 

of conversion 

digital range 

-10–+10VDC -20000–20000, -32000–32000, -27648–27648 

0–10VDC 0–20000, 0–32000, 0–27648 

-5–+5VDC -20000–20000, -32000–32000, -27648–27648 

0–5VDC 0–20000, 0–32000, 0–27648 

1–5VDC 0–20000, 0–32000, 0–27648 

Sampling time <170μs/channel 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period 

based synchronous refresh 
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3.5.2.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
 

3.5.3 FL3504 (8ADI) 

3.5.3.1 Basic information 

FL3504
8xCurrent Input
16bit

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china
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Model 
Ordering 

code 
Description Applicable model 

FL3504 11016-00027 

Analog input module, 8 channels, 

current signal, 16-bit resolution, 

room-temperature accuracy of 

±0.15%FS; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.5.3.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): ADC chip fault or 

incorrect parameter settings. 

Off: The module works normally. 

Signal 

indicator 
00–07: Green 

Channel status 

indicator 

On: The channel is enabled. 

Slow blinking (500ms): Input signal Incorrect 

parameter settings. 

Fast blinking (100ms): Offline at the voltage 

mode. 

Off: The channel is disabled. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

0. 0.

0. 0.
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3.5.3.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

I0+ A0 B0 I0- 

I1+ A1 B1 I1- 

I2+ A2 B2 I2- 

I3+ A3 B3 I3- 

I4+ A4 B4 I4- 

I5+ A5 B5 I5- 

I6+ A6 B6 I6- 

I7+ A7 B7 I7- 

PE A8 B8 PE 

 

 Terminal wiring 

Figure 3-4 Current input wiring 

I0+

I0-Shield 
layer of 
cable

Two-wire system 
4-20mA 

sensor/transmitter

8ADI 
module

+

-

S

+

Power
24VDC

 

I0+

I0-
Shield layer 

of cable

Three-wire system 
4-20mA 

sensor/transmitter

8ADI 
module

+

-

+
S
-

Power
24VDC

  

 

I0+

I0-
Shield layer 

of cable

Four-wire system 
4-20mA 

sensor/transmitter

8ADI 
module

+

-

+

Power
24VDC -

S-

S+
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3.5.3.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
200mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.5.3.5 Input specifications 

Item Specification 

Input type Analog input 

Input mode Voltage 

Input channels 8 

Resolution 16-bit 

Conversion time <170μs/channel 

Current input range ±20mA, 0–20mA, 4–20mA 

Current input resistance 240Ω 

Current input accuracy 

(at 25℃) 
±0.15% 

Current input accuracy 

(in full temperature 

range) 

±0.3% 

Current input limit ±30mA 

Current input diagnosis Not supported 

Isolation 
No isolation between interface channels; voltage isolated from 

interface; interface isolated from bus 
 

3.5.3.6 Software specifications 

Item Specification 

Configuration of 

independent channel 

enabling 

Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 
Over-range detection, and over-limit detection 

Mode switchover 

configuration 
4–20mA, 0–20mA, ±20mA 

Filter parameter 

configuration 

Software filter time can be set through the host controller, which 

ranges from 1 to 255, with the sampling period as the unit. 
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Item Specification 

Configuration of enabling 

over-limit detection 
Supported 

Configuration of enabling 

peak holding 
Not supported 

Configuration 

of conversion 

digital range 

-20mA–

+20mA 
-20000–20000, -32000–32000, -27648–27648 

0mA–

20mA 
0–20000, 0–32000, 0–27648 

4mA–

20mA 
0–20000, 0–32000, 0–27648 

Sampling time <170μs/channel 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period 

based synchronous refresh 
 

3.5.3.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.6 Analog output module (FL4xxx) 

3.6.1 FL4003 (4DA) 

3.6.1.1 Basic information 

I

v LOAD

LOAD

V0+

I0+

V1+

I1+

V2+

I2+

V3+

I3+

24V

VI0-

PE

VI1-

PE

VI2-

PE

VI3-

PE

0V

0

1

2

3

4

5

6

7

8

A B

FL4003
4xAnalog  Output

Voltage&current   16bit 

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

 
 

Model 
Ordering 

code 
Description Applicable model 

FL4003 11016-00008 

Analog output module, 4 channels, 

16-bit resolution, room-temperature 

accuracy of ±0.1% FS; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.6.1.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): DAC chip external 

power exception or parameter setting error. 

Off: The module works normally. 

00–03: Green 
Channel status 

indicator 

On: The channel is enabled. 

Slow blinking (500ms): Short circuit or 

incorrect parameter settings. 

Fast blinking (100ms): Current disconnection. 

Off: The channel is disabled. 

User 

terminal 
External wiring I/O terminal 
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Name Description 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

3.6.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

V0+ A0 B0 VI0- 

I0+ A1 B1 PE 

V1+ A2 B2 VI1- 

I1+ A3 B3 PE 

V2+ A4 B4 VI2- 

I2+ A5 B5 PE 

V3+ A6 B6 VI3- 

I3+ A7 B7 PE 

24V A8 B8 COM 

 

 Terminal wiring 

COM

24V

PE

I0+

VI0-

V0+

CH0

PE

I1+

VI1-

V1+

CH1

PE

I2+

VI2-

V2+

CH2

PE

I3+

VI3-

V3+

CH3

24VDC external DC power

Current output mode
Drivable load range: 

0–0.6kΩ

Voltage output mode
Drivable load range: 

1kΩ–1MΩ

Power 
chip

Digital-
analog 

conversion

5V

+15V

-15V

Shield layer of 
cable

Shield layer of 
cable

 
  

0. 0.

0. 0.
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3.6.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
150mA 

Terminal input power 

rated voltage 
24VDC (20.4VDC–28.8VDC) 

Terminal input power 

rated current 
100mA (Typical value at 24VDC) 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.6.1.5 Output specifications 

Item Specification 

Output type Analog output 

Output mode Voltage/current 

Output channel 4 

Resolution 16-bit 

Conversion time 40μs/channel 

Voltage output range 0–5V, 0–10V, -5–+5V, -10–+10V 

Voltage output load 1kΩ 

Voltage output accuracy 

(25℃) 
±0.1% 

Voltage output accuracy 

(in full temperature 

range) 

±0.5% 

Voltage output diagnosis Short circuit detection and overtemperature protection supported 

Current output range 0–20mA, 4–20mA 

Current output load <600Ω 

Current output accuracy 

(25℃) 
±0.1% 

Current output accuracy 

(in full temperature 

range) 

±0.5% 

Current output diagnosis Open circuit detection and overtemperature protection supported 

Isolation 
No isolation between interface channels; voltage isolated from 

interface; interface isolated from bus 

Output action display None 

Output derating None 
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3.6.1.6 Software specifications 

Item Specification 

Configuration of 

independent channel 

enabling 

Supported 

Configuration of diagnosis 

reporting 
Supported 

Configuration of enabling 

diagnosis detection 

Short circuit detection for voltage, and disconnection detection for 

current 

Mode switchover 

configuration 
0–5V, 0–10V, ±5V, ±10V, 4–20mA, 0–20mA 

Output status 

configuration after stop 
Clearing, keeping the present output, or outputting the preset value 

Preset value output after 

stop 
Supported 

Configuration of 

conversion digital range 
±20000 

Sampling time 4 channels at 160μs 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Stop mode 
Output according to the fault-caused stop mode or the preset value, 

without refreshing any more 
 

3.6.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.7 Temperature detection module (FL31xx) 

3.7.1 FL3103 (4PT) 

3.7.1.1 Basic information 

FL3103
4xAnalog  Input

Temperature, RTD  24bit

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china
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PE
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Two-wire

Three-wire

Four-wire

 
 

Model 
Ordering 

code 
Description Applicable model 

FL3103 11016-00007 

Thermal resistor, 4 channels, 24-bit 

resolution, sensitivity of 0.1℃/℉; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.7.1.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is 

offline. 

Slow blinking (500ms): Error in 

temperature detection. 

Off: The module works normally. 

00–03: Green Channel status indicator 

On: The channel is enabled. 

Slow blinking (500ms): Input signal out of 

range or limit. 

Fast blinking (100ms): Disconnection. 

Off: The channel is disabled. 

User 

terminal 
External wiring I/O terminal 
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Name Description 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

3.7.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

I0+ A0 B0 I0- 

R0+ A1 B1 R0- 

I1+ A2 B2 I1- 

R1+ A3 B3 R1- 

I2+ A4 B4 I2- 

R2+ A5 B5 R2- 

I3+ A6 B6 I3- 

R3+ A7 B7 R3- 

PE A8 B8 PE 

 

 Terminal wiring 

Filter

I+

R+

R-

I-

Filter

AGND

Filter

I+

R+

R-

I-

Filter

AGND

Filter

I+

R+

R-

I-

Filter

AGND

PT

PT

PT

Two-wire 
PT

Three-wire 
PT

Four-wire 
PT

FG

FG

FG

 
 

0. 0.

0. 0.
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3.7.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
250mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output 

power rated voltage 
None 

Terminal output 

power rated current 
None 

Hot swapping of 

module 
Not supported 

 
 

3.7.1.5 Input specifications 

Item Specification 

Input channels 4 

Resolution 24-bit 

Display sensitivity 0.0625℃, 0.0625℉ 

Input terminal Four thermal resistor inputs 

Sensor type PT100, PT500, PT1000, Cu100 

Wiring method Two-wire/Three-wire/Four-wire 

Accuracy (at room 

temperature of 25°C) 
Full scale * ± 0.3% 

Accuracy (in room 

temperature -20℃–

55℃) 

Full scale * ± 1% 

Sampling period 

Channel 1 and channel 2 form a group, while channel 3 and channel 4 

form a group. When both channels within a group are enabled and one 

channel is configured as a three-wire system, the sampling period is 

480ms/channel, and in other cases, the sampling period is 

240ms/channel. 

Filter parameter 1–255 (Default: 8) 

Isolation method 
I/O terminals insulated from the power supply; 
 

No insulation between channels 
 
 

3.7.1.6 Software specifications 

Item Specification 

Configuration of 

diagnosis reporting 
Supported 

Configuration of 

enabling diagnosis 

detection 

Over-limit detection and disconnection detection supported 
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Item Specification 

Configuration of 

enabling over-limit 

detection 

Supported 

Independent channel 

configuration 
Supported 

Configuration of 

enabling temperature 

offset 

Supported 

Temperature offset 

setting range 
-204.8–+204.7 temperature unit 

Sampling period 

Channel 1 and channel 2 form a group, while channel 3 and channel 4 

form a group. When both channels within a group are enabled and one 

channel is configured as a three-wire system, the sampling period is 

480ms/channel, and in other cases, the sampling period is 

240ms/channel. 

Display mode Celsius degree (℃), Fahrenheit degree (℉) 

Sensitivity 0.0625℃, 0.0625℉ 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Disconnection or 

over-limit 
Output of max. value plus 10℃. Disconnection detection supported. 

System diagnosis Not supported 

Channel diagnosis Upper limit exceeding alarm and lower limit exceeding alarm. 

Software diagnosis Not supported 

Configuration 

diagnosis 

Identifying configuration errors, including channel parameter 

configuration errors. 
 

3.7.1.7 Environment requirements 

Item Specification 

Working 

environment 

temperature 

-20℃–+55℃ 

Working 

environment relative 

humidity (RH) 

RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC 

anti-interference 

level 

Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.8 Temperature detection module (FL32xx) 

3.8.1 FL3203 (4TC) 

3.8.1.1 Basic information 

FL3203
4xAnalog  Input

Thermocouple(mV), TC  24bit

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

0

1

2

3

4

5

6

7

8

CH0-

CH1-

CH2-

CH3-

NC

NC

NC

NC

PE

CH0+

CH1+

CH2+

CH3+

NC

NC

NC

NC

NC

BA

TC

 
 

Model 
Ordering 

code 
Description Applicable model 

FL3203 11016-00010 

Thermocouple, 4 channels, 24-bit 

resolution, sensitivity of 0.1℃/℉; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.8.1.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it 

is abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is 

offline. 

Slow blinking (500ms): Error in 

temperature detection. 

Off: The module works normally. 

00–03: 

Green 
Channel status indicator 

On: The channel is enabled. 

Slow blinking (500ms): Input signal out 

of range or limit. 

Fast blinking (100ms): Disconnection. 

Off: The channel is disabled. 

User 

terminal 
External wiring I/O terminal 
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Name Description 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 

3.8.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

CH0+ A0 B0 CH0- 

CH1+ A1 B1 CH1- 

CH2+ A2 B2 CH2- 

CH3+ A3 B3 CH3- 

- A4 B4 - 

- A5 B5 - 

- A6 B6 - 

- A7 B7 - 

- A8 B8 - 

 

 Terminal wiring 

Filter
CH+

CH-
TCTC

FGShield layer 
of cable

Shield 
ground

 
  

0. 0.

0. 0.
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3.8.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
250mA 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.8.1.5 Input specifications 

Item Specification 

Input channels 4 

Resolution 24-bit 

Display sensitivity 0.0625℃, 0.0625℉ 

Input terminal 4 thermocouple inputs 

Thermocouple type B, E, N, J, K, R, S, T 

Compensation method Internal cold junction compensation 

Accuracy (at room 

temperature of 25°C) 
Full scale * (±0.1%) + Cold junction compensation error 

Accuracy (in room 

temperature -20℃–55℃) 
Full scale * (±0.3%) + Cold junction compensation error 

Isolation 
I/O terminals insulated from the power supply; 
 

No insulation between channels 

Input action display None 

Input derating None 

Over-limit and 

disconnection detection 
Supported 

 
 

3.8.1.6 Cold junction compensation 

Installation direction Cold junction compensation error (-20℃–55℃) 

Horizontal and upright 

installation 
±3℃ 

Non-horizontal but 

upright installation 
±6℃ 

 

3.8.1.7 Software specifications 

Item Specification 

Configuration of 

diagnosis reporting 
Supported 
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Item Specification 

Configuration of 

enabling diagnosis 

detection 

Over-limit detection and disconnection detection supported 

Sensor type 

configuration 
Supported thermocouple types: B, E, N, J, K, R, S, T 

Filter parameter 1–255 (Default: 8) 

Overflow and underflow 

detection 
Not supported 

Configuration of 

enabling over-limit 

detection 

Supported 

Independent channel 

configuration 
Supported 

Configuration of 

enabling temperature 

offset 

Supported 

Temperature offset 

setting range 
-204.8–+204.7 temperature unit 

Sampling period 360ms/channel 

Display mode Celsius degree (℃), Fahrenheit degree (℉) 

Sensitivity 0.0625℃, 0.0625℉ 

Sampling refresh 
Sampling time based asynchronous refresh, but not bus period based 

synchronous refresh 

Disconnection or 

over-limit 
Output of max. value plus 10℃. 

System diagnosis Not supported 

Channel diagnosis 
Upper limit exceeding alarm, lower limit exceeding alarm, and 

disconnection alarm 

Software diagnosis Not supported 

Configuration diagnosis 
Identifying configuration errors, including channel parameter 

configuration errors. 
 

3.8.1.8 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.9 Hybrid module (FL5xxx) 

3.9.1 FL5005 (1616DP) 

3.9.1.1 Basic information 

2

Made in Chinawww.invt.com

Shenzhen INVT Electric Co.,Ltd.

FL5005

SN:I06228000058

DI6 DI16

DI7

SS0

DI17

SS0

A B

8

7

6

DI4

DI2

DI14

DI12

DI3

DI5

DI13

DI15

3

5

4

DI0 DI10

DI1 DI11

0

1

16xDigital Input 
16xDigital Output(PNP)
24VDC,0.5A 

C D

2

DO6 DO16

DO7

24V

DO17

0V8

7

6

DO4

DO2

DO14

DO12

DO3

DO5

DO13

DO15

3

5

4

DO0 DO10

DO1 DO11

0

1

L
O

A
D

PNP NPN

o H SR

i

 
 

Model 
Ordering 

code 
Description Applicable model 

FL5005 11016-00015 

Digital hybrid module, with 16 

channels of input + 16 channels of 

output (PNP), 500mA@24VDC; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.9.1.2 Component description 

Status 
indicator

Input signal 
indicator

Output signal 
indicator

User 
terminal

Color 
meaning

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Slow blinking (500ms): No power connected 

externally or incorrect parameter settings. 

Fast blinking (100ms): The module is offline. 

Off: The module works normally. 

Input signal 

indicator 

00–07: 

Green 

10–17: 

Green 

Each corresponds to a 

channel of input 

signal. 

On: The input is valid. 

Off: The input is invalid. 

Output 

signal 

indicator 

00–07: 

Green 

10–17: 

Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 
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Name Description 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, 

thermocouple) 
 Analog output 

 

3.9.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DI10 

DI1 A1 B1 DI11 

DI2 A2 B2 DI12 

DI3 A3 B3 DI13 

DI4 A4 B4 DI14 

DI5 A5 B5 DI15 

DI6 A6 B6 DI16 

DI7 A7 B7 DI17 

SS A8 B8 SS 

DO0 C0 D0 DO10 

DO1 C1 D1 DO11 

DO2 C2 D2 DO12 

DO3 C3 D3 DO13 

DO4 C4 D4 DO14 

DO5 C5 D5 DO15 

DO6 C6 D6 DO16 

DO7 C7 D7 DO17 

24VDC C8 D8 COM 
 

0. 0.

0. 0.
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 Terminal wiring 

A/B terminal C/D terminal 

DI0

DI7

DI10

DI17

In
te

rn
a
l circu

it

SS

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

24VDC24VDC

Source inputSink input
 

In
te

rn
a

l c
irc

u
it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

24V

DO17

DO10

DO7

DO0

 
 

3.9.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
150mA (Typical value at 5VDC) 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of 

module 
Not supported 

 

3.9.1.5 Input/output specifications 

 Input specifications 

Item Specification 

Input type Digital input 

Input mode Source/Sink 

Input channels 16 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Input current (Typical) 7mA (Typical value at 24VDC) 

ON voltage >15V 
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Item Specification 

OFF voltage <5V 

Hardware response 

time ON/OFF 
100μs/100μs 

Software filter time Supported 

Input resistance Reference value is about 3.4kΩ. 

Isolation Optocoupler 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When each terminal is operating at 55℃, it is derated to 75% (with no 

more than 12 input points of ON at the same time), or the temperature 

drops by 10℃ when all input points are ON. 
 
 

 Output specifications 

Item Specification 

Output type Digital output, high-edge output 

Output mode Source type 

Output channel 16 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load 

(Resistance load) 
0.5A/point, 2A/module 

Output load 

(Inductance load) 
7.2W/point, 12W/module 

Output load (Light 

load) 
5W/point, 18W/module 

Hardware response 

time ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 
100Hz for resistance load, 0.5Hz for resistance load, and 100ms for light 

load 

Isolation Yes 

Output action display When the output is in driving state, the output indicator is on. 

Input derating None 

Protection function Short-circuit protection and overcurrent protection 
 
 

3.9.1.6 Software specifications 

Item Specification 

Software input filter 

time 

Setting range: 1–65535 (default: 1000); unit: 10μs; 1000 indicates 10ms. 

Able to set two groups of filter parameter. Every eight channels use a 

group of filter parameter. 

Input port exception 

detection and 

indication 

None 

Input channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 
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Item Specification 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output will not be refreshed, while input supports refreshing in 

Safe-operational state. 

I/O mapping Supporting the mapping method of bitwise access 
 

3.9.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
 



INVT Flex Series I/O System User Guide  I/O module specifications 

202501 (V1.2）  90 

3.9.2 FL5105 (1616DN) 

3.9.2.1 Basic information 

2

Made in Chinawww.invt.com

Shenzhen INVT Electric Co.,Ltd.

FL5105

SN:I06228000058

DI6 DI16

DI7

SS0

DI17

SS0

A B

8

7

6

DI4

DI2

DI14

DI12

DI3

DI5

DI13

DI15

3

5

4

DI0 DI10

DI1 DI11

0

1

16xDigital Input 
16xDigital Output(NPN)
24VDC,0.5A 

C D

2

DO6 DO16

DO7

COM0

DO17

COM08

7

6

DO4

DO2

DO14

DO12

DO3

DO5

DO13

DO15

3

5

4

DO0 DO10

DO1 DO11

0

1

PNP NPN

L
O

A
D

o H SR

i

 
 

Model 
Ordering 

code 
Description Applicable model 

FL5105 11016-00014 

Digital hybrid module, with 16 

channels of input + 16 channels of 

output (NPN), 500mA @ 24VDC; 

RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.9.2.2 Component description 

Status 
indicator

Input signal 
indicator

Output signal 
indicator

User 
terminal

Color meaning

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Slow blinking (500ms): Channel 

overheat/overcurrent alarm or incorrect 

parameter settings. 

Fast blinking (100ms): The module is offline. 

Off: The module works normally. 

Input signal 

indicator 

00–07: 

Green 

10–17: 

Green 

Each corresponds to a 

channel of input 

signal. 

On: The input is valid. 

Off: The input is invalid. 
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Name Description 

Output 

signal 

indicator 

00–07: 

Green 

10–17: 

Green 

Each corresponds to a 

channel of output 

signal. 

On: Enable output. 

Off: Disable output. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, 

thermocouple) 
 Analog output 

 

3.9.2.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

DI0 A0 B0 DI10 

DI1 A1 B1 DI11 

DI2 A2 B2 DI12 

DI3 A3 B3 DI13 

DI4 A4 B4 DI14 

DI5 A5 B5 DI15 

DI6 A6 B6 DI16 

DI7 A7 B7 DI17 

SS A8 B8 SS 

DO0 C0 D0 DO10 

DO1 C1 D1 DO11 

DO2 C2 D2 DO12 

DO3 C3 D3 DO13 

DO4 C4 D4 DO14 

DO5 C5 D5 DO15 

DO6 C6 D6 DO16 

DO7 C7 D7 DO17 

COM C8 D8 COM 
 

0. 0.

0. 0.
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 Terminal wiring 

A/B terminal C/D terminal 

DI0

DI7

DI10

DI17

In
te

rn
a
l circu

it
SS

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

24VDC24VDC

Source inputSink input
 

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

DO17

DO10

DO7

DO0

COM

 
 

3.9.2.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
250mA (Typical value at 5VDC) 

Terminal input power 

rated voltage 
None 

Terminal input power 

rated current 
None 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of 

module 
Not supported 

 

3.9.2.5 Input/output specifications 

 Input specifications 

Item Specification 

Input type Digital input 

Input mode Source/Sink 

Input channels 16 

Input voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Input current (Typical) 7mA (Typical value at 24VDC) 

ON voltage >15V 
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Item Specification 

OFF voltage <5V 

Hardware response 

time ON/OFF 
100μs/100μs 

Software filter time Supported 

Input resistance Reference value is about 3.4kΩ. 

Isolation Optocoupler 

Input action display When the input is in driving state, the input indicator is on. 

Input derating 

When each terminal is operating at 55℃, it is derated to 75% (with no 

more than 12 input points of ON at the same time), or the temperature 

drops by 10℃ when all input points are ON. 

 Output specifications 

Item Specification 

Output type Digital output, low-edge output 

Output mode Sink 

Output channel 16 

Output voltage class 24VDC±10% (21.6VDC–26.4VDC) 

Output load 

(Resistance load) 
0.5A/point, 4A/module 

Output load 

(Inductance load) 
7.2W/point, 24W/module 

Output load (Light 

load) 
5W/point, 18W/module 

Hardware response 

time ON/OFF 
100μs/100μs 

Leakage current at OFF 10μA 

Switch frequency 
100Hz for resistance load, 0.5Hz for resistance load, and 100ms for light 

load 

Isolation Yes 

Output action display When the output is in driving state, the output indicator is on. 

Input derating None 
 
 

3.9.2.6 Software specifications 

Item Specification 

Software input filter 

time 

Setting range: 1–65535 (default: 1000); unit: 10μs; 1000 indicates 10ms. 

Able to set two groups of filter parameter. Every eight channels use a 

group of filter parameter. 

Input port exception 

detection and 

indication 

None 

Input channel logic 

level configuration 
Not supported 

Configuration of 

independent channel 

enabling 

Not supported 

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 
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Item Specification 

In stop mode 
Output will not be refreshed, while input supports refreshing in 

Safe-operational state. 

I/O mapping Supporting the mapping method of bitwise access 
 

3.9.2.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.10 Power feed module (FL7200) 

3.10.1 FL7200 (PWR) 

3.10.1.1 Basic information 

FL7200
Power Feed Module

24VDC,2.5A

SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

0

1

2

3

4

5

6

7

8

0V

0V

0V

0V

0V

0V

0V

0V

PE

24V

24V

24V

24V

24V

24V

24V

24V

PE

BA

 
 

Model 
Ordering 

code 
Description Applicable model 

FL7200 11016-00028 
Power feed module, input 24VDC, 

output 5VDC 2.5A; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.10.1.2 Component description 

Color meaning

Status indicator

User terminal

 
 

Name Description 

Status 

indicator 
R: Yellow green 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 
Power feed 

 Counting and measuring 
  

0. 0.

0. 0.
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3.10.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

24V A0 B0 0V 

24V A1 B1 0V 

24V A2 B2 0V 

24V A3 B3 0V 

24V A4 B4 0V 

24V A5 B5 0V 

24V A6 B6 0V 

24V A7 B7 0V 

PE A8 B8 PE 

 

 Terminal wiring 

A /B terminal                    C/D terminal 

DI0

DI7

DI10

DI17

In
te

rn
a
l circu

it

SS

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

24VDC24VDC

Source inputSink input
   

In
te

rn
a
l circu

it

24VDC

LOAD

LOAD

LOAD

LOAD

COM

24V

DO17

DO10

DO7

DO0
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3.10.1.4 Power supply specifications 

Item Specification 

External input rated 

voltage 
24VDC (-15%–+20%) 

External input rated 

current 
0.8A 

Output rated voltage 5VDC(4.5–5.5VDC) 

Output rated current 2.5A (Typical value at room-temperature 25℃) 

Output protection Short circuit protection, hiccup protection 
 

3.10.1.5 Software specifications 

Item Specification 

Module addressing Not supported 

Module status reading Not supported 
 

3.10.1.6 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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3.11 Counting and measuring module (FL6xxx) 

3.11.1 FL6002 (2ES) 

3.11.1.1 Basic information 

FL6002
SSI 2x24V,RS422
24VDC,0.5A
SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

 D1+

D1-

 C1+

C1-

COM

DI1

PE

DO1

0

1

2

3

4

5

6

7

0V8

A B
 D0+

D0-

 C0+

C0-

VO

DI0

SS

DO0

24V

Load

Power in

NPNPNP

COM(0V)

VO(24V)
Encoder

D+
D-
C+
C-

  
 

Model 
Ordering 

code 
Description Applicable model 

FL6002 11016-00022 
SSI absolute encoder input, 2 

channels, 24VDC, 2MHz; RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.11.1.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): No power connected 

externally or incorrect parameter settings. 

Off: The module works normally. 

Signal 

indicator 

D0/C0: Green 

D1/C1: Green 

SSI encoder signal 

detection Indicator. 

On: The differential voltage level difference of 

data/clock remains positive. 

Off: The differential voltage level difference of 

data/clock remains negative. 

X0/X1: Green 
Digital input signal 

indicator 

On: The input signal is valid. 

Off: The input signal is invalid. 

Y0/Y1: Green 
Digital output signal 

indicator 

On: Enable output. 

Off: Disable output. 
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Name Description 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 
Power feed 

 Counting and measuring 
 

3.11.1.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

D0+ A0 B0 D1+ 

D0- A1 B1 D1- 

C0+ A2 B2 C1+ 

C0- A3 B3 C1- 

VO A4 B4 COM 

DI0 A5 B5 DI1 

SS A6 B6 PE 

DO0 A7 B7 DO1 

24V A8 B8 0V 

 

0. 0.

0. 0.
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 Terminal wiring 

D+

C+

C-

DI

In
te

rn
a
l circu

it

SS

PNP
DI and Encoder

NPN
DI and Encoder

Encoder
+

-

0V

24V

DO

COM

VO

LOAD

VO

COM

D-

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

 

3.11.1.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
140mA 

Terminal input power 

rated voltage 
24VDC (20.4VDC–28.8VDC) 

Terminal input power 

rated current 
2A (Typical value at 24VDC) 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 

 

3.11.1.5 Input specifications 

Item Specification 

Encoder type SSI absolute encoder 

Input mode RS422 electrical level standards, differential input 
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Item Specification 

Input channel 2 

Encoder voltage 24VDC±15% 

SSI frame length 10–40 (Default: 13) 

SSI clock frequency (Hz) 125k, 250k, 500k, 1M, 1.5M, 2M 

Signal type Binary/Gray (default) 

Number of DI channels 2 

DI detection electrical 

level 
24VDC 

DI type PNP (source type)/NPN (sink type) 

DI edge selection Rising edge/Falling edge/Rising or falling edge 

DI filter time setting (0–65535)*0.1μs 

DI function Latch, preset, and clear 

Number of DO channels 2 

DO level 24VDC 

DO type PNP (source type), rated output current 0.16A 

DO function Comparison output 

ON voltage >15V 

OFF voltage <5V 

Hardware response time 

ON/OFF 
100μs/100μs 

Input resistance Reference value about 3.4kΩ 

Isolation Optocoupler 

Measurement variable Frequency/Speed 

Update time of the 

measurement function 
20ms/100ms/500ms/1000ms 

Gating function Software gate 

 

3.11.1.6 Software specifications 

Item Specification 

Software input filter 

time 
Setting range: 0–65535 (default: 1000); unit: indicates 0.1μs.  

Configuration of 

diagnosis reporting 
Diagnosis information will be uploaded by default. 

In stop mode 
Output will not be refreshed, while input supports refreshing in 

Safe-operational state. 

 

3.11.1.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 
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Item Specification 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 

 

 

3.11.2 FL6112 (2EI) 

3.11.2.1 Basic information 

FL6112
Count 2x24V
24VDC,0.5A
SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

A1

B1

Z1

DI1

SS

COM

PE

DO1

0

1

2

3

4

5

6

7

0V8

A B
A0

B0

Z0

DI0

SS

VO

PE

DO0

24V

NPN
DI and Encoder

Load

COM
(0V)

VO
(24V)

Power in

PNP
DI and Encoder

编码器Encoder
+

-

 
 

Model 
Ordering 

code 
Description Applicable model 

FL6112 11016-00019 
incremental encoder input, 2 

channels,24VDC,200kHz;RoHS 

Applicable to INVT Flex/TS/TM 

series 

 



INVT Flex Series I/O System User Guide  I/O module specifications 

202501 (V1.2）  106 

3.11.2.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): No power connected 

externally or incorrect parameter settings. 

Off: The module works normally. 

C0: Green 
Channel 0 enabling 

status indicator 
On: Encoder channel enabled. 

C1: Green 
Channel 1 enabling 

status indicator 
Off: Encoder channel disabled. 

Signal 

indicator 

A0/B0/Z0: 

Green 

Encoder channel 0 

input signal indicator 

On: The input signal is valid. 

Off: The input signal is invalid. 

A1/B1/Z1: 

Green 

Encoder channel 1 

input signal indicator 

 

On: The input signal is valid. 

Off: The input signal is invalid. 

00/01: Green 
Channel 0 digital input 

indicator 

On: The input signal is valid. 

Off: The input signal is invalid. 
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Name Description 

10/11: Green 
Channel 1 digital input 

indicator 

On: The input signal is valid. 

Off: The input signal is invalid. 

Y0: Green 
Channel 0 digital 

output indicator 

On: Output enabled. 

Off: Output disabled. 

Y1: Green 
Channel 1 digital 

output indicator 

On: Output enabled. 

Off: Output disabled. 

User 

terminal 
External wiring I/O terminal 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 
Power feed 

 Counting and measuring 
 

3.11.2.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

A0 A0 B0 A1 

B0 A1 B1 B1 

Z0 A2 B2 Z1 

DI0 A3 B3 DI1 

SS A4 B4 SS 

VO A5 B5 COM 

PE A6 B6 PE 

DO0 A7 B7 DO1 

24V A8 B8 0V 

 

0. 0.

0. 0.
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 Terminal wiring 

A0

B0

Z0

DI0

In
te

rn
a

l c
irc

u
it

SS

Optocoupler 
isolation

PNP
DI and Encoder

NPN
DI and Encoder

Encoder
+

-

0V

24V

DO0

COM

VO

LOAD

VO

COM

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation
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3.11.2.4 Power supply specifications 

Item Specification 

Fieldbus input power rated voltage 5VDC (4.75VDC–5.25VDC) 

Fieldbus input power rated current 140mA (Typical value at 5VDC) 

Terminal input power rated voltage 24VDC (20.4VDC–28.8VDC) 

Terminal input power rated current 2A (Typical value at 24VDC) 

Terminal output power rated voltage None 

Terminal output power rated current None 

Hot swapping of module Not supported 
 

3.11.2.5 Input specifications 

Item Specification 

Encoder type Incremental encoder 

Input channel 2 

Encoder voltage 24VDC±15% 

Pulse mode 
Phase difference pulse/pulse+direction input (supports 

directionless signals) 

Counting range -2147483648–2147483647 

Pulse frequency 200kHz 

Frequency multiplication 

mode 
x1/x2/x4 

Resolution 1–65535PPR (number of pulses per revolution) 

Counter preset Default is 0, which means the preset is disabled. 

Z-pulse calibration Supported by default when Z signal is connected. 

Counter filter (0–65535)*0.1μs per channel 

Number of DI channels 2 

DI function Latch 

DI detection electrical level 24VDC 

DI type PNP (source type)/NPN (sink type) 

DI edge selection Rising edge/Falling edge/Rising or falling edge 

DI filter time setting (0–65535)*0.1μs 

Number of DO channels 2 

DO function Comparison output 

DO level 24VDC 

DO type PNP (source type), rated output current 0.16A 

DO function Comparison output 

ON voltage >15V 

OFF voltage <5V 

Hardware response time 

ON/OFF 
100μs/100μs 

Input resistance Reference value about 3.4kΩ 

Isolation Optocoupler 
 

3.11.2.6 Software specifications 

Item Specification 

Input filter time Setting range: 0–65535 (default: 1000); unit: 0.1μs 

Measurement variable Frequency/Speed 
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Item Specification 

Update time of the 

measurement function 
20ms/100ms/500ms/1000ms 

Gating function Software gate 
 

3.11.2.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
 



INVT Flex Series I/O System User Guide  I/O module specifications 

202501 (V1.2）  111 

3.11.3 FL6121 (1EI_DF) 

3.11.3.1 Basic information 

FL6121
Count  1x5V,RS422
24VDC,0.5A
SN:I06228000058

QC
PASS

o H SR

i

Shenzhen INVT Electric Co.,Ltd
www.invt.com Made in china

A-

B-

Z-

COM

DI1

NC

PE

DO1

0

1

2

3

4

5

6

7

0V8

A B
A+

B+

Z+

VO

DI0

DI2

SS

DO0

24V

Load

Power in

NPNPNP

COM(0V)

VO(5V)Encod
er

A+
A-
B+
B-
Z+
Z-

 
 

Model 
Ordering 

code 
Description Applicable model 

FL6121 11016-00021 
Incremental encoder differential input, 

1 channels,5VDC,2MHz;RoHS 

Applicable to INVT Flex/TS/TM 

series 
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3.11.3.2 Component description 

Color meaning

Status indicator

Signal indicator

User terminal

 
 

Name Description 

Status 

indicator 

R: Yellow 

green 

Power-on/Run status 

indicator 

On: The module is running. 

Slow blinking (500ms): The module is 

establishing communication. 

Off: The module is not powered on or it is 

abnormal. 

E: Red Module fault indicator 

Fast blinking (100ms): The module is offline. 

Slow blinking (500ms): No power connected 

externally or incorrect parameter settings. 

Off: The module works normally. 

EN: Green 
Enabling status 

indicator 
On: Encoder channel enabled. 

Signal 

indicator 

A0/B0/Z0: 

Green 

Encode channel input 

signal indicator 

 

On: The input signal is valid. 

Off: The input signal is invalid. 

X0/X1/X2: 

Green 
Digital input indicator 

On: The input signal is valid. 

Off: The input signal is invalid. 

Y0/Y1: Green Digital output indicator 
On: Output enabled. 

Off: Output disabled. 

User 

terminal 
External wiring I/O terminal 
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Name Description 

Color 

meaning 

 Digital input  

Digital output (source, 

sink, relay) 

 

Analog input (voltage, 

current, thermocouple)  Analog output 

 
Power feed 

 Counting and measuring 
 

3.11.3.3 Terminal definition and wiring 

 Terminal definition 

Schematic diagram Left signal Left terminal Right terminal Right signal 

 

A+ A0 B0 A- 

B+ A1 B1 B- 

Z+ A2 B2 Z- 

VO A3 B3 COM 

DI0 A4 B4 DI1 

DI2 A5 B5 / 

SS A6 B6 PE 

DO0 A7 B7 DO1 

24V A8 B8 0V 

 

0. 0.

0. 0.
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 Terminal wiring 

A

B

Z

DI

In
te

rn
a

l c
irc

u
it

SS

PNP
DI and Encoder

NPN
DI and Encoder

Encoder
+

-

0V

24V

DO

COM

VO

LOAD

VO

COM

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation

Optocoupler 
isolation
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3.11.3.4 Power supply specifications 

Item Specification 

Fieldbus input power 

rated voltage 
5VDC (4.75VDC–5.25VDC) 

Fieldbus input power 

rated current 
140mA (Typical value at 5VDC) 

Terminal input power 

rated voltage 
24VDC (20.4VDC–28.8VDC) 

Terminal input power 

rated current 
2A (Typical value at 24VDC) 

Terminal output power 

rated voltage 
None 

Terminal output power 

rated current 
None 

Hot swapping of module Not supported 
 

3.11.3.5 Input specifications 

Item Specification 

Encoder type Incremental encoder 

Input channel 1 

Encoder voltage 5VDC 

Input type RS422 electrical level standards, differential input 

Pulse mode 
Phase difference pulse/pulse+direction input (supports directionless 

signals) 

Counting range -2147483648–2147483647 

Pulse frequency 100Hz–2MkHz 

Frequency 

multiplication mode 
x1/x2/x4 

Resolution 1–65535PPR (number of pulses per revolution) 

Counter preset Default is 0, which means the preset is disabled. 

Z-pulse calibration Supported by default when Z signal is connected. 

Counter filter (0–65535)*10ns per channel 

Number of DI channels 3 

DI function Latch, preset, and reset 

DI detection electrical 

level 
24VDC 

DI type PNP (source type)/NPN (sink type) 

DI edge selection Rising edge/Falling edge/Rising or falling edge 

DI filter time setting (0–65535)*10ns 

Hardware reset Rising edge reset 

Number of DO 

channels 
2 

DO function Comparison output 

DO level 24VDC 

DO type PNP (source type), rated output current 0.16A 

ON voltage >15V 

OFF voltage <5V 

Hardware response 100μs/100μs 
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Item Specification 

time ON/OFF 

Input resistance Reference value about 3.4kΩ 

Isolation Optocoupler 
 

3.11.3.6 Software specifications 

Item Specification 

Input filter time Setting range: 0–65535 (default: 1000); unit: indicates 10ns.  

Measurement variable Frequency/Speed 

Update time of the 

measurement function 
20ms/100ms/500ms/1000ms 

Gating function Software gate 
 

3.11.3.7 Environment requirements 

Item Specification 

Working environment 

temperature 
-20℃–+55℃ 

Working environment 

relative humidity (RH) 
RH < 95%, no condensation 

Storage temperature -40℃–+70℃ (RH < 90%, no condensation) 

Air No corrosive gas 

Altitude Lower than 3000m 

Pollution degree Below degree 2 

Immunity 2kV power cable, compliant with IEC61000-4-4 

Overvoltage category Category II 

EMC anti-interference 

level 
Zone B, compliant with IEC61131-2 

Vibration resistance Compliant with IEC60068-2-6 

Impact resistance Compliant with IEC60068-2-27 
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4 Installation 

4.1 Preparing 

4.1.1 Installation precautions 

Before installation 

 

 Make sure all product modules have been powered off before installation. 

 Check the planned overall size and ensure that there is enough space to 

accommodate the product modules. The module must be installed in a cabinet 

with each clearance to the surrounding greater than 50mm so that the product 

hardware has good heat dissipation. 
 

During installation 

 

 During installing, use the installation tools that meet the requirements, such as 

screws and gaskets. 

 Prevent metal wire heads, debris, screws, and other objects from falling into the 

internal of the product. Otherwise, short circuit may occur, or heat dissipation 

may be degraded. 
 

After installation 

 

 Ensure that the terminal of the connected communication cable is firmly 

fastened. 

 Ensure that the rail that hosts the module is reliably fixed. 

 Ensure that the strong-electricity cables are separately routed from the 

weak-electricity cables, and the cables are routed neatly in the cabinet. 

 After installation, please remove the sticker attached to the module's ventilation 

holes to ensure smooth heat dissipation. 

 After installation, check the air circulation around the module. 
 

4.1.2 Installation environment and site 

Check the installation environment and ensure that the environment meets the working conditions of all the 

components of the product, which include temperature, humidity, dust and corrosion protection 

requirements. 

 Environment requirements 

Environm

ent 
Requirement 

Temperat

ure 

 

 -20℃–55℃ 

 There is no sudden temperature change. 

 When the product is installed in a closed space, such as control 

cabinet, use a cooling fan or air conditioner for temperature 

adjustment if necessary. 

Humidity 

 

 RH: 5%–95%, no condensation 

 Site requirement 
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Site Requirement 

Indoor, 

overvoltag

e class II 

 
 No strong electric field, strong magnetic field, or direct sunlight 

 

 No dust, conductive powder such as iron powder, oil mist, salt, or 

organic solvent 

 
 No corrosive gas or flammable gas 

 

 No factors that will cause the machine to directly vibrate or suffer 

conductive shocks 
 

4.1.3 Installation space 

Sufficient space should be reserved between the top and bottom of the module and the housing and other 

components to facilitate product replacement, ventilation, and heat dissipation. 

Figure 4-1 Installation space (unit: mm) 

≥ ≥≥

≥
≥

5
0

5
0

6050 50
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4.2 Installation dimensions 

4.2.1 Communication coupler 

4.2.1.1 Module installation dimensions 

The dimensions are applicable to FK1100, FK1200, and FK1400. 

Figure 4-2 Module installation dimensions (unit: mm) 

96 25

1
0

5

5
2

.5
78.5

96.4

DIN rail 

installed 

in the 
center
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4.2.1.2 Connection cable dimensions 

The dimensions are applicable to FK1100, FK1200, and FK1400. 

Figure 4-3 Connection cable dimensions (unit: mm) 

115~130

78.5

 

4.2.1.3 End cover dimensions 

The dimensions are applicable to FK1100, FK1200, and FK1400. 

Figure 4-4 End cover dimensions (unit: mm) 

87

6.5

4.3

1
0

5

96
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4.2.2 I/O module 

4.2.2.1 Module installation dimensions 

The dimensions are applicable to FL1001, FL2002, FL2102, FL3003, FL3103, FL3203, and FL4003. 

Figure 4-5Module installation dimensions set 1 (unit: mm) 

96

99.5

1
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5

12.5

14.7

5
2

.5

DIN rail 

installed in 

the center

 
 

The dimensions are applicable to FL1002, FL2003, FL2103, FL2201, FL5005, and FL5105. 

Figure 4-6 Module installation dimensions set 2 (unit: mm) 

96

99.5
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DIN rail 

installed in 

the center

25

27.2
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4.2.2.2 Connection cable dimensions 

The dimensions are applicable to all I/O module models. 

Figure 4-7Connection cable dimensions (unit: mm) 
125~135

96

1
0

5

 

4.3 DIN rail model selection 

You can refer to the following table to select the applicable DIN rail model. 

Model Length x Depth (unit: mm) Fixing screw 

TH35-7.5Fe 35×7.5 M4 

TH35-7.5A1 35×7.5 M4 

TH35-15Fe 35×15 M4 
 

Figure 4-8 DIN rail installation dimensions (unit: mm) 

≤200≤200 ≤30

3
5

≤30 ≤200

DIN rail DIN rail installation bolt (user provided)

 

Note: To ensure the strength of the DIN rail, install the DIN rail installation bolts (provided by yourself) at 

the places within 30mm from both ends of the DIN rail, (for details, see Figure 4-8), and ensure that the 

interval between two adjacent bolts must be within 200mm. 

4.4 Installation 

The installation procedure is as follows: 
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Step 1 Slide the right end cover of the communication coupler forward and remove it. 

End cover

 

Step 2 Align the communication coupler module with the DIN rail and press inward until the module 

engages with the DIN rail (there is a noticeable sound of engagement when installed in place). 

DIN rail

 

Step 3 Align the module with the connection rail with the sliding rail of the module fixed on the DIN rail, and 

push it inward until the module with the connection rail engages with the DIN rail (there is a noticeable 

sound of engagement when installed in place). 
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Connection 
slot

Sliding slot

Sliding 
slot

 

Step 4 Slide the end cover with the connection rail onto the last I/O module. 

End 
cover

Connection  
slot

Sliding 
slot

 

Note: The metal pins on the last I/O module must not be exposed outside. 

Step 5 Install a guide rail fixing clip at the head and tail of the module assembly to prevent it from sliding 

leftward or rightward. 
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Guide rail fixing clip End cover
 

 

Note: 

 Before installing the module, remove the end cover before proceeding with the next step. Install the 

end cover on the rightmost module. 

 After the module installation is completed, the rail latch will automatically lock. If the rail latch is not 

locked with the DIN rail, press the top of the latch towards the rail to ensure proper installation. 

 The rail fixing clip is user purchased. 

4.5 Disassembly 

The disassembly procedure is as follows: 

Step 1 Loosen the rail fixing clip to ensure that there is sufficient clearance to pull away the module from the 

DIN rail. 

Note: The rail fixing clip is user purchased. 

Step 2 Use a flat screwdriver or other similar tool to pry up the upper and lower rail latches separately. 

①

②

①

Rail latch

DIN rail

Flat screwdriver
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Step 3 Pull the module out in the direction perpendicular to the DIN rail. 

DIN rail

 

Note: Refer to step 1 in section 4.4 Installation. 
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5 Wiring 

5.1 Wiring requirements 

 Before wiring, ensure that all external power supplies have been cut off. 

 After completing the wiring, ensure the module top end cover has been installed properly before 

powering on or operating the module. Otherwise, electric shock or maloperation can result. 

 Before wiring, check the rated voltage and terminal configuration according to product specifications 

to ensure safe wiring. The connection to a power supply that does not match the ratings or incorrect 

product wiring may cause serious accidents such as fire and product damage. 

 Tighten up screws according to specified torque. If screws are loose, short circuit, fire, or maloperation 

may result. 

Note: If terminal screws are too tightened, screw or module damage, falling, short circuit, or faults may 

result. 

 Ensure that there are no metal chips or leftover wires or other foreign objects in each module. The 

foreign objects may cause short circuit, fire, or maloperation. 

5.2 Grounding requirements 

 Power cable grounding 

 Use correct, independent wiring methods. 

 Connect a cable with the cross-sectional area ≥2mm2 and length ≤30cm for grounding, and ground the 

power supply module terminal . 

 If the grounding point is close to the product, ensure that the grounding cable is secure. 

 Shielded cable grounding 

 Use shielded cables for analog I/O, RS485, and EtherCAT cables and other cables that transmit sensitive 

signals. 

 The grounding point should be as close as possible to the module. 

 For the shield part exposed after some of the shield cable is stripped, ground the part and the 

conductive backplane with an area as large as possible to ensure good contact. 

5.3 Cable specifications 

Cable material 
Cable diameter 

Crimping tool 
mm2 AWG 

Tubular cable 

lug 

0.3 22 

Use a proper crimping plier. 

0.5 20 

0.75 18 

1.0 18 

1.5 16 

Note: 

 The cable diameters of the tubular cable lugs in the preceding table is only for reference, which can be 



INVT Flex Series I/O System User Guide  Wiring 

202501 (V1.2）  128 

adjusted based on actual situations. 

 When using other tubular cable lugs, crimp multiple strands of cable, and the processing size 

requirements are as follows: 

 

5.3.1 Digital output module (Source type) 

5.3.2 Digital output module (Sink type) 

5.3.3 Digital output module (Relay) 

5.3.4 Analog input module 

5.3.5 Analog output module 

5.3.6 Temperature detection module (Thermal resistor) 

5.3.7 Temperature detection module (Thermocouple) 

5.3.8 Hybrid module 
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6 Communication coupler configuration 

6.1 EtherCAT configuration 

6.1.1 CODESYS configuration 

6.1.1.1 EtherCAT communication coupler 

1. Device import 

Step 1 Install the device description file named in the format of "FK1100_ECT_Coupler_x.x.x.x.xml". 
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Step 2 Create a project, add the master and slave devices. 

 
 

 

Step 3 Add module network configuration based on actual physical configuration (module connection). 
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Step 4 After completing the module network configuration, set all configuration module parameters. Once 

compiled, the program can be downloaded and run. 

Step 5 (Optional) Enable or disable the module based on actual needs. 

 

2. Parameter description 

Parameter Type Description 

Module Enable UDINT 

Control bit of expansion module 

enabling/disabling. 

Bit that controlling the enabling/disabling of 

the expansion module behind the coupler. 

Each bit controls the enabling/disabling of a 

module. 

Bit31 … Bit0 

Controls module 

32. 
… 

Controls 

module 1. 

TRUE: Enable. FALSE: Disable. 

Coupler Info.ActNum UINT Number of connected expansion modules. 

Coupler Info.HW Version UINT Coupler hardware version number. 

Coupler Info.SW Version USINT Coupler software version number. 

Coupler Info.FPGA Version USINT Coupler FPGA software version number. 
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Parameter Type Description 

Detected Module Ident List - Detection module ID list. 

Detected Module Ident List .SubIndex 001 UDINT ID of 1st module detected 

Detected Module Ident List .SubIndex 002 UDINT ID of 2nd module detected 

… … … 

Detected Module Ident List .SubIndex 032 UDINT ID of 32nd module detected 
 

6.1.1.2 Digital input module 

The following takes FL1001 as an example, while FL1002 is set up in a similar way and will not be described 

in detail here. 

1. Device import 

Step 1 Add the FL1001-1600DI device. 

 
 

Step 2 Set the filtering parameters. The digital input module divides every 8 points into a group, and 

different filtering parameters can be set for each group. Adjust the port filtering mode in the startup 

parameters according to actual needs, with a unit of 10μs and a default value of 10ms. 
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Step 3 Define ibButton1 and ibButton2 of the BOOL type in the program. 

 

Step 4 Choose Module I/O Mapping, map ibButton1 and ibButton2 to the corresponding input points. You 

just need to use mapped variables in the program. 

 
 

2. Parameter description 

 FL1001 

Parameter Type Description 

Filt0 UINT Filter parameters I0–I7. Unit: 10μs 

Filt1 UINT Filter parameters I10–I17. Unit: 10μs 

ErrId UINT Fault code 

I0 BIT I0 status feedback 

I1 BIT I1 status feedback 

… … … 

I17 BIT I17 status feedback 

Module Info. HW Version UINT Module hardware version number 

Module Info. FPGA Version UINT Module FPGA software version number 
 

 FL1002 

Parameter Type Description 

Filt0 UINT Filter parameters I0–I7. Unit: 10μs 

Filt1 UINT Filter parameters I10–I17. Unit: 10μs 

Filt2 UINT Filter parameters I20–I27. Unit: 10μs 

Filt3 UINT Filter parameters I30–I37. Unit: 10μs 

ErrId UINT Fault code 

I0 BIT I0 status feedback 

I1 BIT I1 status feedback 

… … … 
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Parameter Type Description 

I37 BIT I37 status feedback 

Module Info. HW Version UINT Module hardware version number 

Module Info. FPGA Version UINT Module FPGA software version number 
 

6.1.1.3 Digital output module 

The following takes FL2002 as an example, while the setting of the rest of the digital output modules is 

similar and will not be described. 

1. Device import 

Step 1 Add the FL2002-0016DP device. 

 
 

Step 2 Set the stop/offline output mode and preset value based on actual needs in the startup parameters. 

 

The digital output module divides every eight channels into a group. The following takes Stop Mode0 

configuration as an example. The corresponding output channels are Q0–Q7. The data type of Stop Mode0 is 

UINT, with every two bits defining an output stop mode. Please refer to the following table for detailed data 
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description. 

Q7 Q6 Q5 Q4 Q3 Q2 Q1 Q0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 
 

The two-digit value of the corresponding output channel represents the output mode as follows: 

Value Mode 

0b00 Stop/offline output retained 

0b01 Stop/offline output cleared 

0b10 Stop/offline output preset 
 

For example: Q0 is set to stop/offline output retention; Q1 is set to stop/offline output clearing; Q2–Q7 are 

all set to stop/offline output preset, then the value of Stop Mode0 is 43684, that is, 2#1010101010100100. 

Q7 Q6 Q5 Q4 Q3 Q2 Q1 Q0 

1 0 1 0 1 0 1 0 1 0 1 0 0 1 0 0 
 

Step 3 Define BOOL type variables obCylinder1 and obCylinder2 in the program. 

 
 

Step 4 Choose Module I/O Mapping, map obCylinder1 and obCylinder2 to the corresponding output 

points. You just need to use mapped variables in the program. 

 
 

2. Parameter description 

Parameter Type Description 

Stop Mode0 UINT 

Stop/offline output mode: 

Q7 … Q1 Q0 

Bit15 Bit14 … … Bit3 Bit2 Bit1 Bit0 

0b00: Stop/offline output retained  

0b01: Stop/offline output cleared 

0b10: Stop/offline output according to the preset 
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Parameter Type Description 

Stop Mode1 UINT 

Stop/offline output mode 

Q17 … Q11 Q10 

Bit15 Bit14 … … Bit3 Bit2 Bit1 Bit0 

0b00: Stop/offline output retained 

0b01: Stop/offline output cleared 

0b10: Stop/offline output according to the preset 

Stop Output0 USINT 

Preset value of stop/offline output: 

Q7 … Q1 Q0 

Bit7 … Bit1 Bit0 
 

Stop Output1 USINT 

Preset value of stop/offline output: 

Q17 … Q11 Q10 

Bit7 … Bit1 Bit0 
 

Q0 BIT Q0 output control 

Q1 BIT Q1 output control 

… … … 

Q17 BIT Q17 Output control 

ErrId UINT Fault ID 

Module Info. HW Version UINT Module hardware version number 

Module Info. FPGA Version UINT Module FPGA software version number 
 

6.1.1.4 Digital output module (Relay) 

1. Device import 

Step 1 Add the FL2201-0008DR device. 
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Step 2 Set the stop/offline output mode and preset value based on actual needs in the startup parameters. 

 

Note: The setting method in this part is similar to the setting in step 2 in 6.1.1.3 Digital output module, and 

will not be described. 

Step 3 Define BOOL type variables obCylinder1 and obCylinder2 in the program. 

 
 

Step 4 Choose Module I/O Mapping, map obCylinder1 and obCylinder2 to the corresponding output 

points. You just need to use mapped variables in the program. 

 
 

2. Parameter description 

Parameter Type Description 

Stop Mode UINT 

Stop/offline output mode: 

Q7 … Q1 Q0 

Bit15 Bit14 … … Bit3 Bit2 Bit1 Bit0 

0b00: Stop/offline output retained 

0b01: Stop/offline output cleared 

0b01: Stop/offline output according to the preset 

Stop Output USINT 

Preset value of stop/offline output: 

Q7 … Q1 Q0 

Bit7 … Bit1 Bit0 
 

Q0 BIT Q0 output control 

Q1– BIT Q1 output control 

… … … 

Q7 BIT Q7 output control 

ErrId UINT Fault code 

HW Version UINT Module hardware version number 

FPGA Version UINT Module FPGA software version number 
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6.1.1.5 Analog input module 

1. Device import 

Step 1 Add the FL3003-4AD device. 

 
 

Step 2 Set the channel configuration and channel filter parameters based on actual needs in the startup 

parameters. 

 
 

 AIx Cfg(x=0,1,2,3) is a channel configuration parameter of type USINT. Taking the configuration of 

channel 0 as an example, the data definitions are detailed in the following table of parameters.  
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Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

Channel conversion mode (range 

configuration) 

Enhanced 

filter 

enabling 

control 

Over-range 

enabling 

control 

Over-range 

detection 

enabling 

control 

Open-loop 

detection 

enabling 

control 

Channel 

enabling 

control 

0b000: 0–5V 

0b001: 0–10V 

0b010: -5V–5V 

0b011: -10V–+10V 

0b100: 4–20mA 

0b101: 0–20mA 

0b110: Reserved 

0b111: -20–+20mA 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

 

For example: Channel 0 is set to channel enabled, open-circuit detection disabled, over-range detection 

enabled, over-range enabled, enhanced filtering disabled, and the range is set to 4-20mA. The value should 

be 141, that is, 2#10001101. Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

0b100 0 1 1 0 1 

0b100:4–20mA 0: Disable 1: Enable 1: Enable 0: Disable 1: Enable 
 

Range conversion: 

Measurement 

range 

Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range 

Conversion 

formula 

0–5V 

8.19175V 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×U/5 

U = D×5/20000 

5V 20000 0x4E20 

Rated range 2.5V 10000 0x2710 

0V 0 0x0000 

-2.5V -10000 0xD8F0 
Beyond lower 

limit 
-5V -20000 0xB1E0 

-8.19175V -32768 0x8000 

0–10V 

16.3835V 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×U/10 

U = D×10/20000 

10V 20000 0x4E20 

Rated range 5V 10000 0x2710 

0V 0 0x0000 

-5V -10000 0xD8F0 
Beyond lower 

limit 
-10V -20000 0xB1E0 

-16.3835V -32768 0x8000 

±5V 

8.19175V 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×U/5 

U = D×5/20000 

5V 20000 0x4E20 

Rated range 

2.5V 10000 0x2710 

0V 0 0x0000 

-2.5V -10000 0xD8F0 

-5V -20000 0xB1E0 

-8.19175V -32768 0x8000 
Beyond lower 

limit 

±10V 

16.3835V 32767 0x7FFF 
Beyond upper 

limit D = 20000×U/10 

U = D×10/20000 10V 20000 0x4E20 
Rated range 

5V 10000 0x2710 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  140 

Measurement 

range 

Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range 

Conversion 

formula 

0V 0 0x0000 

-5V -10000 0xD8F0 

-10V -20000 0xB1E0 

-16.3835V -32768 0x8000 
Beyond lower 

limit 

4–20mA 

30.2136mA 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×(I-4)/16 

I = D×16/20000+4 

20mA 20000 0x4E20 

Rated range 12mA 10000 0x2710 

4mA 0 0x0000 

0mA -5000 0xEC78 Beyond lower 

limit -22.2136mA -32768 0x8000 

0–20mA 

32.767mA 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×I/20 

I = D×20/20000 

20mA 20000 0x4E20 

Rated range 10mA 10000 0x2710 

0mA 0 0x0000 

-10mA -10000 0xD8F0 
Beyond lower 

limit 
-20mA -20000 0xB1E0 

-32.767mA -32768 0x8000 

±20mA 

32.767mA 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×I/20 

I = D×20/20000 

20mA 20000 0x4E20 

Rated range 

10mA 10000 0x2710 

0mA 0 0x0000 

﹣10mA -10000 0xD8F0 

﹣20mA -20000 0xB1E0 

﹣32.767mA -32768 0x8000 
Beyond lower 

limit 
 

 AIx_Filt(x=0,1,2,3) is a channel filter parameter of type USINT. The parameter setting range is 1 to 255. 

Generally, a higher value indicates better suppression of high-frequency interference, but it also leads 

to greater delay. It should be adjusted according to the actual situation. 

 

Step 3 Define INT type variables iValueAD0 and iValueAD1 in the program. 
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Step 4 Choose Module I/O Mapping, map iValueAD0 and iValueAD1 to the corresponding input channels. 

You just need to use mapped variables in the program. 

 
 

2. Parameter description 

Parameter 

name 
Type Description 

AI0 Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: Enable.) 

Bit1: Open-loop detection enabling control. (0: Disable. 1: 

Enable.) 

Bit2: Over-range detection enabling control. (0: Disable. 1: 

Enable.) 

Bit3: Over-range enabling control. (0: Disable. 1: Enable.) 

Bit4: Enhanced filter enabling control. (0: Disable. 1: Enable.) 

Bit7–Bit5: Channel conversion mode. 

0b000: Voltage range 0–5V, corresponding to detection value 

range 0–20000 

0b001: Voltage range 0–10V, corresponding to detection value 

range 0–20000 

0b010: Voltage range -5–5V, corresponding to detection value 

range -20000–20000 

0b011: Voltage range -10–10V, corresponding to detection value 

range -20000–20000 

0b100: Current range 4–20mA, corresponding to detection value 

range 0–20000 

0b101: Current range 0–20mA, corresponding to detection value 

range 0–20000 

0b110: Reserved 

0b111: Current range -20–20mA, corresponding to detection 

value range -20000–20000 

AI1 Cfg USINT 
Configuration parameter for channel 1. The parameter setting is 

consistent with that for channel 0. 

AI2 Cfg USINT 
Configuration parameter for channel 2. The parameter setting is 

consistent with that for channel 0. 

AI3 Cfg USINT 
Configuration parameter for channel 3. The parameter setting is 

consistent with that for channel 0. 

AI0 Filt USINT 

Filter parameter for channel 0. 

Range: 1–255. A greater value indicates better filter effect but 

greater lagging. 

AI1 Filt USINT 
Filter parameter for channel 1. The filter parameter setting is 

consistent with that for channel 0. 
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Parameter 

name 
Type Description 

AI2 Filt USINT 
Filter parameter for channel 2. The filter parameter setting is 

consistent with that for channel 0. 

AI3 Filt USINT 
Filter parameter for channel 3. The filter parameter setting is 

consistent with that for channel 0. 

AI0 INT Conversion value for channel 0. 

AI1 INT Conversion value for channel 1. 

AI2 INT Conversion value for channel 2. 

AI3 INT Conversion value for channel 3. 

AI0_ErrId UINT Fault code for channel 0. 

AI1_ErrId UINT Fault code for channel 1. 

AI2_ErrId UINT Fault code for channel 2. 

AI3_ErrId UINT Fault code for channel 3. 

HW Version UINT Module hardware version number. 

FPGA Version UINT Module FPGA software version number. 
 

6.1.1.6 Analog output module 

1. Device import 

Step 1 Add the FL4003-4DA device. 

 

Step 2 Set the channel configuration and stop/offline output mode preset value parameters based on 
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actual needs in the startup parameters. 

 
 

 AOx Cfg(x=0,1,2,3) is a channel configuration parameter of type USINT. Taking the configuration of 

channel 0 as an example, the data definitions are detailed in the following table of parameters. 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

Channel conversion mode Reserved 

Output fault 

detection enabling 

control 

Output fault 

detection 

enabling control 

Channel 

enabling 

control 

0b000: 0–5V 

0b001: 0–10V 

0b010: -5–5V 

0b011: -10–+10V 

0b100: 4–20mA 

0b101: 0–20mA 

0b110: Reserved 

0b111: Reserved 

- 

0b00: Offline output 

retained 

0b01: Offline output 

cleared 

0b10: Offline output 

preset 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

 

For example: Channel 0 is configured as channel enabled, output fault detection enabled, offline output 

cleared, and channel conversion mode is set to 4–20mA. The value should be 135, that is, 2#10000111. 

Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

0b100 0 0b01 1 1 

0b100:4–20mA - 
0b01: Offline output 

cleared 
1: Enable 

1: Enable 

 

Range conversion: 

Output range 
Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range Conversion formula 

0-5V 

5V 20000 0x4E20 

Rated range 
D = 20000×U/5 

U = D×5/20000 
2.5V 10000 0x2710 

0V 0 0x0000 

0-10V 

10V 20000 0x4E20 

Rated range 
D = 20000×U/10 

U = D×10/20000 
5V 10000 0x2710 

0V 0 0x0000 

±5V 

5V 20000 0x4E20 

Rated range 
D = 20000×U/5 

U = D×5/20000 

2.5V 10000 0x2710 

0V 0 0x0000 

﹣2.5V -10000 0xD8F0 

﹣5V -20000 0xB1E0 

±10V 

10V 20000 0x4E20 

Rated range 
D = 20000×U/10 

U = D×10/20000 

5V 10000 0x2710 

0V 0 0x0000 

﹣5V -10000 0xD8F0 

﹣10V -20000 0xB1E0 

4-20mA 20mA 20000 0x4E20 Rated range D = 20000×(I-4)/16 
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Output range 
Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range Conversion formula 

12mA 10000 0x2710 I = D×16/20000+4 

4mA 0 0x0000 

0-20mA 

20mA 20000 0x4E20 

Rated range 
D = 20000×I/20 

I = D×20/20000 
10mA 10000 0x2710 

0mA 0 0x0000 
 

 AIx_Stop Output (x=0,1,2,3) is used for stop/offline output mode control, which can be set as described 

in 6.1.1.3 Digital output module. 

Step 3 Define INT type variables iValueDA0 and iValueDA1 in the program. 

 
 

Step 4 Choose Module I/O Mapping, map iValueDA0 and iValueDA1 to the corresponding output channels. 

You just need to use mapped variables in the program. 

 
 

2. Parameter description 

Parameter 

name 
Type Description 

AO0 Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: Enable.) 

Bit1: Output fault detection enabling control. (0: Disable. 1: 

Enable.) 

Bit3–Bit2: Offline output mode. 

0b00: Offline output retained 

0b01: Offline output cleared 

0b10: Offline output preset 

Bit4: Reserved 

Bit7–Bit5: Channel conversion mode. 

0b000: Voltage range 0–5V, corresponding to detection value 

range 0–20000 

0b001: Voltage range 0–10V, corresponding to detection value 

range 0–20000 

0b010: Voltage range -5–5V, corresponding to detection value 

range -20000–20000 

0b011: Voltage range -10–10V, corresponding to detection value 
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Parameter 

name 
Type Description 

range -20000–20000 

0b100: Current range 4–20mA, corresponding to detection value 

range 0–20000 

0b101: Current range 0–20mA, corresponding to detection value 

range 0–20000 

0b110: Reserved 

0b111: Reserved 

AO1 Cfg USINT 
Configuration parameter for channel 1. The parameter setting is 

consistent with that for channel 0. 

AO2 Cfg USINT 
Configuration parameter for channel 2. The parameter setting is 

consistent with that for channel 0. 

AO3 Cfg USINT 
Configuration parameter for channel 3. The parameter setting is 

consistent with that for channel 0. 

AO0 Stop Output INT Preset value of stop/offline output for channel 0. 

AO1 Stop Output INT Preset value of stop/offline output for channel 1. 

AO2 Stop Output INT Preset value of stop/offline output for channel 2. 

AO3 Stop Output INT Preset value of stop/offline output for channel 3. 

AO0 INT Output control value for channel 0. 

AO1 INT Output control value for channel 1. 

AO2 INT Output control value for channel 2. 

AO3 INT Output control value for channel 3. 

AO0_ErrId UINT Fault code for channel 0. 

AO1_ErrId UINT Fault code for channel 1. 

AO2_ErrId UINT Fault code for channel 2. 

AO3_ErrId UINT Fault code for channel 3. 

HW Version UINT Module hardware version number. 

FPGA Version UINT Module FPGA software version number. 
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6.1.1.7 Temperature detection module (Thermal resistor) 

1. Device import 

Step 1 Add the FL3103-4PT device. 

 

 

Step 2 Set the channel configuration, channel filter parameters, and temperature offset values based on 

actual needs in the startup parameters. 
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Note: The temperature upper limit and lower limit are reserved parameters, and therefore they do not 

need to be set. 

 Tempx Cfg(x=0,1,2,3) is a channel configuration parameter of type USINT. Taking the configuration of 

channel 0 as an example, the data definitions are detailed in the following table of parameters. 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

Channel conversion mode 

(sensor type) 

Temperature 

unit 

Thermistor 

wire system 

Over-range 

detection enabling 

control 

Channel 

enabling 

control 

000: 

Reserved 

001: PT100 

010: PT500 

011: 

Reserved 

100: PT1000 

101: 

Reserved 

110: 

Reserved 

111: CU100 

0: ℃ 

1: ℉ 

00: Two-wire 

system 

01: Three-wire 

system 

10: Four-wire 

system 

11: Reserved 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

 

For example: Channel 0 is configured as channel enabled, over-range detection enabled, using 3-wire 

system, temperature unit selected as Celsius (℃), sensor selected as PT1000. Temp0 Cfg should be 135, that 

is, 2#10000111. Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

100 0 01 1 1 

 100 : PT1000 0 : ℃ 01: Three-wire system 1: Enable 1: Enable 
 

 Tempx Filt(x=0,1,2,3) is the channel filter parameter of type USINT, with the setting range of 1–255. 

Generally, a higher value indicates better suppression of high-frequency interference, but it also leads 

to greater delay. It should be adjusted according to the actual situation. 

 Tempx Offset(x=0,1,2,3) is a temperature offset parameter of type USINT. The value is magnified by 10 

times (for example, the setting 999 represents 99.9), measured value = actual value + offset value. 

 

Step 3 Define REAL type variables rValuePT0 and rValuePT1 in the program. 

 

Step 4 Choose Module I/O Mapping, map the variables rValuePT0 and rValuePT1 to the corresponding 

input channels in the Module I/O mapping, and use the mapped variables in the program. 

 
 

2. Parameter description 
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Parameter name Type Description 

Temp0 Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: Enable.) 

Bit1: Over-range detection enabling control. (0: Disable. 1: Enable.) 

Bit3–bit2: Thermal resistor wire system. (0b00: Two-wire system. 

0b01: Three-wire system. 

0b10: Four-wire) 

Bit4: Temperature unit. (0: ℃. 1: ℉.) 

Bit7–Bit5: Channel conversion mode. 

0b000: Reserved 

0b001: PT100 

0b010: PT500 

0b011: Reserved 

0b100: PT1000 

0b101: Reserved 

0b110: Reserved 

0b111: CU100 

Temp1 Cfg USINT 
Configuration parameter for channel 1. The parameter setting is 

consistent with that for channel 0. 

Temp2 Cfg USINT 
Configuration parameter for channel 2. The parameter setting is 

consistent with that for channel 0. 

Temp3 Cfg USINT 
Configuration parameter for channel 3. The parameter setting is 

consistent with that for channel 0. 

Temp0 Filt USINT 
Filter parameter for channel 0. Range: 1–255. A greater value 

indicates better filter effect but greater lagging. 

Temp1 Filt USINT 
Filter parameter for channel 1. The filter parameter setting is 

consistent with that for channel 0. 

Temp2 Filt USINT 
Filter parameter for channel 2. The filter parameter setting is 

consistent with that for channel 0. 

Temp3 Filt USINT 
Filter parameter for channel 3. The filter parameter setting is 

consistent with that for channel 0. 

Temp0 Offset INT 

Temperature offset value for channel 0. 

The value has been amplified by 10 times, with 999 representing 

99.9. Detection value = Actually measured value + Offset value 

Temp1 Offset INT 
Temperature offset value for channel 1. The temperature offset 

value is consistent with that for channel 0. 

Temp2 Offset INT 
Temperature offset value for channel 2. The temperature offset 

value is consistent with that for channel 0. 

Temp3 Offset INT 
Temperature offset value for channel 3. The temperature offset 

value is consistent with that for channel 0. 

Temp0 Up INT 
Temperature upper limit for channel 0. Reserved. The sensor 

provided limit value is used. 

Temp1 Up INT 
Temperature upper limit for channel 1. Reserved. The sensor 

provided limit value is used. 

Temp2 Up INT 
Temperature upper limit for channel 2. Reserved. The sensor 

provided limit value is used. 

Temp3 Up INT 
Temperature upper limit for channel 3. Reserved. The sensor 

provided limit value is used. 

Temp0 Low INT 
Temperature lower limit for channel 0. Reserved. The sensor 

provided limit value is used. 
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Parameter name Type Description 

Temp1 Low INT 
Temperature lower limit for channel 1. Reserved. The sensor 

provided limit value is used. 

Temp2 Low INT 
Temperature lower limit for channel 2. Reserved. The sensor 

provided limit value is used. 

Temp3 Low INT 
Temperature lower limit for channel 3. Reserved. The sensor 

provided limit value is used. 

Temp0 REAL Conversion value for channel 0. 

Temp1 REAL Conversion value for channel 1. 

Temp2 REAL Conversion value for channel 2. 

Temp3 REAL Conversion value for channel 3. 

Temp0_ErrId UINT Fault code for channel 0. 

Temp1_ErrId UINT Fault code for channel 1. 

Temp2_ErrId UINT Fault code for channel 2. 

Temp3_ErrId UINT Fault code for channel 3. 

HW Version UINT Module hardware version number. 

FPGA Version UINT Module FPGA software version number. 
 

6.1.1.8 Temperature detection module (Thermocouple) 

1. Programming instance 

Step 1 Add the FL3203-4TC device. 
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Step 2 Set the channel configuration, channel filter parameters, and temperature offset values based on 

actual needs in the startup parameters. 

 

Note: The temperature upper limit and lower limit are reserved parameters, and therefore they do not 

need to be set. 

 

 Tempx Cfg(x=0,1,2,3) is a channel configuration parameter of type USINT. Taking the configuration of 

channel 0 as an example, the data definitions are detailed in the following table of parameters. 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

Channel conversion mode (sensor 

type) 

Temperature 

unit 
Reserved 

Over-range 

detection 

enabling control 

Channel 

enabling 

control 

0b00: 

Thermocouple of 

type B. 

0b001: 

Thermocouple of 

type E. 

0b010: 

Thermocouple of 

type J. 

0b011: 

Thermocouple of 

type K. 

0b100: 

Thermocouple of 

type N. 

0b101: 

Thermocouple of 

type R. 

0b110: 

Thermocouple of 

type S. 

0b111: 

Thermocouple of 

type T. 

0: ℃ 

1: ℉ 
- 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

 

For example: Channel 0 is configured as channel enabled, over-range detection enabled, temperature unit 

selected as Celsius (℃), sensor selected as J-type thermocouple. Temp0 Cfg should be 67, that is, 

2#01000011. Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

0b010 0 0b00 1 1 

0b010: Thermocouple of type J. 0: ℃ Reserved 1: Enable 1: Enable 
 

 Tempx Filt(x=0,1,2,3) is a channel filter parameter of type USINT, with the setting range of 1–255. 

Generally, a higher value indicates better suppression of high-frequency interference, but it also leads 

to greater delay. It should be adjusted according to the actual situation. 

 Tempx Offset(x=0,1,2,3) is a temperature offset parameter of type USINT. The value is magnified by 10 
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times (for example, the setting 999 represents 99.9), measured value = actual value + offset value. 

 

Step 3 Define REAL type variables rValueTC0 and rValueTC1 in the program. 

 
 

Step 4 Map the variables rValueTC0 and rValueTC1 to the corresponding input channels in the Module I/O 

mapping, and use the mapped variables in the program. 

 
 

2. Parameter description 

Parameter name Type Description 

Temp0 Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: Enable.) 

Bit1: Over-range detection enabling control. (0: Disable. 1: Enable.) 

Bit3–Bit2: Reserved 

Bit4: Temperature unit. (0: ℃. 1: ℉.) 

Bit7–Bit5: Channel conversion mode. 

0b000: Thermocouple of type B. 

0b001: Thermocouple of type E. 

0b010: Thermocouple of type J. 

0b011: Thermocouple of type K. 

0b100: Thermocouple of type N. 

0b101: Thermocouple of type R. 

0b110: Thermocouple of type S. 

0b111: Thermocouple of type T. 

Temp1 Cfg USINT 
Configuration parameter for channel 1. The parameter setting is 

consistent with that for channel 0. 

Temp2 Cfg USINT 
Configuration parameter for channel 2. The parameter setting is 

consistent with that for channel 0. 

Temp3 Cfg USINT 
Configuration parameter for channel 3. The parameter setting is 

consistent with that for channel 0. 

Temp0 Filt USINT 

Filter parameter for channel 0. 

Range: 1–255. A greater value indicates better filter effect but 

greater lagging. 

Temp1 Filt USINT 
Filter parameter for channel 1. The filter parameter setting is 

consistent with that for channel 0. 

Temp2 Filt USINT 
Filter parameter for channel 2. The filter parameter setting is 

consistent with that for channel 0. 
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Parameter name Type Description 

Temp3 Filt USINT 
Filter parameter for channel 3. The filter parameter setting is 

consistent with that for channel 0. 

Temp0 Offset INT 

Temperature offset value for channel 0. (The value has been 

amplified by 10 times, with 999 representing 99.9.) 

Detection value = Actually measured value + Offset value 

Temp1 Offset INT Same as the temperature offset value for channel 0. 

Temp2 Offset INT Same as the temperature offset value for channel 1. 

Temp3 Offset INT Same as the temperature offset value for channel 2. 

Temp0 Up INT 
Temperature upper limit for channel 0. Reserved. The sensor 

provided limit value is used. 

Temp1 Up INT 
Temperature upper limit for channel 1. Reserved. The sensor 

provided limit value is used. 

Temp2 Up INT 
Temperature upper limit for channel 2. Reserved. The sensor 

provided limit value is used. 

Temp3 Up INT 
Temperature upper limit for channel 3. Reserved. The sensor 

provided limit value is used. 

Temp0 Low INT 
Temperature lower limit for channel 0. Reserved. The sensor 

provided limit value is used. 

Temp1 Low INT 
Temperature lower limit for channel 1. Reserved. The sensor 

provided limit value is used. 

Temp2 Low INT 
Temperature lower limit for channel 2. Reserved. The sensor 

provided limit value is used. 

Temp3 Low INT 
Temperature lower limit for channel 3. Reserved. The sensor 

provided limit value is used. 

Temp0 REAL Conversion value for channel 0. 

Temp1 REAL Conversion value for channel 1. 

Temp2 REAL Conversion value for channel 2. 

Temp3 REAL Conversion value for channel 3. 

Temp0_ErrId UINT Fault code for channel 0. 

Temp1_ErrId UINT Fault code for channel 1. 

Temp2_ErrId UINT Fault code for channel 2. 

Temp3_ErrId UINT Fault code for channel 3. 

HW Version UINT Module hardware version number 

FPGA Version UINT Module FPGA software version number 
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6.1.1.9 Counting and measurement module (FL6002) 

1. Programming instance 

Step 1 Add the FL6002-2ES device. 

 

 

Step 2 In the startup parameters, set the counter DI filter time (unit: 0.1μs), SSI communication frame 

length, the number of least significant bits and number of most significant bits in the SSI 

communication position value, SSI communication configuration, and counter configuration 

according to actual needs. 

 

 DIx Filt (x=0,1) is the filter parameter for the external DI channel, with a unit of 0.1μs and a default value 

of 5. If it is set to 10, it means that only signals that remain stable and do not jump within 1μs are 

sampled. 

 Cntx SSI Length (x=0,1) is the encoder SSI communication frame length, with a setting range of 10–40 

and a default value of 13. If a 23-bit multi-turn encoder is used, indicating that the position value has 23 

bits, this parameter should be set to 23. 

 Cntx SSI LSB (x=0,1) is the number of least significant bits in the SSI communication frame position 

value, with a default value of 0. If a 23-bit multi-turn encoder is used, indicating that the position value 

has 23 bits, this parameter should be set to 0. 
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 Cntx SSI MSB (x=0,1) is the number of most significant bits in the SSI communication frame position 

value, with a default value of 12. If a 23-bit multi-turn encoder is used, indicating that the position value 

has 23 bits, this parameter should be set to 22. 

Note: See the corresponding encoder's manual to set the SSI Length/SSI LSB/SSI MSB parameters based 

on the actual situation. 

 Cntx SSI Cfg (x=0,1) is a counter SSI communication configuration parameter of type USINT. The data 

definitions are detailed in the following parameter description table. 

Bit Name Parameter description 

Bit2–Bit0 SSI clock frequency 

2#000: 125kHz (Default) 

2#001: 250kHz 

2#010: 500kHz 

2#011: 1MHz 

2#100: 1.5MHz 

2#101: 2MHz 

2#110: Reserved 

2#111: Reserved 

Bit3 SSI data format 
2#0: Binary (Default) 

2#1: Gray code 

Bit7–bit4 
Position reading interval 

time in SSI communication 

Unit: 100μs. Default: 0 

For example, 2#0001 (decimal 1) indicates 100μs; 2#1001 

(decimal 9) indicates 900μs. 
 

 If the counter SSI clock frequency is set to 500kHz, SSI data format is Gray code, and the position 

reading interval time is 500μs, Cntx SSI Cfg(x=0,1) should be set to 90, that is, 2#01011010. For details, 

see the following table. 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2#0101 2#1 2#010 

Unit: 100μs Gray code 500kHz 

 

 Cntx Cfg (x=0,1) is a counter configuration parameter of type USINT. The data definitions are detailed in 

the following parameter description table. 

Bit Name Parameter description 

Bit1–bit0 
Frequency 

measurement period 

2#00:20ms (Default) 

2#01:100ms 

2#10:500ms 

2#11:1000ms 

Bit3–bit2 DI edge latch enabling 

2#00: Disable (Default) 

2#01: Rising edge 

2#10: Falling edge 

2#11: Dual edges 

Bit5–bit4 
Comparison consistent 

pulse output width 

2#00:1ms (Default) 

2#01:2ms 

2#10:4ms 

2#11:8ms 

Bit7–bit6 
Output mode for 

comparison 

2#00: Consistent output for comparison (Default) 

2#01: Output between [Count lower limit, Comparison value] 

2#10: Output between [Comparison value, Count upper limit] 

2#11: Reserved 

Bit15–bit8 Reserved - 
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If the counter is configured with a frequency measurement period of 100 ms, with DI rising edge latch 

enabled, a period of 8ms for consistent output for comparison, and DO output mode for comparison set to 

generate consistent output within the range [Comparison value, Counter upper limit], then Cntx Cfg (x=0,1) 

should be set to 53, that is, 2#0000000000110101. See the following table for details. 

Bit15–Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2#00000000 2#00 2#11 2#01 2#01 

Reserved 
Comparison 

consistent output 
8ms Rising edge 100ms 

Step 3 After configuring the preceding startup parameters and downloading the program, control the 

counter on the Module I/O mapping interface. 

 

 

 Cntx_Ctrl(x=0,1) is a counter control parameter. See the following table for detailed parameter 

description. 

Bit Name Parameter description 

Bit0 Enable counting 
2#0: Disable 

2#1: Enable 

Bit1 Reserved - 

Bit2 Reserved - 

Bit3 Reserved - 

Bit4 Counter comparison 
2#0: Disable 

2#1: Enable 

Bit7–bit5 Reserved - 

 

 Cntx_CmpVal(x=0,1) is a counter comparison value of type DINT. 

If Cnt0_CmpVal is set to 1000000 and you want to enable the counter for comparison, set Cnt0_Ctrl to 17,  

that is, 2#00010001. The details are as follows. 

Bit7–Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2#000 2#1 2#0 2#0 2#0 2#1 

Reserved Power on 
Effective at the 

rising edge 
Reserved Reserved Power on 

 

 Cntx_Val (x=0,1) is a counter comparison value of type DINT. 

According to the previously mentioned Cntx Cfg (x=0,1) configuration value of 53 (enabling DO consistent 

output for comparison, with the pulse output of 8ms), when the count value Cntx_Val (x=0,1) is 1,000,000, 

the DO will output pulse lasting 8ms. 
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Note: DI0/DI1 are the counter latch inputs, and the corresponding latch values are Cntx_LatchVal (x=0,1). 

2. Parameter description 

Parameter name Type Description 

2ES DI0 Filt UINT DI0 filter time. Unit: 0.1μs. 

2ES DI1 Filt UINT DI1 filter time. Unit: 0.1μs. 

2ES Cnt0 SSI Length USINT Cnt0 SSI communication frame length. 

2ES Cnt1 SSI Length USINT Cnt1 SSI communication frame length. 

2ES Cnt0 SSI LSB USINT Cnt0 SSI position value least significant bit count. 

2ES Cnt1 SSI LSB USINT Cnt1 SSI position value least significant bit count. 

2ES Cnt0 SSI MSB USINT Cnt0 SSI position value most significant bit count. 

2ES Cnt1 SSI MSB USINT Cnt1 SSI position value most significant bit count. 

2ES Cnt0 SSI Cfg USINT 

Cnt0 SSI configuration parameter. 

[2:0] SSI clock frequency 

2#000: 125kHz; 

2#001: 250kHz; 

2#010: 500kHz; 

2#011: 1MHz; 

2#100: 1.5MHz; 

2#101: 2MHz; 

2#110: Reserved; 

2#111: Reserved; 

[3] Data format. 0: Binary   1: Gray code 

[7:4] Position reading interval time (Unit: 100μs) 

2ES Cnt1 SSI Cfg USINT 

Cnt1 SSI configuration parameter. 

[2:0] SSI clock frequency 

2#000: 125kHz; 

2#001: 250kHz; 

2#010: 500kHz; 

2#011: 1MHz; 

2#100: 1.5MHz; 

2#101: 2MHz; 

2#110: Reserved; 

2#111: Reserved; 

[3] Data format. 0: Binary   1: Gray code 

[7:4] Position reading interval time (Unit: 100μs) 

2ES Cnt0 Cfg UINT 

Cnt0 count configuration parameter. 

[1:0] Frequency measurement period 

2#00:20ms; 

  2#01:100ms; 

  2#10:500ms; 

  2#11:1000ms; 

[3:2] L0 edge latch count value enabling 

2#00: Disable; 

2#01: Rising edge; 

2#10: Falling edge; 

2#11: Dual edges; 

[5:4] Comparison consistent output pulse width 

2#00:1ms; 

  2#01:2ms; 
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Parameter name Type Description 

  2#10:4ms; 

  2#11:8ms; 

[7:6] Output mode for comparison 

2#00: Comparison consistent output; 

  2#01: Output between [Count lower limit, Comparison 

value); 

  2#10: Output between (Comparison value, Count upper 

limit]; 

  2#11: Reserved (Comparison consistent output); 

[15:8] Reserved 

2ES Cnt1 Cfg UINT 

Cnt1 count configuration parameter. 

[1:0] Frequency measurement period 

2#00:20ms; 

  2#01:100ms; 

  2#10:500ms; 

  2#11:1000ms; 

[3:2] L0 edge latch count value enabling 

2#00: Disable; 

2#01: Rising edge; 

2#10: Falling edge; 

2#11: Dual edges; 

[5:4] Comparison consistent output pulse width 

2#00:1ms; 

  2#01:2ms; 

  2#10:4ms; 

  2#11:8ms; 

[7:6] Output mode for comparison 

2#00: Comparison consistent output; 

  2#01: Output between [Count lower limit, Comparison 

value); 

  2#10: Output between (Comparison value, Count upper 

limit]; 

  2#11: Reserved (Comparison consistent output); 

[15:8] Reserved 

Cnt0_Ctrl USNT 

Control parameter for counter 0. 

Bit0: Enable counting, valid at high levels; 

Bit1: Reserved; 

Bit2: Reserved; 

Bit3: Reserved; 

Bit4: Enable count comparison function, valid at high 

levels (Provided that the counting is enabled.) 

Bit7–Bit5: Reserved. 

Cnt1_Ctrl USNT 

Control parameter for counter 1. 

Bit0: Enable counting, valid at high levels; 

Bit1: Reserved; 

Bit2: Reserved; 

Bit3: Reserved; 

Bit4: Enable count comparison function, valid at high 

levels (Provided that the counting is enabled.) 
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Parameter name Type Description 

Bit7–Bit5: Reserved. 

Cnt0_CmpVal DINT Counter 0 comparison value 

Cnt1_CmpVal DINT Counter 1 comparison value 

Cnt0_Status USINT 

Counter 0 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Reserved 

Bit3: Reserved 

Bit4: DI latch completion flag 

Bit5: Reserved 

Bit6: Status when the data line is idle 

Bit7: Reserved 

Cnt0_Status USINT 

Counter 1 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Reserved 

Bit3: Reserved 

Bit4: DI latch completion flag 

Bit5: Reserved 

Bit6: Status when the data line is idle 

Bit7: Reserved 

Cnt0_Val DINT Count value of counter 0 

Cnt1_Val DINT Count value of counter 1 

Cnt0_LatchVal DINT Latched value of counter 0 

Cnt1_LatchVal DINT Latched value of counter 1 

Cnt0_Freq UDINT Counter 0 frequency 

Cnt1_Freq UDINT Counter 1 frequency 

Cnt0_Velocity REAL Counter 0 speed (Valid for single-turn encoder) 

Cnt1_Velocity REAL Counter 1 speed (Valid for single-turn encoder) 

Cnt0_ErrId UINT Counter 0 error code 

Cnt1_ErrId UINT Counter 1 error code 
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6.1.1.10 Counting and measurement module (FL6112) 

1. Programming instance 

Step 1 Add the FL6112_2EI device. 

 

Step 2 Choose Startup Parameters, set the counter, filtering mode, encoder resolution, and counter 

preset values based on the actual needs, with a filter unit of 0.1μs. 

 

Cntx Cfg(x=0,1) is the counter configuration parameter of type UINT. Taking the counter 0 configuration as 

an example, the data definition can be found in the parameter description. 

Bit Name Description 

Bit1–bit0 Channel mode 

00: A/B phase quadruple frequency; 01: A/B phase double 

frequency 

10：A/B phase rated frequency; 11: Pulse+direction 

Bit3–bit2 
Frequency 

measurement period 
00: 20ms; 01: 100ms; 10: 500ms; 11: 1000ms 

Bit5–bit4 Edge latch enabling 00: Disabled; 01: Rise edge; 10: Fall edge; 11: Two edges 

Bit7–bit6 Reserved Reserved 

Bit9–bit8 
Comparison consistent 

pulse output width 
00: 1ms; 01: 2ms; 10: 4ms; 11: 8ms 

Bit11–bit10 
DO comparison output 

mode 

00: Comparison consistent output 

01: Output between [lower limit of count, comparison value] 

10: Output between [comparison value, upper limit of count] 

11: Reserved 

Bit15–bit12 Reserved Reserved 
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Assuming that counter 0 is configured as A/B phase quadruple frequency, the frequency measurement 

period is 100ms, DI0 rising edge latch is enabled, and comparison mode is comparison consistent output 

8ms, Cnt0 Cfg should be configured as 788, i.e. 2#0000001100010100, as detailed below. 

Bit15–

bit12 
Bit11 Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

0000 00 11 00 01 01 00 

Reserved 
Comparison consistent 

output 
8ms Reserved 

Rising 

edge 
100ms 

A/B phase quadruple 

frequency 
 

Cntx Filt(x=0,1) is the filter parameter of A/B/Z/DI port with a unit of 0.1μs。 If it is set to 10, it means that only 

signals that remain stable and do not jump within 1μs are sampled. 

Cntx Ratio(x=0,1) is the encoder resolution (number of pulses fed back from one revolution, i.e. the pulse 

increment between two Z pulses). Assuming the resolution labeled on the encoder is 2500P/R, the Cnt0 

Ratio should be set to 10000 since the Cnt0 Cfg is configured as A/B phase quadruple. 

Cntx PresetVal(x=0,1) is the counter preset value of type DINT. 

Step 3 After configuring the above startup parameters and downloading the program, control the counter 

on the Module I/O mapping interface. 

 

Cntx_Ctrl(x=0,1) is the counter control parameter. Taking the counter 0 as an example, the data definition 

can be found in the parameter description. 

Bit Name Description 

Bit0 Enable counting 0: Disable  1: Enable 

Bit1 Clear count value Effective at the rising edge 

Bit2 
Write counter preset 

value 
Effective at the rising edge 

Bit3 
Clear count overflow 

flag 
Effective at the rising edge 

Bit4 Counter comparison 0: Disable  1: Enable 

Bit7–bit5 Reserved Reserved 

 

Cntx_CmpVal(x=0,1) is the counter comparison value of type DINT. 

Assuming that Cnt0_CmpVal is set to 1000000 and you want to enable the counter for comparison, set 

Cnt0_Ctrl to 17,  which is 2#00010001. The details are as follows. 
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Bit7–bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

000 1 0 0 0 1 

Reserved 1: Enable 
Effective at the rising 

edge 

Effective at the 

rising edge 

Effective at 

the rising 

edge 

1: Enable 

 

According to the configuration value 788 of Cnt0 Cfg mentioned above (enabling DO comparison consistent 

output and output pulse 8ms), when the count value Cnt0_Val is equal to 1000000, DO0 will output 8ms. 

To clear the current count value of counter 0, set Cnt0_Ctrl to 2, which is 2#00000010. The details are as 

follows. 

Bit7–bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

000 0 0 0 1 0 

Reserved 0: Disable 
Effective at the rising 

edge 

Effective at the 

rising edge 

Effective at 

the rising 

edge 

0: Disable 

At this point, the bit1 of Cnt0_Ctrl changes from 0 to 1. The FL6112_2EI module monitors the rising edge of 

this bit and clears the count value of counter 0, which means Cnt0_Val is cleared. 

 

2. Parameter description 

Parameter name Type Description 

2EI Cnt0 Cfg UINT 

Configuration parameter for counter 0: 

Bit1–Bit0: Channel mode configuration 

  0b00: A/B phase quadruple frequency; 

  0b01: A/B phase double frequency; 

  0b10: A/B phase rated frequency; 

  0b11: Pulse+direction (high level, positive); 

Bit3–Bit2: Frequency measurement period 

  0b00: 20ms; 

  0b01: 100ms; 

  0b10: 500ms; 

  0b11: 1000ms; 

Bit5–Bit4: Edge latch count value enabling 

  0b00: Disable; 

  0b01: Rising edge; 

  0b10: Falling edge; 

  0B11: Dual edges; 

Bit7–Bit6: Reserved 

Bit9–Bit8: Comparison consistent output pulse width 

  0b00: 1ms; 

  0b01: 2ms; 

  0b10: 4ms; 

  0b11: 8ms; 

Bit11–Bit10: DO comparison output mode 

  0b00: Comparison consistent output; 

  0b01: Output between [lower limit of count, comparison 

value]; 

  0b10: Output between [comparison value, upper limit of 

count]; 
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Parameter name Type Description 

  0b11: Reserved (Comparison consistent output) 

Bit15–Bit12: Reserved 

2EI Cnt0 Cfg UINT 
Configuration parameter for counter 1. The parameter 

configuration is consistent with counter 0. 

2EI Cnt0 Filt UINT 
Filtering parameter for counter 0 A/B/Z/DI port. 

Application scope 1–65535 (Unit: 0.1μs) 

2EI Cnt1 Filt UINT 
Filtering parameter for counter 1 A/B/Z/DI port. 

Application scope 1–65535 (Unit: 0.1μs) 

2EI Cnt0 Ratio UINT 

Encoder resolution for counter 0 (number of pulses fed 

back from one revolution, the pulse increment between 

two Z pulses). 

2EI Cnt1 Ratio UINT 

Encoder resolution for counter 1 (number of pulses fed 

back from one revolution, the pulse increment between 

two Z pulses). 

2EI Cnt0 PresetVal DINT Counter 0 preset value. 

2EI Cnt1 PresetVal DINT Counter 1 preset value. 

Cnt0_Ctrl USINT 

Control parameter for counter 0. 

Bit0: Enable counting, valid at high levels; 

Bit1: Clear counting, valid at the rising edge; 

Bit2: Write counter preset value, valid at the rising edge; 

Bit3: Clear count overflow flag, valid at the rising edge; 

Bit4: Enable count comparison function, valid at high 

levels (Provided that the counting is enabled.) 

Bit7–Bit5: Reserved. 

Cnt1_Ctrl USINT 
Control parameter for counter 1. The parameter 

configuration is consistent with counter 0. 

Cnt0_CmpVal DINT Counter 0 comparison value. 

Cnt1_CmpVal DINT Counter 1 comparison value. 

Cnt0_Status USINT 

Counter 0 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Overflow flag bit 

Bit3: Underflow flag bit 

Bit4: DI0 latch completion flag 

Bit7–Bit5: Reserved 

Cnt1_Status USINT 

Counter 1 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Overflow flag bit 

Bit3: Underflow flag bit 

Bit4: DI1 latch completion flag 

Bit7–Bit5: Reserved 

Cnt0_Val DINT Count value of counter 0 

Cnt1_Val DINT Count value of counter 1 

Cnt0_LatchVal DINT Latched value of counter 0 

Cnt1_LatchVal DINT Latched value of counter 1 

Cnt0_Freq UDINT Counter 0 frequency 

Cnt1_Freq UDINT Counter 1 frequency 
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Parameter name Type Description 

Cnt0_Velocity REAL Counter 0 speed 

Cnt1_Velocity REAL Counter 1 speed 

Cnt0_ErrId UINT Counter 0 error code 

Cnt1_ErrId UINT Counter 1 error code 
 

6.1.1.11 Counting and measurement module (FL6121) 

1. Programming instance 

Step 1 Add the FL6121-1EI device. 

 

 

Step 2 Choose Startup Parameters, set the counter, filtering mode, encoder resolution, and counter 

preset values based on the actual needs, with a filter unit of 10ns. 

 

 Cnt Cfg is a counter configuration parameter, with data type of UINT. Refer to the parameter 

description table for data definition. 

Bit Name Parameter description 

Bit1–bit0 
Channel mode 

configuration 

2#00: A/B phase quadruple frequency (Default) 

2#01: A/B phase double frequency 

2#10: A/B phase rated frequency 

2#11: Pulse + direction 

Bit3–bit2 
Frequency 

measurement period 

2#00:20ms (Default) 

2#01:100ms 

2#10:500ms 

2#11:1000ms 
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Bit Name Parameter description 

Bit5–bit4 
DI0 edge latch 

enabling 

2#00: Disable (Default) 

2#01: Rising edge 

2#10: Falling edge 

2#11: Dual edges 

Bit7–bit6 
DI1 edge latch 

enabling 

2#00: Disable (Default) 

2#01: Rising edge 

2#10: Falling edge 

2#11: Dual edges 

Bit9–bit8 

Comparison 

consistent pulse 

output width 

2#00:1ms (Default) 

2#01:2ms 

2#10:4ms 

2#11:8ms 

Bit11–bit10 
DO0 comparison 

output mode 

2#00: Consistent output for comparison (Default) 

2#01: Output between [Count lower limit, Comparison value] 

2#10: Output between [Comparison value, Count upper limit] 

2#11: Reserved 

Bit13–bit12 
DO1 comparison 

output mode 

2#00: Consistent output for comparison (Default) 

2#01: Output between [Count lower limit, Comparison value] 

2#10: Output between [Comparison value, Count upper limit] 

2#11: Reserved 

Bit15–bit14 Reserved - 

 

Assuming that counter is configured as A/B phase quadruple frequency, the frequency measurement period 

is 100ms, DI0 rising edge latch and DI1 falling edge latch are enabled, comparison consistent output of 8ms, 

DO0 comparison output mode is comparison consistent output , DO1 comparison output mode is output 

between [comparison value, upper limit of count], then Cnt Cfg should be configured as 9108, i.e. 

2#0010001110010100, as detailed below. 

Bit15–

Bit14 
Bit13 Bit12 

Bit1

1 
Bit10 Bit9 Bit8 Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2#00 2#10 2#00 2#11 2#10 2#01 2#01 2#00 

Reserved 

Output 

between 

[comparison 

value, upper 

limit of count] 

Comparison 

consistent 

output 

8ms fall edge Rising edge 100ms 

A/B phase 

quadruple 

frequency 

 

 Cnt Filt is the filtering parameter for A/B/Z ports, in units of 10ns, with a default value of 5. If it is set to 

100, it means that only signals that remain stable and do not jump within 1μs are sampled. 

 DI Filt is the filtering parameter for DI0/ DI1/ DI2 ports, in units of 10ns, with a default value of 5. If it is 

set to 100, it means that only signals that remain stable and do not jump within 1μs are sampled. 

 Cnt Ratio is the encoder resolution (number of pulses fed back from one turn, namely the pulse 

increment between two Z pulses), with a default value of 10000. Assuming the resolution labeled on the 

encoder is 2500P/R, the Cnt Ratio should be set to 10000 since the Cnt Cfg is configured as A/B phase 

quadruple. 

 Cnt PresetVal is the counter preset value, with a default value of 0 and a parameter type of DINT. 
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Step 3 After configuring the above startup parameters and downloading the program, control the counter 

on the Module I/O mapping interface. 

 

 

 Cnt_Ctrl is the counter control parameter. Refer to the parameter description table for data definition. 

Bit Name Parameter description 

Bit0 Enable counting 
2#0: Disable 

2#1: Enable 

Bit1 Clear counting Effective at the rising edge 

Bit2 Write counter preset value Effective at the rising edge 

Bit3 Clear counter overflow flag Effective at the rising edge 

Bit4 Counter comparison 
2#0: Disable 

2#1: Enable 

Bit7–bit5 Reserved - 

 

 Cnt_CmpxVal (x=0,1) is the counter comparison value of type DINT. 

Assuming that Cnt_Cmp0Val is set to 1000000, if you need to enable the counter for comparison, set Cnt_Ctrl 

to 17,  which is 2#00010001. The details are as follows. 

Bit7–Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2#000 2#1 2#0 2#0 2#0 2#1 

Reserved Power on 
Effective at the 

rising edge 

Effective at the 

rising edge 

Effective at the 

rising edge 
Power on 

 

 Cnt_Val is the counter counting value of type DINT. 

According to the configuration value 9108 of Cnt Cfg mentioned above (enabling DO0 comparison consistent 

output and output pulse 8ms), when the count value Cnt_Val is equal to 1000000, DO0 will output 8ms. 

If you want to clear the current count value of the counter, you need to set Cnt_Ctrl to 2, i.e. 2#00000010, as 

detailed below. 

Bit7–Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

2#000 2#0 2#0 2#0 2#1 2#0 

Reserved Disable 
Effective at the 

rising edge 

Effective at the 

rising edge 

Effective at the 

rising edge 
Disable 

At this point, bit1 of Cnt_Ctrl changes from 0 to 1. The FL6121_1EI module detects the rising edge of this bit, 

and the counter value is cleared to zero, that is, Cnt_Val is cleared to zero. 

Note: 

 DI0/DI1 serves as the counter latch input, with corresponding latch values of 

Cnt_Latch0Val/Cnt_Latch1Val. 
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 In Cnt_Ctrl, the function of bit1 is to clear the count value. When clearing the count value, the overflow 

flag of the counter will also be cleared. The function of bit3 in Cnt_Ctrl is to clear the overflow flag, and 

at the same time as clearing the overflow flag, the count value will not be cleared. 

 DI2 is the counter reset input and it is valid at the rising edge. After the FL6121_1EI module detects a 

rising edge on DI2, it will reset the count value Cnt_Val to the preset value Cnt PresetVal, clear the 

overflow flag of the counter, and reset the latch values Cnt_Latch0Val/Cnt_Latch1Val to 0. 

2. Parameter description 

Parameter name Type Description 

1EI Cnt Cfg UINT 

Configuration parameter for counter 0: 

Bit1–Bit0: Channel mode configuration 

  0b00: A/B phase quadruple frequency; 

  0b01: A/B phase double frequency; 

  0b10: A/B phase rated frequency; 

  0b11: Pulse+direction (high level, positive); 

Bit3–Bit2: Frequency measurement period 

  0b00: 20ms; 

  0b01: 100ms; 

  0b10: 500ms; 

  0b11: 1000ms; 

Bit5–Bit4: DI0 edge latch count value enabling 

  0b00: Disable; 

  0b01: Rising edge; 

  0b10: Falling edge; 

  0B11: Dual edges; 

Bit7–Bit6: DI1 edge latch count value enabling 

  0b00: Disable; 

  0b01: Rising edge; 

  0b10: Falling edge; 

  0B11: Dual edges; 

Bit9–Bit8: Comparison consistent output pulse width 

  0b00: 1ms; 

  0b01: 2ms; 

  0b10: 4ms; 

  0b11: 8ms; 

Bit11–Bit10: DO0 comparison output mode 

  0b00: Comparison consistent output; 

  0b01: Output between [lower limit of count, 

comparison value]; 

  0b10: Output between [comparison value, upper 

limit of count]; 

  0b11: Reserved (Comparison consistent output) 

Bit13–Bit12: DO1 comparison output mode 

  0b00: Comparison consistent output; 

  0b01: Output between [lower limit of count, 

comparison value]; 

  0b10: Output between [comparison value, upper 

limit of count]; 

  0b11: Reserved (Comparison consistent output) 

Bit15–Bit14: Reserved 
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Parameter name Type Description 

1EI Cnt Filt UINT 
Filtering parameter for counter A/B/Z port. Application 

scope 1–65535 (Unit: 10ns) 

1EI DI Filt UINT 
Filtering parameter for counter DI port. Application 

scope 1–65535 (Unit: 10ns) 

1EI Cnt Ratio UINT 

Encoder resolution (number of pulses fed back from 

one revolution, the pulse increment between two Z 

pulses). 

1EI Cnt PresetVal DINT Counter preset value 

Cnt_Ctrl UINT 

Control parameter for counter 0. 

Bit0: Enable counting, valid at high levels; 

Bit1: Clear counting, valid at the rising edge; 

Bit2: Write counter preset value, valid at the rising 

edge; 

Bit3: Clear count overflow flag, valid at the rising edge; 

Bit4: Enable count comparison function, valid at high 

levels (Provided that the counting is enabled.) 

Bit7–Bit5: Reserved. 

Cnt_Cmp0Val DINT Counter comparison value 0 

Cnt_Cmp1Val DINT Counter comparison value 1 

Cnt_Status UINT 

Counter 0 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Overflow flag bit 

Bit3: Underflow flag bit 

Bit4: DI0 latch completion flag 

Bit5: DI1 latch completion flag 

Bit7–Bit6: Reserved 

Cnt_Val DINT Count value of counter 

Cnt_Latch0Val DINT Latched value 0 of counter 

Cnt_Latch1Val DINT Latched value 1 of counter 

Cnt_Freq UDINT Counter frequency 

Cnt_Velocity REAL Counter speed 

Cnt_ErrId UINT Counter error code 
 

6.1.2 Sysmac Studio configuration description 

6.1.2.1 Installing the device descriptor file 

Double-click EtherCAT, right-click Master device on the pop-up interface, choose Display ESI library, click 

this folder on the pop-up ESI library interface to open the ESI library folder, put the device description file 

FK1100_ECT_Coupler_x.x.x.x.xml into the folder, and restart the Sysmac Studio software. 
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6.1.2.2 Setting the slave node address 

When the coupler module is used for the first time, you need to configure the slave node address. 

After the device is connected, click the online button, right-click the main device, choose Write to Slave 

Node Address, modify the setting on the pop-up Sub-device node address writing in progress interface 

(the setting ranges from 1 to 192 and cannot be repeated), and click Write. After successful writing, the 

FK1100_ECT_Coupler coupler module will take effect after power off and restart. 
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6.1.2.3 Performing network configuration 

 Manual configuration 

1. Add FK1100 ECT Couper Slave. 

In offline state, double-click EtherCAT > Master, find the EtherCAT coupler with the INVT label in the toolbar 

on the right, double-click FK1100_ECT_Coupler to add the coupler slave. 
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Note: The address of the sub-node here needs to be consistent with the one configured in 6.1.2.2 Setting 

the slave node address. 

 

2. Add the expansion module. 

Click FK1100_ECT_Coupler that has been added, then click Edit Module Configuration in the 

configuration box on the right. Based on the actual physical connection of the modules, add the modules 

from the toolbar to the slots. 
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Note: On this interface (node configuration interface), click Node: FK1100_ECT_Coupler, and change 

Module config send method to Send on the right configuration interface. If the network configuration is 

not modified, it will not be sent to the slave node, and thus the slave node cannot receive the network 

configuration, resulting in a configuration mismatch error. In addition, EtherCAT communication will also 

fail to enter the OP state. 
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Note: The physical configuration must be consistent with the network configuration. If the configuration 

is inconsistent, EtherCAT communication cannot enter the OP state. 

 Automatic scanning 

Click the online button, right-click Master, choose Compare and Merge with Actual Network 

Configuration, and click Apply actual network configuration on the pop-up Compare and Merge with 

Actual Network Configuration interface. 
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Note: 

 For offline state, on the node configuration interface, click Node: FK1100_ECT_Coupler, and change 

Module config send method to Send on the right configuration interface. If the network configuration 

is not modified, it will not be sent to the slave node, and thus the slave node cannot receive the 

network configuration, resulting in a configuration mismatch error. In addition, EtherCAT 

communication will also fail to enter the OP state. 

 After the automatic scanning, it is recommended to check whether the network configuration and 

physical configuration added by the scan match, and adjustments can be made manually. 

6.1.2.4 EtherCAT communication parameter configuration 

1. Synchronous mode: Double-click EtherCAT, click FK1100_ECT_Coupler on the pop-up interface, and 

set Enable Distributed Clock on the right side. 
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2. Synchronization period: / 

 

6.1.2.5 Module configuration parameter 

Testing revealed that some versions of Omron support visual configuration of initialization parameters, 

while others do not. The testing results on Omron's Sysmac Studio V1.52 are as follows; other versions may 

vary depending on specific conditions. 

Omron host 

controller 
Model PLC version 

Support visual 

configuration 

NJ501 

1300 

1400 

1500 

V1.40 and later Supported 

V1.21 Not supported 

V1.20 and earlier Not supported 

NX701 
1600 

1700 
V1.21 and earlier Not supported 

NX1P2 

9024DT 

1040DT 

1140DT 

V1.40 and later Supported 

V1.21 Not supported 

V1.20 and earlier Not supported 
 

 Visual modification of initialization parameters 

Double-click Node 1: FK1100_ECT_Coupler, click Edit Setting Parameters on the right side, and modify 

the coupler configuration parameter Module Enable on the pop-up Edit Setting Parameters interface. For 

the specific meanings of the parameters, refer to 6.1.2.7 Object dictionary description. 

 

The visual configuration of other digital, analog, and temperature sampling modules can be seen in the 

following figures. For details of the parameters, refer to the parameter remarks in the figures and 6.1.2.7 

Object dictionary description. 
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 Modify initialization parameters of the SDO function block 

Configuration parameters are all SDO parameters. Omron does not support a PLC version that visually 

configures initialization parameters. Configuring SDO parameters requires the use of the EC_CoESDOWrite 

function block. 

Execute

SDO_Write

NodeAdr

object

1000

data

WriteSize

NodeAdr

Execute

EC_CoESDOWrite

SdoObj

TimeOut

WriteDat

Done

Busy

ErrorID

AbortCode

Error

WriteSize

Input 

variable

Input 

variable

Input 

variable

err

 

Name Description 

Execute Rising edge active, and the rising edge enables the SDO Write function block. 

NodeAdr Node address 
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Name Description 

SdoObj 

Object dictionary SDO parameter 

SdoObj.Index: Index 

SdoObj.Subindex: Subindex 

SdoObj.IsCompleteAccess: Indicates whether to access all indexes 

TimeOut Timeout time 

WriteDat Data written 

WriteSize Written data size, unit: byte 
 

Each module configuration parameter index can be calculated by referring to 9.3 Expansion module object 

dictionary allocation and 6.1.2.7 Object dictionary description, each subindex can also be calculated by 

referring to 6.1.2.7 Object dictionary description, and the same configuration can be set up in the Invtmatic 

Studio to view the index and subindex of each configuration parameter in the software. 

 

Configuration example for FK1100_ECT_Coupler + FL1001-1600DI + FL2102-0016DN + FL3003-4AD + 

FL4003-4DA + FL3201-4TC is as follows: 

 

The delay before starting to write the SDO should be adjusted according to the actual situation; here, only a 

simple example is provided. 

CASE myStep OF 
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 0://Set the 1600DI module filter parameter Filt0 to 300 (3ms). 

  NodeAdr := 8; 

  object.Index := 16#8001; 

  object.Subindex := 16#01; 

  object.IsCompleteAccess := 0; 

  data := 300; 

  WriteSize  := 2; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 1; 

  END_IF; 

 1://Set the 1600DI module filter parameter Filt1 to 300 (3ms). 

  NodeAdr := 8; 

  object.Index := 16#8001; 

  object.Subindex := 16#02; 

  object.IsCompleteAccess := 0; 

  data := 300; 

  WriteSize  := 2; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 2; 

  END_IF; 

 2://Set the 4AD module channel 0 configuration parameter AI0 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#8115; 

  object.Subindex := 16#01; 

  object.IsCompleteAccess := 0; 

  data := 16#01; //0–5V channel enable 

  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 3; 

  END_IF; 

 3://Set the 4AD module channel 1 configuration parameter AI1 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#8115; 

  object.Subindex := 16#02; 

  object.IsCompleteAccess := 0; 

  data := 16#21; //0–10V channel enable 

  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 4; 

  END_IF; 

 4://Set the 4AD module channel 2 configuration parameter AI2 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#8115; 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  180 

  object.Subindex := 16#03; 

  object.IsCompleteAccess := 0; 

  data := 16#81; //4–20mA channel enable 

  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 5; 

  END_IF; 

 5://Set 4DA module channel 0 configuration parameter AO0 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#8199; 

  object.Subindex := 16#01; 

  object.IsCompleteAccess := 0; 

  data := 16#1; //0–5 channel enable 

  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 6; 

  END_IF; 

 6://Set 4DA module channel 1 configuration parameters AO1 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#8199; 

  object.Subindex := 16#02; 

  object.IsCompleteAccess := 0; 

  data := 16#21; //0–10 channel enable 

  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 7; 

  END_IF; 

 7://Set 4DA module channel 2 configuration parameter AO2 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#8199; 

  object.Subindex := 16#03; 

  object.IsCompleteAccess := 0; 

  data := 16#81; //4–20mA channel enable 

  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 8; 

  END_IF; 

 8://Set 4TC module channel 0 configuration parameter Temp0 Cfg. 

  NodeAdr := 8; 

  object.Index := 16#822D; 

  object.Subindex := 16#01; 

  object.IsCompleteAccess := 0; 

  data := 16#61; // K-type thermocouple channel enable 
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  WriteSize  := 1; 

  Execute := 1; 

  IF SDO_Write.Done AND NOT SDO_Write.Error THEN 

   Execute := 0; 

   myStep := 9; 

  END_IF; 

 9: 

  //do something  

  ; 

END_CASE; 

6.1.2.6 Module process data 

 

6.1.2.7 Object dictionary description 

 FK1100_ECT_Coupler 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 
0x3000:00 Module Enable UDINT 

Enabling/disabling control bits for 

the expansion modules behind the 

coupler, with each bit controlling 

the enabling/disabling of a module. 

 bit0 controls the 1st module. 

 bit1 controls the 2nd module. 

 … 

 bit31 controls the 32nd module. 

TRUE: Enable 

FALSE: Disable 

Control 

parameter 
- - - - 
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Name Index--Subindex Parameter Type Description 

RxPDO 

Feedback 

parameter 

TxPDO 

- - - - 

Status 

parameter SDO 

0x3080 Coupler Info - Coupler information. 

Subindex 0x01 ActNum UINT 
Number of connected expansion 

modules. 

Subindex 0x02 HW Version UINT Coupler hardware version number. 

Subindex 0x03 SW Version USINT Coupler software version number. 

Subindex 0x04 FPGA Version USINT 
Coupler FPGA software version 

number. 

0xF050 
Detected Module 

Ident List 
- Detection module ID list. 

Subindex 0x01 SubIndex 001 UDINT ID of 1st module detected. 

Subindex 0x02 SubIndex 002 UDINT ID of 2nd module detected. 

… … … … 

Subindex 0x20 SubIndex 032 UDINT ID of 32nd module detected. 
 

 FL1001-1600DI 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8001+0x80*n 1600DI SDO Cfg - 
1600DI module filter configuration 

parameter. 

Subindex 0x01 Filt0 UINT I0–I7 filter parameter. Unit: 10μs 

Subindex 0x02 Filt1 UINT I10–I17 filter parameter. Unit: 10μs 

Control 

parameter 

RxPDO 

- - - - 

Feedback 

parameter 

TxPDO 

0x6001+0x80*n 1600DI TxPDO - 
1600DI module status feedback 

parameter. 

Subindex 0x01 ErrId UINT Fault code. 

Subindex 0x02 I0 BIT I0 status feedback. 

Subindex 0x03 I1 BIT I1 status feedback. 

… … … … 

Subindex 0x11 I17 BIT I17 status feedback. 

Status 

parameter SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL1002-3200DI 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8002+0x80*n 3200DI SDO Cfg - 
3200DI module filter configuration 

parameter. 

Subindex 0x01 Filt0 UINT I0–I7 filter parameter. Unit: 10μs 

Subindex 0x02 Filt1 UINT I10–I17 filter parameter. Unit: 10μs 
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Name Index--Subindex Parameter Type Description 

Subindex 0x03 Filt2 UINT I20–I27 filter parameter. Unit: 10μs 

Subindex 0x04 Filt3 UINT I30–I37 filter parameter. Unit: 10μs 

Control 

parameter 

RxPDO 

- - - - 

Feedback 

parameter 

TxPDO 

0x6002+0x80*n 3200DI TxPDO - 
3200DI module status feedback 

parameter. 

Subindex 0x01 ErrId UINT Fault code. 

Subindex 0x02 I0 BIT I0 status feedback. 

Subindex 0x03 I1 BIT I1 status feedback. 

… … … … 

Subindex 0x21 I37 BIT I37 status feedback. 

Status 

parameter SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL2002(0016DP) & FL2102(0016DN) 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8005+ 0x80*n 0016D* SDO Cfg - 
0016DP/DN module stop/offline 

configuration parameter. 

Subindex 0x01 Stop Mode0 UINT 

Stop/offline output mode 

Q0 bit1: bit0 

Q1 bit3: bit2 

… … 

Q7 bit15: bit14 
 

 0b00: Stop/offline output 

retained 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x02 Stop Mode1 UINT 

Stop/offline output mode. 

Q10 bit1: bit0 

Q11 bit3: bit2 

… … 

Q17 bit15: bit14 
 

 0b00: Stop/offline output 

retained 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x03 Stop Output0 USINT 

Preset value of stop/offline output. 

 Bit0: Q0 stop/offline output 

preset 

 Bit1: Q1 stop/offline output 

preset 
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Name Index--Subindex Parameter Type Description 

 … 

 Bit7: Q7 stop/offline output 

preset 

Subindex 0x04 Stop Output1 USINT 

Preset value of stop/offline output. 

 Bit0: Q10 stop/offline output 

preset 

 Bit1: Q11 stop/offline output 

preset 

 … 

 Bit7: Q17 stop/offline output 

preset 

Control 

parameter 

RxPDO 

0x7005+0x80*n 0016D* RxPDO - 
0016DP/DN module output control 

value. 

Subindex 0x01 Q0 BIT Q0 output control. 

Subindex 0x02 Q1 BIT Q1 output control. 

… … … … 

Subindex 0x10 Q17 BIT Q17 Output control. 

Feedback 

parameter TxPDO 

0x6005+0x80*n 0016D* TxPDO - 
0016 DP/DN module status 

feedback parameter. 

Subindex 0x01 ErrId UINT Fault code. 

Status parameter 

SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL2003(0032DP) & FL2103(0032DN) 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8006+ 0x80*n 0032D* SDO Cfg - 
0032DP/DN module stop/offline 

configuration parameter. 

Subindex 0x01 Stop Mode0 UINT 

Stop/offline output mode. 

Q0 bit1: bit0 

Q1 bit3: bit2 

… … 

Q7 bit15: bit14 
 

 0b00: Stop/offline output 

retained 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x02 Stop Mode1 UINT 

Stop/offline output mode. 

Q10 bit1: bit0 

Q11 bit3: bit2 

… … 

Q17 bit15: bit14 
 

 0b00: Stop/offline output 

retained 
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Name Index--Subindex Parameter Type Description 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x03 Stop Mode2 UINT 

Stop/offline output mode. 

Q20 bit1: bit0 

Q21 bit3: bit2 

… … 

Q27 bit15: bit14 
 

 0b00: Stop/offline output 

retained 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x04 Stop Mode3 UINT 

Stop/offline output mode. 

Q30 bit1: bit0 

Q31 bit3: bit2 

… … 

Q37 bit15: bit14 
 

 0b00: Stop/offline output 

retained 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x05 Stop Output0 USINT 

Stop/offline output preset. 

 Bit0: Q0 stop/offline output 

preset 

 Bit1: Q1 stop/offline output 

preset 

 … 

 Bit7: Q7 stop/offline output 

preset 

Subindex 0x06 Stop Output1 USINT 

Preset value of stop/offline output. 

 Bit0: Q10 stop/offline output 

preset 

 Bit1: Q11 stop/offline output 

preset 

 … 

 Bit7: Q17 stop/offline output 

preset 

Subindex 0x07 Stop Output2 USINT 

Stop/offline output preset. 

 Bit0: Q20 stop/offline output 

preset 

 Bit1: Q21 stop/offline output 

preset 

 … 

 Bit7: Q27 stop/offline output 

preset 

Subindex 0x08 Stop Output3 USINT Stop/offline output preset. 
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Name Index--Subindex Parameter Type Description 

 Bit0: Q30 stop/offline output 

preset 

 Bit1: Q31 stop/offline output 

preset 

 … 

 Bit7: Q37 stop/offline output 

preset 

Control 

parameter RxPDO 

0x7006+0x80*n 0032D* RxPDO - 
0032DP/DN module output control 

value. 

Subindex 0x01 Q0 BIT Q0 output control. 

Subindex 0x02 Q1 BIT Q1 output control. 

… … … … 

Subindex 0x20 Q17 BIT Q37 output control. 

Feedback 

parameter TxPDO 

0x6006+0x80*n 0032D* TxPDO - 
0032DP/DN module status 

feedback parameter. 

Subindex 0x01 ErrId UINT Fault code. 

Status parameter 

SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL2201-0008DR 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8004+0x80*n 0008DR SDO Cfg - 
0008DR module stop/offline 

configuration parameter. 

Subindex 0x01 Stop Mode UINT 

Stop/offline output mode. 

Q0 bit1: bit0 

Q1 bit3: bit2 

… … 

Q7 bit15: bit14 
 

 0b00: Stop/offline output 

retained 

 0b01: Stop/offline output 

cleared 

 0b10: Stop/offline output preset 

Subindex 0x02 Stop Output USINT 

Preset value of stop/offline output. 

 Bit0: Q0 stop/offline output 

preset 

 Bit1: Q1 stop/offline output 

preset 

 … 

 Bit7: Q7 stop/offline output 

preset 

Control 

parameter 

RxPDO 

0x7004+0x80*n 0008DR RxPDO - 
0008DR module output control 

value. 

Subindex 0x01 Q0 BIT Q0 output control. 

Subindex 0x02 Q1 BIT Q1 output control. 
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Name Index--Subindex Parameter Type Description 

… … … … 

Subindex 0x08 Q7 BIT Q7 output control. 

Feedback 

parameter 

TxPDO 

0x6004+0x80*n 0008DR TxPDO - 
0008DR module status feedback 

parameter. 

Subindex 0x01 ErrId UINT Fault code. 

Status 

parameter SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL3003-4AD 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8015+0x80*n 4AD SDO Cfg - 
4AD module configuration 

parameter. 

Subindex 0x01 AI0 Cfg USINT 

Configuration parameter for 

channel 0. 

 bit0: Channel enabling control. 

(0: Disable. 1: Enable.) 

 bit1: Open-loop detection 

enabling control. (0: Disable. 1: 

Enable.) 

 bit2: Over-limit detection 

enabling control. (0: Disable. 1: 

Enable.) 

 bit3: Over-range enabling 

control. (0: Disable. 1: Enable.) 

 bit4: Enhanced filter enabling 

control. (0: Disable. 1: Enable.) 

 bit7–bit5: Channel conversion 

mode. 

 0b000: voltage 0–5V 

Corresponding code value: 0–

20000 

 0b001: voltage 0–10V 

Corresponding code value: 0–

20000 

 0b010: voltage -5–5V 

Corresponding code value: 

20000–20000 

 0b011: voltage -10–10V 

Corresponding code value: 

20000–20000 

 0b100: current 4–20mA 

Corresponding code value: 0–

20000 

 0b101: current 0–20mA 

Corresponding code value: 0–

20000 
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Name Index--Subindex Parameter Type Description 

 0b110: reserved 

 0b111: current -20–20mA 

Corresponding code value: 

20000–20000 

Subindex 0x02 AI1 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x03 AI2 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x04 AI3 Cfg USINT 
Same as the configuration 

parameters for channel 0. 

Subindex 0x05 AI0 Filt USINT 

Filter parameter for channel 0. 

Range: 1–255. A greater value 

indicates better filter effect but 

greater lagging. 

Subindex 0x06 AI1 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x07 AI2 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x08 AI3 Filt USINT 
Same as the filter parameter for 

channel 0. 

Control 

parameter 

RxPDO 

- - - - 

Feedback 

parameter 

TxPDO 

0x6015+0x80*n 4AD TxPDO - 
4AD module status feedback 

parameter. 

Subindex 0x01 AI0 INT Conversion value for channel 0. 

Subindex 0x02 AI1 INT Conversion value for channel 1. 

Subindex 0x03 AI2 INT Conversion value for channel 2. 

Subindex 0x04 AI3 INT Conversion value for channel 3. 

Subindex 0x05 AI0_ErrId UINT Fault code for channel 0. 

Subindex 0x06 AI1_ErrId UINT Fault code for channel 1. 

Subindex 0x07 AI2_ErrId UINT Fault code for channel 2. 

Subindex 0x08 AI3_ErrId UINT Fault code for channel 3. 

Status parameter 

SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL4003-4DA 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8019+0x80*n 4DA SDO Cfg - 
4DA module configuration 

parameter. 

Subindex 0x01 AO0 Cfg USINT 

Configuration parameter for 

channel 0. 

 bit0: Channel enabling control. 

(0: Disable. 1: Enable.) 

 bit1: Output fault detection 
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Name Index--Subindex Parameter Type Description 

enabling control. (0: Disable. 1: 

Enable.) 

 bit3–bit2: Offline output mode 

 0b00: Offline output retained 

 0b01: Offline output cleared 

 0b10: Offline output preset 

 bit4: Reserved 

 bit7–bit5: Channel conversion 

mode. 

 0b000: voltage 0–5V 

Corresponding code value: 0–

20000 

 0b001: voltage 0–10V 

Corresponding code value: 0–

20000 

 0b010: voltage -5–+5V 

Corresponding code value: 

20000–20000 

 0b011: voltage -10–+10V 

Corresponding code value: 

20000–20000 

 0b100: current 4–20mA 

Corresponding code value: 0–

20000 

 0b101: current 0–20mA 

Corresponding code value: 0–

20000 

 0b110: Reserved 

 0b111: Reserved 

Subindex 0x02 AO1 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x03 AO2 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x04 AO3 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x05 
AO0 Stop 

Output 
INT 

Preset value of stop/offline output 

for channel 0. 

Subindex 0x06 
AO1 Stop 

Output 
INT 

Preset value of stop/offline output 

for channel 1. 

Subindex 0x07 
AO2 Stop 

Output 
INT 

Preset value of stop/offline output 

for channel 2. 

Subindex 0x08 
AO3 Stop 

Output 
INT 

Preset value of stop/offline output 

for channel 3. 

Control 

parameter 

RxPDO 

0x7019+0x80*n 4DA RxPDO - 4DA module output control value. 

Subindex 0x01 AO0 INT Output control value for channel 0. 

Subindex 0x02 AO1 INT Output control value for channel 1. 

Subindex 0x03 AO2 INT Output control value for channel 2. 

Subindex 0x04 AO3 INT Output control value for channel 3. 

Feedback 0x6019+0x80*n 4DA TxPDO - 4DA module status feedback 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  190 

Name Index--Subindex Parameter Type Description 

parameter 

TxPDO 

parameter. 

Subindex 0x01 AO0_ErrId UINT Fault code for channel 0. 

Subindex 0x02 AO1_ErrId UINT Fault code for channel 1. 

Subindex 0x03 AO2_ErrId UINT Fault code for channel 2. 

Subindex 0x04 AO3_ErrId UINT Fault code for channel 3. 

Status 

parameter SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL3101-4PT 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x8029+0x80*n 4PT SDO Cfg - 
4PT module configuration 

parameter. 

Subindex 0x01 Temp0 Cfg USINT 

Configuration parameter for 

channel 0. 

 bit0: Channel enabling control. 

(0: Disable. 1: Enable.) 

 bit1: Over-range detection 

enabling control. (0: Disable. 1: 

Enable.) 

 bit3–bit2: Thermistor wire 

system 

 0b00: Two-wire system 

 0b01: Three-wire system 

 0b10: Four-wire system 

 bit4: Temperature unit  

 0: ℃ 

 1: ℉ 

 bit7–bit5: Channel conversion 

mode. 

 0b000: Reserved 

 0b001: PT100 

 0b010: PT500 

 0b011: Reserved 

 0b100: PT1000 

 0b101: Reserved 

 0b110: Reserved 

 0b111: CU100 

Subindex 0x02 Temp1 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x03 Temp2 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x04 Temp3 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x05 Temp0 Filt USINT 
Filter parameter for channel 0. 

Range: 1–255. A greater value 
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Name Index--Subindex Parameter Type Description 

indicates a more effective filtering 

effect, though this consequently 

leads to an increased delay. 

Subindex 0x06 Temp1 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x07 Temp2 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x08 Temp3 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x09 Temp0 Offset INT 

Temperature offset value for 

channel 0. 

Amplified by a factor of ten, 999 

represents 99.9. 

Detected value = Actually measured 

value + Offset value 

Subindex 0xA Temp1 Offset INT 
Same as the temperature offset 

value for channel 0. 

Subindex 0xB Temp2 Offset INT 
Same as the temperature offset 

value for channel 1. 

Subindex 0xC Temp3 Offset INT 
Same as the temperature offset 

value for channel 2. 

Subindex 0xD Temp0 Up INT 

Channel 0 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0xE Temp1 Up INT 

Channel 1 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0xF Temp2 Up INT 

Channel 2 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x10 Temp3 Up INT 

Channel 3 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x11 Temp0 Low INT 

Channel 0 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x12 Temp1 Low INT 

Channel 1 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x13 Temp2 Low INT 

Channel 2 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x14 Temp3 Low INT 

Channel 3 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Control 

parameter 

RxPDO 

- - - - 

Feedback 0x6029+0x80*n 4PT TxPDO - 4PT module status feedback 
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Name Index--Subindex Parameter Type Description 

parameter 

TxPDO 

parameter. 

Subindex 0x01 Temp0 REAL32 Conversion value for channel 0. 

Subindex 0x02 Temp1 REAL32 Conversion value for channel 1. 

Subindex 0x03 Temp2 REAL32 Conversion value for channel 2. 

Subindex 0x04 Temp3 REAL32 Conversion value for channel 3. 

Subindex 0x05 Temp0_ErrId UINT Fault code for channel 0. 

Subindex 0x06 Temp1_ErrId UINT Fault code for channel 1. 

Subindex 0x07 Temp2_ErrId UINT Fault code for channel 2. 

Subindex 0x08 Temp3_ErrId UINT Fault code for channel 3. 

Status 

parameter SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

 FL3203-4TC 

Name Index--Subindex Parameter Type Description 

Configuration 

parameter SDO 

0x802D+0x80*n 4TC SDO Cfg - 
4TC module configuration 

parameter. 

Subindex 0x01 Temp0 Cfg USINT 

Configuration parameter for 

channel 0. 

 bit0: Channel enabling control. 

(0: Disable. 1: Enable.) 

 bit1: Over-range detection 

enabling control. (0: Disable. 1: 

Enable.) 

 bit3–bit2: Reserved 

 bit4: Temperature unit 

 0: ℃ 

 1: ℉ 

 bit7–bit5: Channel conversion 

mode. 

 0b000: Thermocouple of type 

B. 

 0b001: Thermocouple of type 

E. 

 0b010: Thermocouple of type 

J. 

 0b011: Thermocouple of type 

K. 

 0b100: Thermocouple of type 

N. 

 0b101: Thermocouple of type 

R. 

 0b110: Thermocouple of type 

S. 

 0b111: Thermocouple of type 

T. 
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Name Index--Subindex Parameter Type Description 

Subindex 0x02 Temp1 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x03 Temp2 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x04 Temp3 Cfg USINT 
Same as the configuration 

parameter for channel 0. 

Subindex 0x05 Temp0 Filt USINT 

Filter parameter for channel 0. 

Range: 1–255. A greater value 

indicates better filter effect but 

greater lagging. 

Subindex 0x06 Temp1 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x07 Temp2 Filt USINT 
Same as the filter parameter for 

channel 0. 

Subindex 0x08 Temp3 Filt USINT 
Same as the filter parameter for 

channel 0 

Subindex 0x09 Temp0 Offset INT 

Temperature offset value for 

channel 0. 

Amplified by a factor of ten, 999 

represents 99.9. 

Detected value = Actually measured 

value + Offset value 

Subindex 0xA Temp1 Offset INT 
Same as the temperature offset 

value for channel 0. 

Subindex 0xB Temp2 Offset INT 
Same as the temperature offset 

value for channel 1. 

Subindex 0xC Temp3 Offset INT 
Same as the temperature offset 

value for channel 2. 

Subindex 0xD Temp0 Up INT 

Channel 0 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0xE Temp1 Up INT 

Channel 1 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0xF Temp2 Up INT 

Channel 2 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x10 Temp3 Up INT 

Channel 3 temperature upper limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x11 Temp0 Low INT 

Channel 0 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x12 Temp1 Low INT 

Channel 1 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Subindex 0x13 Temp2 Low INT 

Channel 2 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 
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Name Index--Subindex Parameter Type Description 

Subindex 0x14 Temp3 Low INT 

Channel 3 temperature lower limit, 

reserved. 

Use sensor inherent limitations. 

Control 

parameter 

RxPDO 

- - - - 

Feedback 

parameter 

TxPDO 

0x602D+0x80*n 4TC TxPDO - 
4TC module status feedback 

parameter. 

Subindex 0x01 Temp0 REAL32 Conversion value for channel 0. 

Subindex 0x02 Temp1 REAL32 Conversion value for channel 1. 

Subindex 0x03 Temp2 REAL32 Conversion value for channel 2. 

Subindex 0x04 Temp3 REAL32 Conversion value for channel 3. 

Subindex 0x05 Temp0_ErrId UINT Fault code for channel 0. 

Subindex 0x06 Temp1_ErrId UINT Fault code for channel 1. 

Subindex 0x07 Temp2_ErrId UINT Fault code for channel 2. 

Subindex 0x08 Temp3_ErrId UINT Fault code for channel 3. 

Status 

parameter SDO 

0x8078+0x80*n Module Info - Module information. 

Subindex 0x01 HW Version UINT Module hardware version number. 

Subindex 0x02 FPGA Version UINT 
Module FPGA software version 

number. 

Note: n represents the slot where the expansion module is located, n∈[0,31] 
 

6.1.3 TwinCAT3 configuration description 

6.1.3.1 Installing the device description file 

Copy the device description file named like FK1100_ECT_Coupler_x.x.x.x.xml to the directory 

C:\TwinCAT\3.1\Config\Io\EtherCAT, and restart the TwinCAT software. 
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6.1.3.2 Performing network configuration 

 Manual configuration 

Step 1 Add EtherCAT Master. 

Right-click Devices under I/O, choose Add New Item, choose EtherCAT Master on the pop-up Insert Device 

interface, and select the correct network port on the pop-up Device Found At interface. 
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Step 2 Add FK1100_ECT_Coupler Slave. 

Right click Device 1(EtherCAT) under Devices, choose Add New Item, find FK1100_ECT_Coupler on the 

pop-up Insert EtherCAT Device interface, and click OK to add an EtherCAT slave. 

 

 

Step 3 Add the expansion module. 

Double click FK1100_ECT_Coupler and click the Slots tab. Based on the physical configuration (actual 

physical connection sequence), correctly add the modules on the right to the slots on the left. 

Note: The physical configuration must be consistent with the network configuration. If the configuration 

is inconsistent, EtherCAT communication cannot enter the OP state. 
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 Automatic scanning 

Step 1 Establish a reliable physical connection for Computer > PLC > FK1100_ECT_Coupler, and switch the 

PLC to configuration mode. 
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Step 2 Right-click Devices under I/O, choose Scan, and click OK in the pop-up dialog box to wait for the 

scan results. Select the devices scanned as needed, click OK, and click Yes in the pop-up Scan for 

boxes dialog box to wait for the scan results. 

Note: It is recommended to check whether the network configuration and physical configuration added 

in automatic scan match, and adjustments can be made manually. 
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6.1.3.3 EtherCAT communication parameter configuration 

1. Synchronous mode: Double click FK1100_ECT_Coupler and click the DC tab, and set Operation Mode. 

 

 

2. Synchronization period:  

A. Double-click I/O > Devices > EtherCAT, click the Adapter tab, and set Freerun Cycle(ms) 

(recommended to adjust). 

B. Double-click FK1100_ECT_Coupler, click the DC tab, click Advanced Settings, in the SYNC 0 area, 

set Sync Unit Cycle (not recommended to adjust). 
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6.1.3.4 Module configuration parameter 

On the FK1100_ECT_Coupler > Startup interface, the Startup parameters are all SDO data, which are the 

initialization configuration parameters of each module. They are sent to the slave node during the transition 

from Pre-OP to Safe-OP in EtherCAT communication. Refer to 6.1.2.7 Object dictionary description for 

parameter details. 
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6.1.3.5 Module process data 

  

6.2 PROFINET configuration description 

6.2.1 TIA Portal configuration description 

6.2.1.1 PROFINET communication coupler—FK1200 

1. Install the device description file named in the format of GSDML-V2.43-INVT-FK1200-xxxxxxxx.xml. 

Step 1 Choose Options > Manage general station description files (GSD) from the menu bar. 

 

Step 2 In the Manage general station description files window that appears, set Source path to the GSD 
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file saving path, select the GSD file to be installed, and then click Install. 

 
 

2. Set the PN device name and IP address. 

Step 1 Complete the actual physical connection. Under Project tree, choose Devices > Online access > 

Realtek PCle GbE Family Controller > Update accessible devices. 
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Step 2 Choose the refreshed PN coupler device (you can confirm the device according to the MAC address). 

Choose Online & diagnostics under fk1200, choose Functions > Assign IP address, set IP address 

and Subnet mask, and click Assign IP address. After the IP address assignment, choose Assign 

PROFINET device name, set PROFINET device name, and click Assign name. 
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3. Network configuration 

Step 1 Choose PLC_1 > Device configuration on the left, click Network view on the main interface, click 

Hardware catalog on the right, choose Other field devices > PROFINET IO > I/O > INVT > FK1200 > 

FK1200. 

 
 

Step 2 Choose PLC_1 > Device configuration on the left, click Device view on the main interface, choose 

the FK1200 devices, and add modules to the slots according to actual physical configuration on the 

right. 

 
 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  205 

Step 3 On the Device view interface, double click FK1200. Under the lower part of interface, choose 

Properties > General > PROFINET interface [X1] > Ethernet addresses, deselect Generate 

PROFINET device automatically, and set PROFINET device name to the current device name. 

 

Note: In PROFINET communication, devices are identified through device names. Therefore, the set device 

names must match the actual device names of modules, and each device name must be unique. 
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Step 4 Set module parameters. 

Example 1: On the Device view interface, double click FL3003-4AD under Module, choose Properties > 

General > Module parameters, and then set module initialization parameters. 

 

Example 2: On the Device view interface, double click FL1001-1600DI under Module, choose Properties > 

General > Module parameters, and then set module initialization parameters. 
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Step 5 After completing the network configuration, set all configuration module parameters. Once 

compiled, the program can be downloaded and run. 
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6.2.1.2 Digital input module—FL1001 (1600D) 

Step 1 On the Device view interface, add FL1001-1600DI, double click FL1001-1600DI under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 

Note: For filtering parameter setting, the digital input module divides every 8 points into a group, and 

different filtering parameters can be set for each group. Adjust the port filtering mode in the startup 

parameters according to actual needs, with a unit of 10μs and a default value of 10ms. 

 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.3 Digital input module—FL1002 (3200D) 

Step 1 On the Device view interface, add FL1002-3200DI, double click FL1002-3200DI under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 

Note: For filtering parameter setting, the digital input module divides every 8 points into a group, and 

different filtering parameters can be set for each group. Adjust the port filtering mode in the startup 

parameters according to actual needs, with a unit of 10μs and a default value of 10ms. 

 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.4 Digital output module (source type)—FL2002 (0016DP) 

Step 1 On the Device view interface, add FL2002-0016DP, double click FL2002-0016DP under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Control output through Q addresses. 
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6.2.1.5 Digital output module (source type)—FL2003 (0032DP) 

Step 1 On the Device view interface, add FL2003-0032DP, double click FL2003-0032DP under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Control output through Q addresses. 

 
. 
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6.2.1.6 Digital output module (sink type)—FL2102 (0016DN) 

Step 1 On the Device view interface, add FL2102-0016DN, double click FL2102-0016DN under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Control output through Q addresses. 
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6.2.1.7 Digital output module (sink type)—FL2103 (0032DN) 

Step 1 On the Device view interface, add FL2103-0032DN, double click FL2103-0032DN under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Control output through Q addresses. 
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6.2.1.8 Digital output module (relay)—FL2201 (0008DR) 

Step 1 On the Device view interface, add FL2201-0008DR, double click FL2201-0008DR under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Control output through Q addresses. 
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6.2.1.9 Digital hybrid module—FL5005 (1616DP) 

Step 1 On the Device view interface, add FL5005-1616DP, double click FL5005-1616DP under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses and control output through Q addresses. 
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6.2.1.10 Digital hybrid module—FL5105 (1616DN) 

Step 1 On the Device view interface, add FL5105-1616DN, double click FL5105-1616DN under Module, 

choose Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses and control output through Q addresses. 
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6.2.1.11 Analog input module—FL3003 (4AD) 

Step 1 On the Device view interface, add FL3003-4AD, double click FL3003-4AD under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.12 Analog input module—FL3404(8ADV) 

Step 1 In the Device view interface, add FL3404-8ADV, double click FL3404-8ADV under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.13 Analog input module—FL3504(8ADI) 

Step 1 In the Device view interface, add FL3504-8ADI, double click FL3504-8ADI under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.14 Analog output module—FL4003 (4DA) 

Step 1 On the Device view interface, add FL4003-4DA, double click FL4003-4DA under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Control output through Q addresses. 
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6.2.1.15 Temperature detection module (thermistor)—FL3103 (4PT) 

Step 1 On the Device view interface, add FL3103-4PT, double click FL3103-4PT under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.16 Temperature detection module (thermistor)—FL3203 (4TC) 

Step 1 On the Device view interface, add FL3203-4TC, double click FL3203-4TC under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses. 
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6.2.1.17 Counting and measurement module—FL6002-2ES 

Step 1 In the Device view interface, add FL6002-2ES, double click FL6002-2ES under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses and control the module through Q addresses. 

 

The meaning of I and Q addresses is as follows: 

Address Parameter name Type Description 

%QB64 Cnt0_Ctrl USNT 

Control parameter for counter 0. 

Bit0: Enable counting, valid at high levels; 

Bit1: Reserved; 

Bit2: Reserved; 

Bit3: Reserved; 

Bit4: Enable count comparison function, valid at 

high levels (Provided that the counting is 

enabled.) 

Bit7–Bit5: Reserved. 

%QB65 Cnt1_Ctrl USNT 

Control parameter for counter 1. 

Bit0: Enable counting, valid at high levels; 

Bit1: Reserved; 
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Address Parameter name Type Description 

Bit2: Reserved; 

Bit3: Reserved; 

Bit4: Enable count comparison function, valid at 

high levels (Provided that the counting is 

enabled.) 

Bit7–Bit5: Reserved. 

%QD66 Cnt0_CmpVal DINT Counter 0 comparison value 

%QD70 Cnt1_CmpVal DINT Counter 1 comparison value 

%IB68 Cnt0_Status USINT 

Counter 0 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Reserved 

Bit3: Reserved 

Bit4: DI latch completion flag 

Bit5: Reserved 

Bit6: Status when the data line is idle 

Bit7: Reserved 

%IB69 Cnt0_Status USINT 

Counter 1 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Reserved 

Bit3: Reserved 

Bit4: DI latch completion flag 

Bit5: Reserved 

Bit6: Status when the data line is idle 

Bit7: Reserved 

%ID70 Cnt0_Val DINT Count value of counter 0 

%ID74 Cnt1_Val DINT Count value of counter 1 

%ID78 Cnt0_LatchVal DINT Latched value of counter 0 

%ID82 Cnt1_LatchVal DINT Latched value of counter 1 

%ID86 Cnt0_Freq UDINT Counter 0 frequency 

%ID90 Cnt1_Freq UDINT Counter 1 frequency 

%ID94 Cnt0_Velocity REAL Counter 0 speed (Valid for single-turn encoder) 

%ID98 Cnt1_Velocity REAL Counter 1 speed (Valid for single-turn encoder) 
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6.2.1.18 Counting and measurement module—FL6112-2EI 

Step 1 In the Device view interface, add FL6112-2EI, double click FL6112-2EI under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses and control the module through Q addresses. 

 

The meaning of I and Q addresses is as follows: 

Address Parameter name Type Description 

%QB74 Cnt0_Ctrl USINT 

Control parameter for counter 0. 

Bit0: Enable counting, valid at high levels; 

Bit1: Clear counting, valid at the rising edge; 

Bit2: Write counter preset value, valid at the 

rising edge; 

Bit3: Clear count overflow flag, valid at the 

rising edge; 

Bit4: Enable count comparison function, 

valid at high levels (Provided that the 

counting is enabled.) 

Bit7–Bit5: Reserved. 

%QB75 Cnt1_Ctrl USINT Control parameter for counter 1. The 
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Address Parameter name Type Description 

parameter configuration is consistent with 

counter 0. 

%QD76 Cnt0_CmpVal DINT Counter 0 comparison value. 

%QD80 Cnt1_CmpVal DINT Counter 1 comparison value. 

%IB102 Cnt0_Status USINT 

Counter 0 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Overflow flag bit 

Bit3: Underflow flag bit 

Bit4: DI0 latch completion flag 

Bit7–Bit5: Reserved 

%IB103 Cnt1_Status USINT 

Counter 1 count state feedback 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Overflow flag bit 

Bit3: Underflow flag bit 

Bit4: DI1 latch completion flag 

Bit7–Bit5: Reserved 

%ID104 Cnt0_Val DINT Count value of counter 0 

%ID108 Cnt1_Val DINT Count value of counter 1 

%ID112 Cnt0_LatchVal DINT Latched value of counter 0 

%ID116 Cnt1_LatchVal DINT Latched value of counter 1 

%ID120 Cnt0_Freq UDINT Counter 0 frequency 

%ID124 Cnt1_Freq UDINT Counter 1 frequency 

%ID128 Cnt0_Velocity REAL Counter 0 speed 

%ID132 Cnt1_Velocity REAL Counter 1 speed 
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6.2.1.19 Counting and measurement module—FL6121-1EI 

Step 1 In the Device view interface, add FL6121-1EI, double click FL6121-1EI under Module, choose 

Properties > General > Module parameters, and then set module initialization parameters. 

 
 

Step 2 Obtain sampling values through I addresses and control the module through Q addresses. 

 

The meaning of I and Q addresses is as follows: 

Address Parameter name Type Description 

%QW84 Cnt_Ctrl UINT 

Counter control parameter. 

Bit0: Enable counting, valid at high levels 

Bit1: Clear counting, valid at the rising edge 

Bit2: Write counter preset value, valid at the 

rising edge 

Bit3: Clear count overflow flag, valid at the 

rising edge 

Bit4: Enable count comparison function, valid at 

high levels (Provided that the counting is 

enabled.) 

Bit15–Bit5: Reserved 

%QD86 Cnt_Cmp0Val DINT Counter comparison value 0. 
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Address Parameter name Type Description 

%QD90 Cnt_Cmp1Val DINT Counter comparison value 1. 

%IW136 Cnt_Status UINT 

Counter count state feedback. 

Bit0: Forward run flag bit 

Bit1: Reverse run flag bit 

Bit2: Overflow flag bit 

Bit3: Underflow flag bit 

Bit4: DI0 latch completion flag 

Bit5: DI1 latch completion flag 

Bit15–Bit6: Reserved 

%ID138 Cnt_Val DINT Count value of counter 

%ID142 Cnt_Latch0Val DINT Latched value 0 of counter 

%ID146 Cnt_Latch1Val DINT Latched value 1 of counter 

%ID150 Cnt_Freq UDINT Counter frequency 

%ID154 Cnt_Velocity REAL Counter speed 
 

6.3 EtherNet/IP configuration description 

6.3.1 EDS use description 

The FK1300 EIP coupler EDS files come in two forms: one is a generic EDS file, and the other is a specialized 

EDS file generated by the Ttools-IO host controller software based on the configuration. 

6.3.1.1 Module parameter 

 FK1300 coupling 

Parameter Type Description Data type 

hwVersion UINT Coupler hardware version 
Input Data(TO) 

swVersion UINT Coupler software version 

 Digital input module 

Parameter Type Description Data type 

1600DI-Filt0/3200DI-Filt0 UINT 
I0–I7 filter parameter. Unit: 

10μs 

Config Param 

1600DI-Filt0/3200DI-Filt1 UINT 
I10–I17 filter parameter. Unit: 

10μs 

3200DI-Filt2 UINT 
I20–I27 filter parameter. Unit: 

10μs 

3200DI-Filt3 UINT 
I30–I37 filter parameter. Unit: 

10μs 

1600DI-ErrId/3200DI-ErrId UINT Fault code Diagnosis Data 

1600DI-IN0/3200DI-IN0 USINT I0–I7 status feedback 

Input (TO) 
1600DI-IN0/3200DI-IN1 USINT I10–I17 status feedback 

3200DI-IN2 USINT I20–I27 status feedback 

3200DI-IN3 USINT I30–I37 status feedback 
 

 Digital output module 

Parameter Type Description Data type 

(0016DP/N)-Stop_Mode0 

(0032DP/N)-Stop_Mode0 
UINT 

Stop/offline output mode: 

Q7 … Q1 Q0 

Config 

Param 
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Parameter Type Description Data type 

bit15 bit14 … … bit3 bit2 bit1 bit0 

0b00: Stop/offline output retained  

0b01: Stop/offline output cleared 

0b10: Stop/offline output preset 

(0016DP/N)-Stop_Mode1 

(0032DP/N)-Stop_Mode1 
UINT 

Stop/offline output mode 

Q17 … Q11 Q10 

bit15 bit14 … … bit3 bit2 bit1 bit0 

0b00: Stop/offline output retained 

0b01: Stop/offline output cleared 

0b10: Stop/offline output according to the preset 

(0032DP/N)-Stop_Mode2 UINT 

Stop/offline output mode 

Q27 … Q21 Q20 

bit15 bit14 … … bit3 bit2 bit1 bit0 

0b00: Stop/offline output retained 

0b01: Stop/offline output cleared 

0b10: Stop/offline output according to the preset 

(0032DP/N)-Stop_Mode3 UINT 

Stop/offline output mode 

Q37 … Q31 Q30 

bit15 bit14 … … bit3 bit2 bit1 bit0 

0b00: Stop/offline output retained 

0b01: Stop/offline output cleared 

0b10: Stop/offline output preset 

(0016DP/N)-Stop Output0 

(0032DP/N)-Stop Output0 
USINT 

Stop/offline output preset 

Q7 … Q1 Q0 

bit7 … bit1 bit0 
 

(0016DP/N)-Stop Output1 

(0032DP/N)-Stop Output1 
USINT 

Stop/offline output preset 

Q17 … Q11 Q10 

bit7 … bit1 bit0 
 

(0032DP/N)-Stop Output2 USINT 

Stop/offline output preset 

Q27 … Q21 Q20 

bit7 … bit1 bit0 
 

(0032DP/N)-Stop Output3 USINT 

Stop/offline output preset 

Q37 … Q31 Q30 

bit7 … bit1 bit0 
 

(0016DP/N)-OUT0 

(0032DP/N)-OUT0 
USINT Q0–Q7 output control 

Output 

 (O T) 

(0016DP/N)-OUT1 

(0032DP/N)-OUT1 
USINT Q10–Q17 output control 

(0032DP/N)-OUT2 USINT Q20–Q27 output control 

(0032DP/N)-OUT3 USINT Q30–Q37 output control 

Satisfy Parameter USINT 
Empty parameter, used for alignment and padding 

for modules with fewer than 16 points 

(0016DP/N)-ErrID/ 

(0032DP/N)-ErrID 
UINT Fault code 

Diagnosis 

Data 

(Input(T  

O)) 
 

The digital output module divides every eight channels into a group. Taking configuration 
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0016DP-Stop_Mode0 as an example, the corresponding output channels are Q0–Q7. The data type of 

0016DP-Stop_Mode0 is UINT. The data definition is detailed in the following parameter description table. 

Q7 Q6 Q5 Q4 Q3 Q2 Q1 Q0 

bit15 bit14 bit13 bit12 bit11 bit10 bit9 bit8 bit7 bit6 bit5 bit4 bit3 bit2 bit1 bit0 
 

The output modes represented by bit1 and bit0 values are as follows: 

Value Mode 

0b00 Stop/offline output retained 

0b01 Stop/offline output cleared 

0b10 Stop/offline output preset 
 

If Q0–Q7 are all configured as output retained, then the value of 0016DP-Stop_Mode0 is 0, that is, 

2#0000000000000000. 

Q7 Q6 Q5 Q4 Q3 Q2 Q1 Q0 

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0 
 

 Analog input module-FL3003 (4AD) 

Parameter 

name 
Type Description 

Data type 

4AD-AI0_Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: Enable.) 

Bit1: Open-loop detection enabling control. (0: Disable. 

1: Enable.) 

Bit2: Over-range detection enabling control. (0: 

Disable. 1: Enable.) 

Bit3: Over-range enabling control. (0: Disable. 1: 

Enable.) 

Bit4: Enhanced filter enabling control. (0: Disable. 1: 

Enable.) 

Bit7–bit5: Channel conversion mode. 

0b000: Voltage range 0–5V, corresponding to 

detection value range 0–20000 

0b001: Voltage range 0–10V, corresponding to 

detection value range 0–20000 

0b010: Voltage range -5–5V, corresponding to 

detection value range -20000–20000 

0b011: Voltage range -10–10V, corresponding to 

detection value range -20000–20000 

0b100: Current range 4–20mA, corresponding to 

detection value range 0–20000 

0b101: Current range 0–20mA, corresponding to 

detection value range 0–20000 

0b110: Reserved 

0b111: Current range -20–20mA, corresponding to 

detection value range -20000–20000 

Config Param 

4AD-AI1_Cfg USINT 
Configuration parameter for channel 1. The parameter 

setting is consistent with that for channel 0. 

4AD-AI2_Cfg USINT 
Configuration parameter for channel 2. The parameter 

setting is consistent with that for channel 0. 
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Parameter 

name 
Type Description 

Data type 

4AD-AI3_Cfg USINT 
Configuration parameter for channel 3. The parameter 

setting is consistent with that for channel 0. 

4AD-AI0_Filt USINT 

Filter parameter for channel 0. 

Range: 1–255. A greater value indicates better filter 

effect but greater lagging. 

4AD-AI1_Filt USINT 
Filter parameter for channel 1. The filter parameter 

setting is consistent with that for channel 0. 

4AD-AI2_Filt USINT 
Filter parameter for channel 2. The filter parameter 

setting is consistent with that for channel 0. 

4AD-AI3_Filt USINT 
Filter parameter for channel 3. The filter parameter 

setting is consistent with that for channel 0. 

4AD-AI0 DINT Conversion value for channel 0. 

Input(TO) 
4AD-AI1 DINT Conversion value for channel 1. 

4AD-AI2 DINT Conversion value for channel 2. 

4AD-AI3 DINT Conversion value for channel 3. 

4AD-AI0_ErrId UINT Fault code for channel 0. 

Diagnosis Data 

(Input(T  O)) 

4AD-AI1_ErrId UINT Fault code for channel 1. 

4AD-AI2_ErrId UINT Fault code for channel 2. 

4AD-AI3_ErrId UINT Fault code for channel 3. 
 

Taking channel 0 as an example, the parameter type is USINT. See the following table for detailed definition 

of 4AD-AI0_Cfg. 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

Channel conversion mode 

(range configuration) 

Enhanced 

filter enabling 

control 

Over-range 

enabling 

control 

Over-range 

detection 

enabling 

control 

Open-loop 

detection 

enabling 

control 

Channel 

enabling 

control 

0b000: 0–5V 

0b001: 0–10V 

0b010: -5V–

+5V 

0b011: -10V–

+10V 

0b100: 4–20mA 

0b101: 0–20mA 

0b110: Reserved 

0b111: -20–

+20mA 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

0: Disable 

1: Enable 

 

Channel 0 is set to channel enabled, open-circuit detection disabled, over-range detection enabled, 

over-range enabled, enhanced filtering disabled, and the range is set to 4-20mA. The value should be 141, 

that is, 2#10001101. Details are as follows: 

Bit7 Bit6 Bit5 Bit4 Bit3 Bit2 Bit1 Bit0 

0b100 0 1 1 0 1 

0b100:4–20mA 0: Disable 1: Enable 1: Enable 0: Disable 1: Enable 
 

Range conversion: 

Measurement 

range 

Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range 

Conversion 

formula 

0–5V 
8.19175V 32767 0x7FFF 

Beyond upper 

limit 
D = 20000×U/5 

U = D×5/20000 
5V 20000 0x4E20 Rated range 
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Measurement 

range 

Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range 

Conversion 

formula 

2.5V 10000 0x2710 

0V 0 0x0000 

-2.5V -10000 0xD8F0 
Beyond lower 

limit 
-5V -20000 0xB1E0 

-8.19175V -32768 0x8000 

0–10V 

16.3835V 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×U/10 

U = D×10/20000 

10V 20000 0x4E20 

Rated range 5V 10000 0x2710 

0V 0 0x0000 

-5V -10000 0xD8F0 
Beyond lower 

limit 
-10V -20000 0xB1E0 

-16.3835V -32768 0x8000 

±5V 

8.19175V 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×U/5 

U = D×5/20000 

5V 20000 0x4E20 

Rated range 

2.5V 10000 0x2710 

0V 0 0x0000 

-2.5V -10000 0xD8F0 

-5V -20000 0xB1E0 

-8.19175V -32768 0x8000 
Beyond lower 

limit 

±10V 

16.3835V 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×U/10 

U = D×10/20000 

10V 20000 0x4E20 

Rated range 

5V 10000 0x2710 

0V 0 0x0000 

-5V -10000 0xD8F0 

-10V -20000 0xB1E0 

-16.3835V -32768 0x8000 
Beyond lower 

limit 

4–20mA 

30.2136mA 32767 0x7FFF 
Beyond upper 

limit 

D = 

20000×(I-4)/16 

I = D×16/20000+4 

20mA 20000 0x4E20 

Rated range 12mA 10000 0x2710 

4mA 0 0x0000 

0mA -5000 0xEC78 Beyond lower 

limit -22.2136mA -32768 0x8000 

0–20mA 

32.767mA 32767 0x7FFF 
Beyond upper 

limit 

D = 20000×I/20 

I = D×20/20000 

20mA 20000 0x4E20 

Rated range 10mA 10000 0x2710 

0mA 0 0x0000 

-10mA -10000 0xD8F0 
Beyond lower 

limit 
-20mA -20000 0xB1E0 

-32.767mA -32768 0x8000 

±20mA 32.767mA 32767 0x7FFF Beyond upper D = 20000×I/20 
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Measurement 

range 

Current (I)/ 

Voltage (U) 
Decimal (D) Hexadecimal Range 

Conversion 

formula 

limit I = D×20/20000 

20mA 20000 0x4E20 

Rated range 

10mA 10000 0x2710 

0mA 0 0x0000 

﹣10mA -10000 0xD8F0 

﹣20mA -20000 0xB1E0 

﹣32.767mA -32768 0x8000 
Beyond lower 

limit 
 

 Analog output module-FL4003 (4DA) 

Parameter name Type Description Data type 

4DA-AO0_Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: 

Enable.) 

Bit1: Output fault detection enabling control. (0: 

Disable. 1: Enable.) 

Bit3–bit2: Offline output mode. 

0b00: Offline output retained 

0b01: Offline output cleared 

0b10: Offline output preset 

Bit4: Reserved 

Bit7–bit5: Channel conversion mode. 

0b000: Voltage range 0–5V, corresponding to 

detection value range 0–20000 

0b001: Voltage range 0–10V, corresponding to 

detection value range 0–20000 

0b010: Voltage range -5–+5V, corresponding to 

detection value range -20000–20000 

0b011: Voltage range -10–+10V, corresponding to 

detection value range -20000–20000 

0b100: Current range 4–20mA, corresponding to 

detection value range 0–20000 

0b101: Current range 0–20mA, corresponding to 

detection value range 0–20000 

0b110: Reserved 

0b111: Reserved 

Config Param 

4DA-AO1_Cfg USINT 

Configuration parameter for channel 1. The 

parameter setting is consistent with that for 

channel 0. 

4DA-AO2_Cfg USINT 

Configuration parameter for channel 2. The 

parameter setting is consistent with that for 

channel 0. 

4DA-AO3_Cfg USINT 

Configuration parameter for channel 3. The 

parameter setting is consistent with that for 

channel 0. 

4DA-AO0_Stop_Output INT Preset value of stop/offline output for channel 0. 

4DA-AO1_Stop_Output INT Preset value of stop/offline output for channel 1. 

4DA-AO2_Stop_Output INT Preset value of stop/offline output for channel 2. 
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Parameter name Type Description Data type 

4DA-AO3_Stop_Output INT Preset value of stop/offline output for channel 3. 

4DA-AO0 DINT Output control value for channel 0. 

Output(O T) 
4DA-AO1 DINT Output control value for channel 1. 

4DA-AO2 DINT Output control value for channel 2. 

4DA-AO3 DINT Output control value for channel 3. 

4DA-AO0_ErrId UINT Fault code for channel 0. 
Diagnosis 

Data 

(Input(T  O)) 

4DA-AO1_ErrId UINT Fault code for channel 1. 

4DA-AO2_ErrId UINT Fault code for channel 2. 

4DA-AO3_ErrId UINT Fault code for channel 3. 
 

 Temperature detection module-FL3103 (4PT) 

Parameter name Type Description Data type 

4PT-Temp0_Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: 

Enable.) 

Bit1: Over-range detection enabling control. (0: 

Disable. 1: Enable.) 

Bit3–bit2 Thermistor wire system configuration 

(0b00: Two-wire system; 0b01: Three-wire 

system; 0b10: Four-wire system) 

Bit4: Temperature unit. (0: ℃. 1: ℉.) 

Bit7–bit5: Channel conversion mode. 

0b000: Reserved 

0b001: PT100 

0b010: PT500 

0b011: Reserved 

0b100: PT1000 

0b101: Reserved 

0b110: Reserved 

0b111: CU100 
Config Param 

4PT-Temp1_Cfg USINT 

Configuration parameter for channel 1. The 

parameter setting is consistent with that for 

channel 0. 

4PT-Temp2_Cfg USINT 

Configuration parameter for channel 2. The 

parameter setting is consistent with that for 

channel 0. 

4PT-Temp3_Cfg USINT 

Configuration parameter for channel 3. The 

parameter setting is consistent with that for 

channel 0. 

4PT-Temp0_Filt USINT 

Filter parameter for channel 0. Range: 1–255. A 

greater value indicates better filter effect but 

greater lagging. 

4PT-Temp1_Filt USINT 

Filter parameter for channel 1. The filter 

parameter setting is consistent with that for 

channel 0. 

4PT-Temp2_Filt USINT 

Filter parameter for channel 2. The filter 

parameter setting is consistent with that for 

channel 0. 
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Parameter name Type Description Data type 

4PT-Temp3_Filt USINT 

Filter parameter for channel 3. The filter 

parameter setting is consistent with that for 

channel 0. 

4PT-Temp0_Offset DINT 

Temperature offset value for channel 0. 

The value has been amplified by 10 times, with 

999 representing 99.9. Detection value = Actually 

measured value + Offset value 

4PT-Temp1_Offset DINT 

Temperature offset value for channel 1. The 

temperature offset value is consistent with that 

for channel 0. 

4PT-Temp2_Offset DINT 

Temperature offset value for channel 2. The 

temperature offset value is consistent with that 

for channel 0. 

4PT-Temp3_Offset DINT 

Temperature offset value for channel 3. The 

temperature offset value is consistent with that 

for channel 0. 

4PT-Temp0 REAL Conversion value for channel 0. 

Input(TO) 
4PT-Temp1 REAL Conversion value for channel 1. 

4PT-Temp2 REAL Conversion value for channel 2. 

4PT-Temp3 REAL Conversion value for channel 3. 

4PT-Temp0_ErrId UINT Fault code for channel 0. 
Diagnosis 

Data 

(Input(T  O)) 

4PT-Temp1_ErrId UINT Fault code for channel 1. 

4PT-Temp2_ErrId UINT Fault code for channel 2. 

4PT-Temp3_ErrId UINT Fault code for channel 3. 
 

 Temperature detection module-FL3203 (4TC) 

Parameter name Type Description Data type 

4TC-Temp0_Cfg USINT 

Configuration parameter for channel 0. 

Bit0: Channel enabling control. (0: Disable. 1: 

Enable.) 

Bit1: Over-range detection enabling control. (0: 

Disable. 1: Enable.) 

Bit3–bit2: Reserved 

Bit4: Temperature unit. (0: ℃. 1: ℉.) 

Bit7–bit5: Channel conversion mode. 

0b000: Thermocouple of type B. 

0b001: Thermocouple of type E. 

0b010: Thermocouple of type J. 

0b011: Thermocouple of type K. 

0b100: Thermocouple of type N. 

0b101: Thermocouple of type R. 

0b110: Thermocouple of type S. 

0b111: Thermocouple of type T. 

Config Param 

4TC-Temp1_Cfg USINT 

Configuration parameter for channel 1. The 

parameter setting is consistent with that for 

channel 0. 

4TC-Temp2_Cfg USINT 
Configuration parameter for channel 2. The 

parameter setting is consistent with that for 
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Parameter name Type Description Data type 

channel 0. 

4TC-Temp3_Cfg USINT 

Configuration parameter for channel 3. The 

parameter setting is consistent with that for 

channel 0. 

4TC-Temp0_Filt USINT 

Filter parameter for channel 0. Range: 1–255. A 

greater value indicates better filter effect but 

greater lagging. 

4TC-Temp1_Filt USINT 

Filter parameter for channel 1. The filter 

parameter setting is consistent with that for 

channel 0. 

4TC-Temp2_Filt USINT 

Filter parameter for channel 2. The filter 

parameter setting is consistent with that for 

channel 0. 

4TC-Temp3_Filt USINT 

Filter parameter for channel 3. The filter 

parameter setting is consistent with that for 

channel 0. 

4TC-Temp0_Offset DINT 

Temperature offset value for channel 0. (The value 

has been amplified by 10 times, with 999 

representing 99.9.) 

Detection value = Actually measured value + Offset 

value 

4TC-Temp1_Offset DINT 
Same as the temperature offset value for channel 

0. 

4TC-Temp2_Offset DINT 
Same as the temperature offset value for channel 

1. 

4TC-Temp3_Offset DINT 
Same as the temperature offset value for channel 

2. 

4TC-Temp0 REAL Conversion value for channel 0. 

Input (TO) 
4TC-Temp1 REAL Conversion value for channel 1. 

4TC-Temp2 REAL Conversion value for channel 2. 

4TC-Temp3 REAL Conversion value for channel 3. 

4TC-Temp0_ErrId UINT Fault code for channel 0. 

Diagnosis Data 

(Input(T  O)) 

4TC-Temp1_ErrId UINT Fault code for channel 1. 

4TC-Temp2_ErrId UINT Fault code for channel 2. 

4TC-Temp3_ErrId UINT Fault code for channel 3. 
 

 Incremental encoder input detection module-FL6112(2EI) 

Parameter Type Description Data type 

2EI_Cnt0_Cfg UINT 

Bit[1:0] Channel mode configuration 

 0b00: A/B phase quadrature mode x4 

 0b01: A/B phase quadrature mode x2 

 0b10: A/B phase quadrature mode x1 

 0b11: Pulse + Direction (high level forward) 

Bit[3:2] Frequency measurement period 

 0b00: 20ms 

 0b01: 100ms 

 0b10: 500ms 

 0b11: 1000ms 

Config Param 
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Parameter Type Description Data type 

Bit[5:4] Edge latch count value enabling 

 0b00: Disable 

 0b01: Rising edge 

 0b10: Falling edge 

 0b11: Dual edge 

Bit[7:6] Reserved 

Bit[9:8] Consistent output pulse width for 

comparison 

 0b00: 1ms 

 0b01: 2ms 

 0b10: 4ms 

 0b11: 8ms 

Bit [11:10] DO comparison output mode 

 0b00: Consistent output for comparison 

 0b01: Output between [Lower count limit, 

Comparison value) 

 0b10: Output between [Comparison value, 

Upper count limit] 

 0b11: Reserved (Consistent output for 

comparison) 

Bit[15:12] Reserved 

2EI_Cnt1_Cfg UINT 

Bit[1:0] Channel mode configuration 

 0b00: A/B phase quadrature mode x4 

 0b01: A/B phase quadrature mode x2 

 0b10: A/B phase quadrature mode x1 

 0b11: Pulse + Direction (high level forward) 

Bit[3:2] Frequency measurement period 

 0b00: 20ms 

 0b01: 100ms 

 0b10: 500ms 

 0b11: 1000ms 

Bit[5:4] Edge latch count value enabling 

 0b00: Disable 

 0b01: Rising edge 

 0b10: Falling edge 

 0b11: Dual edge 

Bit[7:6] Reserved 

Bit[9:8] Consistent output pulse width for 

comparison 

 0b00: 1ms 

 0b01: 2ms 

 0b10: 4ms 

 0b11: 8ms 

Bit [11:10] DO comparison output mode 

 0b00: Consistent output for comparison 

 0b01: Output between [Lower count limit, 

Comparison value) 

 0b10: Output between [Comparison value, 

Upper count limit] 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  238 

Parameter Type Description Data type 

 0b11: Reserved (Consistent output for 

comparison) 

Bit[15:12] Reserved 

2EI_Cnt0_Filt UINT Cnt A/B/Z/L/R Port filter parameter. Unit: 0.1μs 

2EI_Cnt1_Filt UINT Cnt A/B/Z/L/R Port filter parameter. Unit: 0.1μs 

2EI_Cnt0_Ratio UINT 
Encoder resolution, number of pulses per 

revolution, pulse increment between two Z pulses 

2EI_Cnt1_Ratio UINT 
Encoder resolution, number of pulses per 

revolution, pulse increment between two Z pulses 

2EI_Cnt0_PresetVal DINT Counter preset value 

2EI_Cnt1_PresetVal DINT Counter preset value 

2EI_Cnt0_Status USINT 

Counter status feedback 

Bit[0] Forward rotation flag 

Bit[1] Reverse rotation flag 

Bit[2] Overflow flag 

Bit[3] Underflow flag 

Bit[4] L0 latch completion flag 

Bit[7:5] Reserved 

Input (TO) 
2EI_Cnt1_Status USINT 

Counter status feedback 

Bit[0] Forward rotation flag 

Bit[1] Reverse rotation flag 

Bit[2] Overflow flag 

Bit[3] Underflow flag 

Bit[4] L0 latch completion flag 

Bit[7:5] Reserved 

2EI_Cnt0_Val DINT Count value feedback 

2EI_Cnt1_Val DINT Count value feedback 

2EI_Cnt0_Freq DINT Count frequency feedback Hz 

2EI_Cnt1_Freq DINT Count frequency feedback Hz 

2EI_Cnt0_LatchVal DINT Count latch value feedback 

2EI_Cnt1_LatchVal DINT Count latch value feedback 

2EI_Cnt0_Velocity DINT Running speed feedback r/min 

2EI_Cnt1_Velocity DINT Running speed feedback r/min 

2EI_Cnt0_ErrId UINT Fault code Diagnosis Data 

(Input(T  O)) 2EI_Cnt1_ErrId UINT Fault code 

2EI_Cnt0_Ctrl USINT 

Bit[0] Counter enabling, high active  

Bit[1] Counter reset, rising edge active 

Bit[2] Counter preset value writing, rising edge 

active 

Bit[3] Counter overflow flag clear, rising edge 

active 

Bit[4] Counter compare function enabling, high 

active (Counter enabling required) 

bit[7:5] Reserved 

Output (O T) 

2EI_Cnt1_Ctrl USINT 

Bit[0] Counter enabling, high active 

Bit[1] Counter clearing, rising edge active 

Bit[2] Counter preset value writing, rising edge 

active 
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Parameter Type Description Data type 

Bit[3] Counter overflow flag clearing, rising edge 

active 

Bit[4] Counter compare function enabling, high 

active (Counter enabling required) 

Bit [7:5] Reserved 

2EI_Cnt0_CmpVal DINT Counter comparison value 

2EI_Cnt1_CmpVal DINT Counter comparison value 
 

6.3.1.2 Universal EDS file 

FK1300_universal_V1.0.eds: This is a universal EDS file that is used regardless of how the module 

configuration changes or which master node it is compatible with. The current version in use is V1.0. 

EDS has declared 6 connections: 

1. Exdusive Owner 

2. Input Only 

3. Listen Only 

4. Exdusive Owner Diagnosis Interface 

5. Input Only Diagnosis Interface 

6. Listen Only Diagnosis Interface 

Note: Generally, connections 1, 2, and 3 are used based on the situation; connections 4, 5, and 6 are for 

diagnostics (not recommended for use). 

 Input(TO) size and output(OT) size settings 

When configuring, it is necessary to set the sizes of the connected input (TO) and output (OT). The bytes 

occupied by each I/O module are listed as follows. 

Table 6-1 Number of bytes occupied I/O modules 

No. Module Input(TO): bytes Output(OT): bytes 

0 FK1300 4 0 

1 FL1001_1600DI 2 0 

2 FL1002_3200DI 4 0 

3 FL2002_0016DP 0 2 

4 FL2003_0032DP 0 4 

5 FL2102_0016DN 0 2 

6 FL2103_0032DN 0 4 

7 FL2201_0008DR 0 2 

8 FL3003_4AD 8 0 

9 FL3103_4PT 16 0 

10 FL3203_4TC 16 0 

11 FL4003_4DA 0 8 

12 FL5005_1616DP 2 2 

13 FL5105_1616DN 2 2 

14 FL6112_2EI 34 10 

For example, combination of FK1300 + FL1001_1600DI + FL3103_4PT + FL2201_0008DR 

After checking the table: 

FK1300:   4 bytes Input(TO),   Parameter name: hwVersion, swVersion 
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FL1001_1600DI:  2bytes Input(TO),   Parameter name: 1600DI -IN0, 1600DI –IN1 

FL3103_4PT:  16bytes Input(TO),  Parameter name: 4PT-Temp0 – 4PT-Temp4 

FL2201_0008DR: 2bytes Output(OT),   Parameter name: 0008DR-OUT0, Satisfy Parameter (empty 

parameter) 

TO byte TO parameter name 

0 
hwVersion 

1 

2 
swVersion 

3 

4 1600DI_IN0 

5 1600DI_IN1 

6 

4PT-Temp0 
7 

8 

9 

10 

4PT-Temp1 
11 

12 

13 

14 

4PT-Temp2 
15 

16 

17 

18 

4PT-Temp3 
19 

20 

21 

OT byte OT parameter name 

0 0008DR-OUT0 

1 Satisfy Parameter (Empty parameter) 
 

Input(TO) length: 4+2+16+0=22 

Output(OT) length: 0+0+2=2 

The configuration is as follows if in Codesys: 

  

Note: 

 The length of the data in the input and output process must be set correctly; otherwise a connection 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  241 

cannot be established. 

 When calculating the length of input data, please note that the FK1300 coupler occupies 4 bytes of 

data. 

 Config Param configuration parameter description 

The current ConfigParam field includes the configuration for 14 supported I/O modules, with uniform 

settings for the same modules within the configuration, with a total length of 206 bytes. The specific offsets 

are as follows: 

Module Configuration parameter name Offset Default value Configurable 

FK1300 

EDS type 
0 

1 No 
1 

SLOT 1–8 Module Enable Bit 2 255 Yes 

SLOT 9–16 Module Enable Bit 3 255 Yes 

SLOT 17–24 Module Enable Bit 4 255 Yes 

SLOT 25–32 Module Enable Bit 5 255 Yes 

FL1001-1600DI 

slot1_FlexIO(FL1001) 

6 

372330578 No 
7 

8 

9 

slot1_1600DI_Filt0 
10 

1000 Yes 
11 

slot1_1600DI_Filt1 
12 

1000 Yes 
13 

FL1002-3200DI 

slot2_FlexIO(FL1002) 

14 

372330579 No 
15 

16 

17 

slot2_3200DI_Filt0 
18 

1000 Yes 
19 

slot2_3200DI_Filt1 
20 

1000 Yes 
21 

slot2_3200DI_Filt2 
22 

1000 Yes 
23 

slot2_3200DI_Filt3 
24 

1000 Yes 
25 

FL2002-0016DP 

slot3_FlexIO(FL2002) 

26 

372330586 No 
27 

28 

29 

slot3_0016DP_Stop_Mode0 
30 

0 Yes 
31 

slot3_0016DP_Stop_Mode1 
32 

0 Yes 
33 

slot3_0016DP_Stop_Output0 34 0 Yes 

slot3_0016DP_Stop_Output1 35 0 Yes 

FL2003-0032DP slot4_FlexIO(FL2003) 

36 

372330587 No 37 

38 
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Module Configuration parameter name Offset Default value Configurable 

39 

slot4_0032DP_Stop_Mode0 
40 

0 Yes 
41 

slot4_0032DP_Stop_Mode1 
42 

0 Yes 
43 

slot4_0032DP_Stop_Mode2 
44 

0 Yes 
45 

slot4_0032DP_Stop_Mode3 
46 

0 Yes 
47 

slot4_0032DP_Stop_Output0 48 0 Yes 

slot4_0032DP_Stop_Output1 49 0 Yes 

slot4_0032DP_Stop_Output2 50 0 Yes 

slot4_0032DP_Stop_Output3 51 0 Yes 

FL2102-0016DN 

slot5_FlexIO(FL2102) 

52 

372330594 No 
53 

54 

55 

slot5_0016DN_Stop_Mode0 
56 

0 Yes 
57 

slot5_0016DN_Stop_Mode1 
58 

0 Yes 
59 

slot5_0016DN_Stop_Output0 60 0 Yes 

slot5_0016DN_Stop_Output1 61 0 Yes 

FL2103-0032DN 

slot6_FlexIO(FL2103) 

62 

372330595 No 
63 

64 

65 

slot6_0032DN_Stop_Mode0 
66 

0 Yes 
67 

slot6_0032DN_Stop_Mode1 
68 

0 Yes 
69 

slot6_0032DN_Stop_Mode2 
70 

0 Yes 
71 

slot6_0032DN_Stop_Mode3 
72 

0 Yes 
73 

slot6_0032DN_Stop_Output0 74 0 Yes 

slot6_0032DN_Stop_Output1 75 0 Yes 

slot6_0032DN_Stop_Output2 76 0 Yes 

slot6_0032DN_Stop_Output3 77 0 Yes 

FL2201-0008DR 

slot7_FlexIO(FL2201) 

78 

372330601 No 
79 

80 

81 

slot7_0008DR_Stop_Mode 
82 

0 Yes 
83 

slot7_0008DR_Stop_Output 84 0 Yes 

FL3003-4AD slot8_FlexIO(FL3003) 
85 

372330625 No 
86 
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Module Configuration parameter name Offset Default value Configurable 

87 

88 

slot8_4AD_AI0_Cfg 89 97 Yes 

slot8_4AD_AI1_Cfg 90 97 Yes 

slot8_4AD_AI2_Cfg 91 97 Yes 

slot8_4AD_AI3_Cfg 92 97 Yes 

slot8_4AD_AI0_Filt 93 8 Yes 

slot8_4AD_AI1_Filt 94 8 Yes 

slot8_4AD_AI2_Filt 95 8 Yes 

slot8_4AD_AI3_Filt 96 8 Yes 

FL3103-4PT 

slot9_FlexIO(FL3103) 

97 

372330657 No 
98 

99 

100 

slot9_4PT_Temp0_Cfg 101 129 Yes 

slot9_4PT_Temp1_Cfg 102 129 Yes 

slot9_4PT_Temp2_Cfg 103 129 Yes 

slot9_4PT_Temp3_Cfg 104 129 Yes 

slot9_4PT_Temp0_Filt 105 8 Yes 

slot9_4PT_Temp1_Filt 106 8 Yes 

slot9_4PT_Temp2_Filt 107 8 Yes 

slot9_4PT_Temp3_Filt 108 8 Yes 

slot9_4PT_Temp0_Offset 
109 

0 Yes 
110 

slot9_4PT_Temp1_Offset 
111 

0 Yes 
112 

slot9_4PT_Temp2_Offset 
113 

0 Yes 
114 

slot9_4PT_Temp3_Offset 
115 

0 Yes 
116 

FL3203-4TC 

slot10_FlexIO(FL3203) 

117 

372330665 No 
118 

119 

120 

slot10_4TC_Temp0_Cfg 121 129 Yes 

slot10_4TC_Temp1_Cfg 122 129 Yes 

slot10_4TC_Temp2_Cfg 123 129 Yes 

slot10_4TC_Temp3_Cfg 124 129 Yes 

slot10_4TC_Temp0_Filt 125 8 Yes 

slot10_4TC_Temp1_Filt 126 8 Yes 

slot10_4TC_Temp2_Filt 127 8 Yes 

slot10_4TC_Temp3_Filt 128 8 Yes 

slot10_4TC_Temp0_Offset 
129 

0 Yes 
130 

slot10_4TC_Temp1_Offset 
131 

0 Yes 
132 

slot10_4TC_Temp2_Offset 
133 

0 Yes 
134 
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Module Configuration parameter name Offset Default value Configurable 

slot10_4TC_Temp3_Offset 
135 

0 Yes 
136 

FL4003-4DA 

slot11_FlexIO(FL4003) 

137 

372330633 No 
138 

139 

140 

slot11_4DA_AO0_Cfg 141 97 Yes 

slot11_4DA_AO1_Cfg 142 97 Yes 

slot11_4DA_AO2_Cfg 143 97 Yes 

slot11_4DA_AO3_Cfg 144 97 Yes 

slot11_4DA_AO0_Stop_Output 
145 

0 Yes 
146 

slot11_4DA_AO1_Stop_Output 
147 

0 Yes 
148 

slot11_4DA_AO2_Stop_Output 
149 

0 Yes 
150 

slot11_4DA_AO3_Stop_Output 
151 

0 Yes 
152 

FL5005-1616DP 

slot12_FlexIO(FL5005) 

153 

372330610 No 
154 

155 

156 

slot12_1616DP_Filt0 
157 

1000 Yes 
158 

slot12_1616DP_Filt1 
159 

1000 Yes 
160 

slot12_1616DP_Stop_Mode0 
161 

0 Yes 
162 

slot12_1616DP_Stop_Mode1 
163 

0 Yes 
164 

slot12_1616DP_Stop_Output0 165 0 Yes 

slot12_1616DP_Stop_Output1 166 0 Yes 

FL5105-1616DN 

slot13_FlexIO(FL5105) 

167 

372330614 No 
168 

169 

170 

slot13_1616DN_Filt0 
171 

1000 Yes 
172 

slot13_1616DN_Filt1 
173 

1000 Yes 
174 

slot13_1616DN_Stop_Mode0 
175 

0 Yes 
176 

slot13_1616DN_Stop_Mode1 
177 

0 Yes 
178 

slot13_1616DN_Stop_Output0 179 0 Yes 

slot13_1616DN_Stop_Output1 180 0 Yes 

FL6112_2EI slot14_FlexIO(FL6112) 
181 

372330673 No 
182 
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Module Configuration parameter name Offset Default value Configurable 

183 

184 

slot14_2EI_Cnt0_Cfg 
185 

772 Yes 
186 

slot14_2EI_Cnt1_Cfg 
187 

772 Yes 
188 

slot14_2EI_Cnt0_Filt 
189 

5 Yes 
190 

slot14_2EI_Cnt1_Filt 
191 

5 Yes 
192 

slot14_2EI_Cnt0_Ratio 
193 

10000 Yes 
194 

slot14_2EI_Cnt1_Ratio 
195 

10000 Yes 
196 

slot14_2EI_Cnt0_PresetVal 

197 

0 Yes 
198 

199 

200 

slot14_2EI_Cnt1_PresetVal 

201 

0 Yes 
202 

203 

204 

FK1300 Satisfy Parameter 205 0 No 
 

For specific module configuration instructions, see 6.3.1.1 Module parameter. 

FK1300 configurable parameter descriptions are listed in the following table. 

Parameter Type Description 

SLOT  1-8 Module Enable USINT 

Control bit of expansion module enabling/disabling. 

Bit that controlling the enabling/disabling of the 

expansion module behind the coupler. Each bit 

controls the enabling/disabling of a module. 

Bit7 … Bit0 

Controls module 

8. 
… 

Controls module 

1. 

TRUE: Enable.    FALSE: Disable. 

SLOT  9-16 Module Enable USINT 

Control bit of expansion module enabling/disabling. 

Bit that controlling the enabling/disabling of the 

expansion module behind the coupler. Each bit 

controls the enabling/disabling of a module. 

Bit7 … Bit0 

Controls module 

16. 
… 

Controls module 

9. 

TRUE: Enable.    FALSE: Disable. 

SLOT  17-24 Module Enable USINT 

Control bit of expansion module enabling/disabling. 

Bit that controlling the enabling/disabling of the 

expansion module behind the coupler. Each bit 

controls the enabling/disabling of a module. 
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Parameter Type Description 

Bit7 … Bit0 

Controls module 

24. 
… 

Controls module 

17. 

TRUE: Enable.    FALSE: Disable. 

SLOT  25-32 Module Enable USINT 

Control bit of expansion module enabling/disabling. 

Bit that controlling the enabling/disabling of the 

expansion module behind the coupler. Each bit 

controls the enabling/disabling of a module. 

Bit7 … Bit0 

Controls module 

32. 
… 

Controls module 

25. 

TRUE: Enable.    FALSE: Disable. 
 

6.3.1.3 Specialized EDS file 

Based on the actual configuration, the corresponding EDS file is generated using a tool, and there is no need 

to set input(TO) size/output(O  T) size again during master node configuration. 

 Instructions for generating a specialized EDS file 

 Tool software: Ttools-IO.exe, use version V1.0.6.2 or later. 

 USB cable: Type-C 

1. After the coupler is powered on, connect the Type-C cable to the computer, and then run the Ttools-IO 

software. See the following figure. 
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2. Click refresh COM and refresh view. See the following figure. 

 

3. Click the buttons shown in the following figure for EDS file generation. 

 

Note: Distinguish non-configured EDS files by modifying the product code. 

Two files are generated: 

 FK1300.eds: Specialized EDS file. 

 FK1300_IO.excel: IO mapping table for easy querying of parameter offset addresses. 

Description of a parameter name in the document: Slot name + Module name + Parameter name; you can 

know the slot and module type according to the name. 

For example: 

 slot1_1600DI_IN0: slot1 is the first slot counted from the coupler end is , the module is 1600DI, and the 

parameter is IN0. 

 slot10_4TC_Temp0: slot10 is the tenth slot counted from the coupler end, the module is 4TC, and the 

parameter is Temp0. 
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IO mapping table description: 

 

According to the byte sequence number, you can know the offset address and the number of bytes 

occupied. 

There are a total of three tables as follows: 

 Input: Input process data 

 Output: Output process data 

 Config: Configuration data 

 Parameter description 

See 6.3.1.1 Module parameter for the specific module configuration description. 

6.3.1.4 Object information 

The object information can be obtained/configured through UCMM using the Get Attribute Single (0x0E) and 

Set Attribute Single (0x10) services. Common object information is listed in the following table. 

Data object Class Instance Attribute Service Remarks 

Coupler information 0x04 0x68 0x03 0x0E 

Bytes 0–1: Number of Act 

num modules 

Bytes 2–3: Hw version 

Bytes 4–5: Sw version 

Bytes 6–7: Fpga version 
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Data object Class Instance Attribute Service Remarks 

Module configuration 0x04 0x69 0x03 0x0E 

Bytes 0–31: Slot 1–32 

module type 

Module does not exist: 0x00 

FL1001-1600DI: 0x12 

FL2002-0016DP: 0x1A 

FL2102-0016DN: 0x22 

FL2201-0008DR: 0x29 

FL3003-4AD: 0x41 

FL4003-4DA: 0x49 

FL3103-4PT: 0x61 

FL3203-4TC: 0x69 

Slot 1 module info 0x04 0x70 0x03 0x0E 
Bytes 0–1: Hw version 

Bytes 2–3: FPGA version 
… 0x04 … 0x03 0x0E 

Slot 32 module info 0x04 0x8F 0x03 0x0E 

IP configuration 

method 
0xF5 0x01 0x03 0x0E, 0x10 CIP standard object 

IP interface 

configuration 
0xF5 0x01 0x05 0x0E, 0x10 CIP standard object 

IP address 0x04 0x92 0x03 0x0E, 0x10 - 

Subnet mask 0x04 0x93 0x03 0x0E, 0x10 - 

Gateway 0x04 0x94 0x03 0x0E, 0x10 - 
 

6.3.2 KV STUDIO configuration description 

6.3.2.1 Preparation 

 PLC: KV-8000 

 Computer: Pre-installed KV STUDIO software 

 network cable, power supply, coupler, module 

The list is as follows: 

Type Model Qty Slot 

PLC KV-8000 1 - 

Coupler FK1300 1 0 

IO module 

FL1001(1600D) 1 1 

FL2002(0016DP) 1 2 

FL1002(3200D) 1 3 

FL2002(0016DP) 1 4 

Bottom cover Bottom cover 1 5 
 

Device configuration file (choose one from two options; this example uses a universal EDS file) 

 Universal EDS file: FK1300_universal_V1.0.eds 

 Specialized EDS file: FK1300.eds that is generated using the Ttools-IO software. 

For hardware configuration and connection, see the requirements and operations described in chapters 4 

Installation and 5 Wiring. 
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6.3.2.2 Project establishing 

Step 1 Open KV STUDIO software, choose File > New Project, enter information such as Project name and 

PLC model, and click OK on the pop-up interface. 

 

Step 2 Click Yes. 

 

Step 3 Click Yes. 
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Step 4 Set the IP address of KV-8000. Ensure it is in the same network segment as PK1300. 

 

Step 5 Double-click the unit in the red box to configure the network. 
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Step 6 Click Manual, enter the EtherNet/IP settings interface, and click EDS file to add an EDS file. 

 

 

 

Step 7 Select FK1300_universal_V1.0.eds and then click OK. 

 

After successful adding, the interface shown in the following figure appears. 
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Step 8 Double click FK1300, change the corresponding IP to the actual IP of the coupler, and add the 

device to the configuration. 

 

Step 9 After adding the module, click Exclusive Owner to enter the module settings window, click Setup 

parameter, and set the correct TO and OT sizes. 
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Assign soft elements by referring to Table 6-1 based on the actual IO module configuration. 

Type Model Slot 
TO size 

(Bytes) 

OT size 

(Bytes) 

Automatic soft 

element assignment 

(word access) 

Manual 

assignment (bit 

access) 

IO 

module 

FK1300 0 4 0 W00, W01 - 

FL1001(1600D) 1 2 0 W02 R78000–R78015 

FL2002(0016DP) 2 0 2 W06 R78400–R78415 

FL1002(3200D) 3 4 0 W03, W04 
R78100–R78115, 

R78200–R78215 

FL2002(0016DP) 4 0 2 W07 R78500–R78515 
 

Step 10 Soft element assignment: choose manual or automatic. See the preceding table for corresponding 

module parameters. 

Automatic assignment: 
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Manual assignment: Use the unit of R. 

   

Step 11 Set RPI. 

Step 12 After setting is completed, click OK to enter the download verification. 

6.3.2.3 Configuration download and verification 

Choose Monitor/Simulator (N) > PLC Transfer > Monitor Mode (C), and click Execute to download to the 

PLC. 
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At this time, the PK1300 indicator lights PWR and MS_R are steady on in green. 

 

Manual soft element configuration: 
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Automatic soft element configuration: 

 
 

6.3.3 RSLogix5000 configuration description 

6.3.3.1 Preparation 

 PLC: Rockwell 1769-L36ERMS LOGIX5370 SAFETY 

 Computer: Preinstalled with STUDIO 5000 software 

 network cable, power supply, coupler, module 

The list is as follows: 

Type Model Qty Slot 

PLC 
Rockwell 

1769-L36ERMS LOGIX5370 SAFETY 
1 - 

Coupler FK1300 1 0 

IO module 

FL1001(1600D) 1 1 

FL2002(0016DP) 1 2 

FL1002(3200D) 1 3 

FL2002(0016DP) 1 4 

Bottom cover Bottom cover 1 5 
 

Device configuration file (choose one from two options; this example uses a universal EDS file) 

 Universal EDS file: FK1300_universal_V1.0.eds 

 Specialized EDS file: FK1300.eds that is generated using the Ttools-IO software. 

For hardware configuration and connection, see the requirements and operations described in chapters 4 

Installation and 5 Wiring. 
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6.3.3.2 Project establishing 

Step 1 Use a printer cable or Ethernet cable to connect the computer and the PLC, open Studio5000 

software, right-click the File option, and then click New. 

 

Step 2 Select the correct PLC model, fill in the project name, and click Next. 

 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  259 

Step 3 Add the EDS file. Click TOOLS > EDS Hardware Installation Tool. The following interface appears. 

 

Step 4 Click Next to proceed to the next page, choose Register an EDS file(s), then click Next again to 

enter the interface shown below. Choose the path of the EDS file we want to install. 
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Step 5 Keep clicking Next until OK. 

Step 6 Right-click Ethernet and choose New Module. 

 

Step 7 Double click FK1300 to add the device to the configuration. 
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Step 8 Set FK1300 name and IP address, and then click Change. 

 

Step 9 Modify the input(TO) size and output(OT) size. 

 

Assign soft elements by referring to Table 6-1 based on the actual IO module configuration. 

Type Model Slot TO size (Bytes) OT size (Bytes) 

IO 

module 

FK1300 0 4 0 

FL1001(1600D) 1 2 0 

FL2002(0016DP) 2 0 2 

FL1002(3200D) 3 4 0 
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Type Model Slot TO size (Bytes) OT size (Bytes) 

FL2002(0016DP) 4 0 2 

 Input(TO) Size: 10 

 Output(OT) Size: 4 

 

Step 10 Click OK > Yes > OK > Close. 

6.3.3.3 Download 

Select the bus symbol (as shown in the red box in the middle of the following figure) to enter the WHO Active 

interface, select the controller you are using, and click Download. 

 

If the following interface appears, set the gear of the PLC controller to REM or PROG mode. 

 

Then click Download again to complete the download successfully. 
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At this time, the PK1300 indicator lights PWR and MS_R are steady on in green. 

To view the data: choose Menu > LOGIC > Monitor Tags. 

 

 Test: When FK1300 is loaded, enter Name. 

 test:C: Configuration information 

 test: I: Input process data 

 test:O: Output process data 

6.3.4 CODESYS configuration description 

6.3.4.1 Preparation 

Hardware environment: 

 One computer pre-installed with CODESYS V3.5 software 

 Network cable and power module model should be configured according to the actual situation. 

The list is as follows: 

Type Model Slot 

PLC CODESYS Control WIN V3 – x64 SysTray software - 
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Type Model Slot 

Coupler FK1300 0 

I/O module 

FL1002-3200DI 1 

FL2103-0032DN 2 

FL3203-4TC 3 

FL3003-4AD 4 

FL4003-4DA 5 

FL6112_2EI 6 

FL1001-1600DI 7 

FL5005-1616DP 8 

FL5105-1616DN 9 

FL2201-0008DR 10 

FL3103-4PT 11 

FL2003-0032DP 12 

FL2002-0016DP 13 

Bottom cover Bottom cover 15 
 

Device configuration file (Choose one from the two) 

 Universal EDS file: FK1300_universal_V1.0.eds 

 Specialized EDS file: FK1300.eds that is generated using the Ttools-IO software. 

For hardware configuration and connection, see the requirements and operations described in chapters 4 

Installation and 5 Wiring. 

6.3.4.2 EDS file installing 

Install the EDS device descriptor file (FK1300_universal_V1.0.eds). 

Open the CODESYS software, choose Tools > Device Repository, click Install, and select 

FK1300_universal_V1.0.eds to install. See the following figure. 
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6.3.4.3 Project establishing  

1. Click File and choose New Project. 

2. Add Ethernet.  

Step 1 Start the PLC: CODESYS Control Win V3 - x64 SysTray. 

Step 2 Double click Device (CODESYS Control Win V3 x64) in the left navigation tree, and then click Scan 

Network. 

Step 3 Select the device, click Scan Network, and select the network path. 

 
 

Step 4 Click OK to enter the interface as shown in the following figure. The network is in activated state. 
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Step 5 Choose Device (CODESYS Control Win V3 x64) from the left navigation tree, right-click and choose 

Add Device. 

Step 6 Choose EthernetIP > Ethernet Adapter > Ethernet. See the following figure. 
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Step 7 Choose Ethernet (Ethernet) from the navigation tree on the left, right-click and choose Add 

Device. 

Step 8 Choose EtherNetIP > EtherNet/IP Scanner > EtherNet/IP Scanner. See the following figure. 

 

Step 9 Configure EthernetIP. Double-click Ethernet (Ethernet) in the left navigation tree to open the 

configuration window. On the General tab, click the right side of Interface and select the network 

adapter, as shown in the following figure. 
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Step 10 Add a device. Right-click EtherNet_IP_Scanner and choose Add Device. See the following figure. 

 

Step 11 After adding the device, configure the device communication parameters, setting the actual IP of 

the coupler. Ensure that the coupler and the Ethernet IP master are on the same network segment. 

 
 

Step 12 Set device connection parameters. 

Double click the device FK1300, open the device configuration window, and switch to the 

Connection page. See the following figure. 

 

See Table 6-1 for the OT size (bytes) and TO size (bytes). 
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According to the actual IO module configuration, check the table. 

Type Model Slot TO size (Bytes) OT size (Bytes) 

IO module 

FK1300 0 4 0 

FL1002-3200DI 1 4 0 

FL2103-0032DN 2 0 4 

FL3203-4TC 3 16 0 

FL3003-4AD 4 8 0 

FL4003-4DA 5 0 8 

FL6112_2EI 6 34 10 

FL1001-1600DI 7 2 0 

FL5005-1616DP 8 2 2 

FL5105-1616DN 9 2 2 

FL2201-0008DR 10 0 2 

FL3103-4PT 11 16 0 

FL2003-0032DP 12 0 4 

FL2002-0016DP 13 0 2 

FL2102-0016DN 14 0 2 

Summary 88 36 
 

Calculate based on the preceding table: OT size (bytes): 36 

TO size (Bytes): 88 

The following figure shows the corresponding positions. 

 

 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  270 

Step 13 Click OK. Then click the compile, and download, and run buttons. See the following figure. 

 

Step 14 Configuration is completed and the PLC program can be written and verified in practice. 

6.4 ModbusTCP configuration 

6.4.1 Ttools-IO upper computer configuration example 

Use Ttools-IO to configure the FK1400. Note that the power must be turned on before connecting the type-C 

cable to the computer. 

 Configuration reading 

 

Click Device Scanning > Refresh to select the serial port corresponding to the device. Click Get Config to 

load the version information and slots of each module in the configuration. Then click Load to proceed to 

the next page. 
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 IP configuration 

 

Read: Click the Get Config button to load the device configuration information such as IP address, subnet 

mask, etc. 

Modify: After entering the IP address, subnet mask, and gateway, click OK. The settings will take effect after 

the device is powered on again. 
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 Module parameter configuration 

 

By clicking on each slot module in the configuration information column on the left, you can enter the 

Configuration Parameters interface to set parameters for each channel. After making the necessary 

modifications, use the Download Project function to download the settings to the coupler, which will then 

save the configuration information. 
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 Configuration writing 

 

When all modules have been configured, click in the order shown in the above diagram to write the 

configuration settings and module configurations to the coupler. 

If the configuration information does not match the actual configuration, the SF indicator on the coupler will 

illuminate to indicate a configuration mismatch. Please carefully verify that the configuration information 

on the left side of the diagram above matches the actual configuration. 

 Address mapping table 

 

Note: The Address mapping table requires reference to Appendix A for operation. 

6.4.2 Module configuration application example 

6.4.2.1 Codesys configuration example 

 Environment 

Perform the configuration operation according to the Ttools-IO setup. Power on the coupler and connect 

the network cable to the computer. Ensure that the IP address of the coupler and the IP address of the 

computer are in the same subnet. The computer should be pre-installed with the software "CODESYS V3.5, 

CODESYS Control Win V3 - x64 SysTray". 
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 Creating a new project 

Log in to CODESYS, click File > New Project, enter a name, and click OK, as shown in the figure below. 

 

 Scanning network 

Step 1 Use "CODESYS Control Win V3 - x64 SysTray" to start the PLC. Locate "CODESYS Control Win V3 - x64 

SysTray" in the bottom right corner of the computer, right-click it, and select Start PLC. 

Step 2 Double-click Device (CODESYS Control Win V3 X64) in the left navigation tree of CODESYS, and 

then click on Scan Network. 

Step 3 Select the device and choose the correct network path to the controller, as shown in the following 

figure. 
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 Adding devices 

 Add Ethernet. 

 Add a ModbusTCP master node. 

 Add a ModbusTCP slave node. 

After adding, it appears as shown in the following figure. 

 

 

 Ethernet configuration 

 

 

 ModbusTCP slave node configuration 

1) Configuring the network 

 

 



INVT Flex Series I/O System User Guide  Communication coupler configuration 

202501 (V1.2）  276 

2) Configuring the channel 

Step 1 With the Ttools-IO software, you can view the topology structure's IO module address mapping 

table. This table displays the function code for each module, the starting address offset, and the 

corresponding monitoring address range for the module, as shown in the following figure. 

 

 

Step 2 On the left side of the Modbus_TCP_Slave page, click Modbus Slave Channel, then click Add 

Channel to open the Channel 0 configuration window, as shown in the following figure. 
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Step 3 The digital input modules FL1002_3200DI, FL5005_1616DP, FL5105_1616DN, and FL1002_3200DI 

have a function code of 02 corresponding to DI (Input Bit), with an offset address of 0x00 and 

address ranges of 0–31, 32–47, 48–63, and 64–95, totaling 96 bits. In the Channel 0 configuration 

window, set the Access type to Read Discrete Inputs (Function Code 2), set the READ Register 

Offset to 0 and Length to 96, and click OK, as shown in the following figure. (You can also customize 

the offset address and length based on actual needs by referring to the IO module address mapping 

table.) 

 

 

Step 4 The digital output modules FL2201_0008DR, FL2102_0016DN, FL5005_1616DP, FL2003_0032DP, 

FL5105_1616DN, FL2002_0016DP, and FL2103_0032DN correspond to an address range of 0–8 when 

using the Output (Word) write function. When configuring Channel 1, set the Access type to Write 

Multiple Registers (Function Code 16) and set the WRITE Register Offset to 4096 and Length of 9, 

as shown in the following figure. 

 

Note: If the Output (Word) write function is used, the Output (Bit) write operation cannot be performed 

simultaneously. Otherwise, multiple write operations to the same output point may cause conflicts. 
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Configure the other channels in sequence as follows: 

 

 

 Verifying 

Step 1 On the left side of the Modbus_TCP_Slave page, click ModbusTCPSlave I/O Mapping to monitor the 

IO modules. In the lower right corner, select Enabled 1 for Always update variables, as shown in 

the following figure. 

 

 

Step 2 On the menu bar, click Build > Build to start the compilation process.  

Step 3 On the menu bar, click Online > Login or click the login icon to log in. 

Step 4 On the menu bar, click Online > Multiple Download, select Always perform a full download, and 

click OK. 

Step 5 Click the start icon to perform the verification test. 

Modify the output value for a simple verification. 

 

 

6.4.2.2 Modbus Poll example 

 Environment 

Perform the configuration operation according to the Ttools-IO setup. Power on the coupler and connect 

the network cable to the computer. Ensure that the IP address of the coupler and the IP address of the 

computer are in the same subnet. The computer should be pre-installed with the software "Modbus Poll". 
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 Module connection 

Step 1 Open the Modbus Poll software, and the main window is shown in the following figure. 

  

Tx = 0 indicates the number of data frames sent to the master node, which is 0 in the figure.  

Err = 0 indicates the number of communication errors, which is 0 in the figure.  

ID = 1 indicates the device address of the simulated Modbus slave device, which is 1 in the figure.  

F = 15 indicates the Modbus function code being used, which is function code 15 in the figure. 

SR = 10ms indicates the scan period, and the red text indicates the current error status. 

"No Connection" indicates a disconnected status. 

Step 2 On the menu bar, click Connection > Connect to open the Connection setup window. In the 

Connection options, select Modbus TCP/IP, which is the communication protocol used by Modbus 

TCP. Enter the IP address of the coupler in the IP address field, and then click OK, as shown in the 

following figure. 
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Step 3 After the connection is established, Tx will continue to increase. See the following figure. 

 

 

 Channel settings and monitoring 

Step 1 With the Ttools-IO software, you can view the topology structure's IO module address mapping 

table. This table displays the function code for each module, the starting address offset, and the 

corresponding monitoring address range for the module, as shown in the following figure. 

 

 

Step 2 Configure the channels as follows according to the table above: 

A. Function code 2, Input (bit), offset: 0, length: 96 
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B. Function code 15, Output(bit), offset: 0, length: 144 

 

C. Function code 04, Input(Word), offset: 0, length: 40 

 

D. Function code 16, Output(Word), offset: 0, length: 14 
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Note: Input (Word), offset: 4096; and Output (Word), offset: 4096 are the digital Word access mappings. 

They correspond to the same signals as Input (Bit), offset: 0; and Output (Bit), offset: 0. Generally, use them 

as needed, but do not access both Bit and Word simultaneously. Concurrent write operations on outputs 

may lead to conflicts. 

Step 3 Configure the diagnostic information as follows: 

Function code 04, Input(Word), offset: 8192, length: 24 

 

The result is as shown in the following figure: 
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7 Common functions of Ttools-IO software 

The following are the main commonly used functions of Ttools-IO software: 

 Coupler firmware upgrade 

 Creating a new project 

 Opening an existing project 

 Scanning a module 

 Adding a module 

 Adjusting module order 

 Deleting a module 

 Editing parameters 

 Downloading project parameters 

 EDS export 

 Module firmware upgrade 

 Online monitoring 

 Viewing logs 

 Checking for updates 

Note: 

 The following common functions of Ttools-IO software are illustrated using the FK1300 module as an 

example. 

 The minimum version of EIP for firmware compatibility is 103. Users need to confirm the firmware 

version during operation. 

 Operating environment 

Type Description 

OS Windows7, Windows10 

Communication interface USB 

Power supply 24V 

Module 

FL1001-1600DI, FL1002-3200DI, FL2002-0016DP, FL2003-0032DP, 

FL2102-0016DN, FL2103-0032DN, FL2201-0008DR, FL3003-4AD, 

FL3103-4PT, FL3203-4TC, FL4003-4DA, FL5005-1616DP, 

FL5105-1616DN, FL6002-2ES, FL6112-2EI, FL6121-1EI 
 

 Precautions 

1. When upgrading the coupler firmware, first connect the USB, and then connect the power supply. It is 

very important to follow the correct sequence for the upgrade to proceed normally. 

2. For module scanning, module upgrading, and parameter downloading, the power supply must be 

connected first, followed by the USB cable. The correct connection order is necessary for normal 

operation. 

3. Some operations require power to be turned off and then back on to take effect, such as firmware 

upgrades, module upgrades, and IP modifications. Pay attention to the prompt information during 
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these operations. 

4. The coupler module can connect a maximum of 32 modules. If the total power of the modules exceeds 

the output power provided by the coupler, a power relay module must be used to ensure stable 

operation of the entire module configuration. 

5. When connecting the USB to the coupler, be sure to select the correct COM port to avoid errors. It is 

recommended to connect only one set of couplers for operation at a time. 

 

7.1 Coupler firmware upgrade 

 

As shown in the above figure, select Firmware Upgrade, and then select Adapter Upgrade in the pop-up 

window. Next, select the corresponding COM port and the required firmware, and finally click Start to start 

the upgrade. 
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7.2 Creating a new project 

 

As shown in the above figure, you can manually create a new project by clicking the New Project button in 

the menu bar to open the corresponding window. Enter a project name, select a save path, and click OK to 

create a new project. 
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7.3 Opening an existing project 

 

Click File > Open Project from the menu bar. The following operation interface will be displayed. Select the 

required project and click Open to open the project. 
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The interface shown in the following figure indicates that the project has been successfully opened. 

 

7.4 Scanning a module 

 

Module scanning is used to obtain information about the physical configuration. Once the scanning is 

complete, you can load it into the project by clicking the Load button, creating a saveable software project 

that facilitates subsequent parameter editing and downloading. 

The interface shown in the following figure indicates that the scanned module has been successfully loaded. 
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7.5 Adding a module 

 

For an opened project, you can add modules by double-clicking the corresponding module in the device 

tree or by dragging the module into the software view. 
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7.6 Adjusting module order 

 

1. When selecting a module in the project tree, you can adjust the module order using the move up and 

move down buttons. 

2. When selecting the Configuration window in the Installation Information section, you can adjust the 

window order using the left and right arrow keys or through the right-click menu. 

7.7 Deleting a module 

 



INVT Flex Series I/O System User Guide  Common functions of Ttools-IO software 

202501 (V1.2）  290 

1. When selecting a module in the project tree, you can delete the module using the Delete key on the 

keyboard or through the right-click menu. 

2. When selecting the Configuration window in the Installation Information section, you can delete the 

corresponding module using the right-click menu. 

 

7.8 Editing parameters 

 

In the project tree interface, after selecting a module or installation information, you can select the 

Configuration Parameters tab to edit the corresponding module's parameters. Once you have finished 

editing, please remember to save the project. 



INVT Flex Series I/O System User Guide  Common functions of Ttools-IO software 

202501 (V1.2）  291 

7.9 Downloading project parameters 

 

In the project tree interface, select the coupler for which you need to download parameters. Click Download 

Project in the menu bar to open the corresponding operation interface, where you can download 

parameters for all edited modules to the device. 

7.10 EDS export 

 

Right-click the coupler that you need to export the EDS file for, and select Export EDS from the menu. 
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On the pop-up windows, enter a product name and product code, click Export EDS to save the exported file 

in the selected path. 

7.11 Module firmware upgrade 

 

Module upgrades are performed on the modules connected to the coupler. Select Firmware Upgrade from 

the menu bar, then choose Module Upgrade in the pop-up interface. Follow the prompts to connect the 

coupler and select the appropriate serial port to obtain the physical configuration, which will be displayed 

on the interface. 

When selecting the firmware to upgrade, please note that only one type of module can be upgraded at a 

time. You can select modules one by one for upgrading, or you can select multiple modules of the same type 

at once, but you cannot select different types of modules for upgrading simultaneously. Once the upgrade is 

complete, be sure to reconnect the power and proceed with subsequent operations via USB. 
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Note: Currently, only coupler firmware upgrades are supported. Module firmware upgrades are not 

available at this time. 

7.12 Online monitoring 

 

As shown in the above figure, right-click the coupler in the project tree, select Online from the menu, and 

then select the corresponding serial port for the coupler in the pop-up window to start the online 

monitoring function. 
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After selecting the module you wish to monitor, you can view the real-time data in the Value column. 

 

 

To stop the online monitoring function, right-click the coupler or module, and select Offline in the menu. 
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7.13 Viewing logs 

 

The log viewing function is primarily designed to track records of key operations. 

7.14 Checking for updates 

 

 



INVT Flex Series I/O System User Guide  Common functions of Ttools-IO software 

202501 (V1.2）  296 

 

If there are updates available, a prompt will appear. Follow the instructions to download and then install the 

updates. 
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8 Fault code 

Fault 

code 

Fault code  

(in hex.) 
Fault Type Solution 

1 0x0001 Module configuration fault 

Ensure the correct mapping between 

module network configuration and 

physical configuration. 

2 0x0002 
Incorrect module parameter 

setting 

Ensure that module parameter settings are 

correct. 

3 0x0003 
Module output port power supply 

fault 

Ensure that the module output port power 

supply is normal. 

4 0x0004 Module output fault 
Ensure that the module output port load is 

within the specified range. 

18 0x0012 
Incorrect parameter setting for 

channel 0 

Ensure that the parameter settings for 

channel 0 are correct. 

20 0x0014 Output fault on channel 0 
Ensure that the output of channel 0 has no 

short circuit or open circuit. 

21 0x0015 
Signal source open circuit fault on 

channel 0 

Ensure that the signal source physical 

connection of channel 0 is normal. 

22 0x0016 
Sampling signal limit exceeding 

fault on channel 0 

Ensure that the sampling signal on 

channel 0 does not exceed the chip limit. 

23 0x0017 

Sampling signal measurement 

upper limit exceeding fault on 

channel 0 

Ensure that the sampling signal on 

channel 0 does not exceed the 

measurement upper limit. 

24 0x0018 

Sampling signal measurement 

lower limit exceeding fault on 

channel 0 

Ensure that the sampling signal on 

channel 0 does not exceed the 

measurement lower limit. 

34 0x0022 
Incorrect parameter setting for 

channel 1 

Ensure that the parameter settings for 

channel 1 are correct. 

36 0x0024 Output fault on channel 1 
Ensure that the output of channel 1 has no 

short circuit or open circuit. 

37 0x0025 
Signal source open circuit fault on 

channel 1 

Ensure that the signal source physical 

connection of channel 1 is normal. 

38 0x0026 
Sampling signal limit exceeding 

fault on channel 1 

Ensure that the sampling signal on 

channel 1 does not exceed the chip limit. 

39 0x0027 

Sampling signal measurement 

upper limit exceeding fault on 

channel 1 

Ensure that the sampling signal on 

channel 1 does not exceed the 

measurement upper limit. 

40 0x0028 

Sampling signal measurement 

lower limit exceeding fault on 

channel 1 

Ensure that the sampling signal on 

channel 1 does not exceed the 

measurement lower limit. 

50 0x0032 
Incorrect parameter setting for 

channel 2 

Ensure that the parameter settings for 

channel 2 are correct. 

52 0x0034 Output fault on channel 2 
Ensure that the output of channel 2 has no 

short circuit or open circuit. 

53 0x0035 
Signal source open circuit fault on 

channel 2 

Ensure that the signal source physical 

connection of channel 2 is normal. 
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Fault 

code 

Fault code  

(in hex.) 
Fault Type Solution 

54 0x0036 
Sampling signal limit exceeding 

fault on channel 2 

Ensure that the sampling signal on 

channel 2 does not exceed the chip limit. 

55 0x0037 

Sampling signal measurement 

upper limit exceeding fault on 

channel 2 

Ensure that the sampling signal on 

channel 2 does not exceed the 

measurement upper limit. 

56 0x0038 

Sampling signal measurement 

lower limit exceeding fault on 

channel 2 

Ensure that the sampling signal on 

channel 2 does not exceed the 

measurement lower limit. 

66 0x0042 
Incorrect parameter setting for 

channel 3 

Ensure that the parameter settings for 

channel 3 are correct. 

68 0x0044 Output fault on channel 3 
Ensure that the output of channel 3 has no 

short circuit or open circuit. 

69 0x0045 
Signal source open circuit fault on 

channel 3 

Ensure that the signal source physical 

connection of channel 3 is normal. 

70 0x0046 
Sampling signal limit exceeding 

fault on channel 3 

Ensure that the sampling signal on 

channel 3 does not exceed the chip limit. 

71 0x0047 

Sampling signal measurement 

upper limit exceeding fault on 

channel 3 

Ensure that the sampling signal on 

channel 3 does not exceed the 

measurement upper limit. 

72 0x0048 

Sampling signal measurement 

lower limit exceeding fault on 

channel 3 

Ensure that the sampling signal on 

channel 3 does not exceed the 

measurement lower limit. 
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9 EtherCAT functions 

9.1 Basic functions 

FK1100 ECT Coupler is an EtherCAT coupler that enables our Flex series expansion modules to connect to a 

high-speed EtherCAT network. In this way, Flex series expansion modules of different types can be 

configured an EtherCAT slave node, reducing the number of slave nodes connected. 

9.2 Object dictionary overview 

According to the definition of the standard protocol, the device object dictionary is uniformly divided, and 

all devices must be divided according to the rules of the protocol. The general structure allocation of the 

object dictionary is shown in the following table: 

Index Description 

0x0000–0x0FFF Data type 

0x1000–0x1FFF EtherCAT standard communication object dictionary 

0x2000–0x5FFF Manufacturer defined parameters 

0x6000–0x6FFF 
TxPDO, used to map the output process data of the expansion 

module. 

0x7000–0x7FFF 
RxPDO, used to map the input process data of the expansion 

module. 

0x8000–0x8FFF 
SDO, used for parameter configuration and status feedback of 

the expansion module. 

0xF000–0xFFFF 
Device description area, coupler configuration object 

dictionary 
 

9.3 Expansion module object dictionary allocation 

Each expansion module connected to the FK1100 ECT Coupler module is standardized as a module type, 

and the configuration parameters and process data of each module are instantiated as object dictionaries 

for management. The index of the module object dictionary is dynamically allocated and related to the 

location of the module. The object dictionary dynamic allocation range is as follows. 

Type Module 0 Module 1 Module n Module 31 

RxPDO mapping 0x1600 0x1601 0x1600+n*0x01 0x161F 

TxPDO mapping 0x1A00 0x1A01 0x1A00+n*0x01 0x1A1F 

TxPDO parameter 0x6000–0x607F 0x6080–0x60FF 0x6000+n*0x80–0x607F+n*0x80 0x6F80–0x6FFF 

RxPDO parameters 0x7000–0x707F 0x7080–0x70FF 0x7000+n*0x80–0x707F+n*0x80 0x7F80–0x7FFF 

SDO parameter 0x8000–0x807F 0x8080–0x80FF 0x8000+n*0x80–0x807F+n*0x80 0x8F80–0x8FFF 
 

Each Flex series expansion module connected to the EtherCAT coupler is assigned a unique object 

dictionary base value. This base object dictionary is used to calculate the dynamic allocation of PDO 

mappings, PDO data, and SDO parameters based on the slot position of the module. 

The calculation methods for the RxPDO and TxPDO mappings of expansion modules are as follows: 

Object dictionary index = Object dictionary base value + Module position n * 0x01 
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The calculation methods for the RxPDO parameters, TxPDO parameters, and SDO parameters of expansion 

modules are as follows: 

Object dictionary index = Object dictionary base value + Module position n * 0x80 

Note: Module position n is calculated starting from 0, representing the position number of the slot where 

the module is located. 

The object dictionary basic value distribution of Flex series is as follows. 

Module 

Object dictionary 

RxPDO 

mapping 

TxPDO 

mapping 

TxPDO 

parameter 

RxPDO 

parameter 

SDO 

configuration 

parameter 

SDO status 

parameter 

FL1001-1600DI - 0x1A00 0x6001 - 0x8001 0x8078 

FL1002-3200DI - 0x1A00 0x6002 - 0x8002 0x8078 

FL2201-0008DR 0x1600 0x1A00 0x6004 0x7004 0x8004 0x8078 

FL2102-0016DN 0x1600 0x1A00 0x6005 0x7005 0x8005 0x8078 

FL2002-0016DP 0x1600 0x1A00 0x6005 0x7005 0x8005 0x8078 

FL3003-4AD - 0x1A00 0x6015 - 0x8015 0x8078 

FL4003-4DA 0x1600 0x1A00 0x6019 0x7019 0x8019 0x8078 

FL3101-4PT - 0x1A00 0x6029 - 0x8029 0x8078 

FL3201-4TC - 0x1A00 0x602D - 0x802D 0x8078 
 

For example, the actual configuration is as follows. 

FK1100_ECT_Coupler + FL1001-1600DI + FL2102-0016DN + FL3003-4AD + FL4003-4DA + FL3201-4TC 

According to the object dictionary allocation rules, the object dictionary for this configuration is as follows. 

Module 

Object dictionary 

RxPDO 

mapping 

TxPDO 

mapping 

TxPDO 

parameter 

RxPDO 

parameter 

SDO configuration 

parameter 

SDO status 

parameter 

FL1001-1600DI 

slot 0 
- 0x1A00 0x6001 - 0x8001 0x8078 

FL2102-0016DN 

slot 1 
0x1601 0x1A01 0x6085 0x7085 0x8085 0x80F8 

FL3003-4AD slot 2 - 0x1A02 0x6115 - 0x8115 0x8178 

FL4003-4DA slot 3 0x1603 0x1A03 0x6199 0x7199 0x8199 0x81F8 

FL3201-4TC slot 4 - 0x1A04 0x622D - 0x822D 0x8278 
 

9.4 Expansion module scanning function 

The local bus protocol stack inside the FK1100_ECT Coupler has an automatic scanning function for 

modules, through this function the master node can directly scan and obtain the types and positions of the 

Flex series modules connected to the coupler module, and therefore directly determine the actual access 

module type of each slot, thus determining the configuration relationship of the modules. The configuration 

settings and scanning of modules are identified through the device identification code of the Flex series 

modules themselves. 

Each Flex series expansion module is assigned a unique device ID, which is a 32-bit long data. During the 

power-on initialization process, the FK1100_ECT_Coupler module queries the identification code of the 

expansion module in each slot, and then write them to into subindex 1 to subindex 32 of the 0xF050 object 

dictionary from slot 0 to slot 31. When the master node starts the scanning function, it reads the 0xF050 

object dictionary to obtain the device identification codes of the expansion modules connected to 
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FK1100_ECT_Coupler. Through these identification codes, the model of each module connected to each slot 

behind the coupler can be determined, thereby configuring the modules accordingly. 

Regardless of whether the master node obtains the module configuration through manual configuration or 

scanning, it must send the user-configured network configuration information to the coupler while the 

FK1100_ECT_Coupler module is still in the Pre_Operational state. Specifically, the master node must write 

the identification codes of the Flex series modules detected in slot 0 to slot 31 into subindex 1 to subindex 32 

of the 0xF030 object dictionary in sequence. The FK1100_ECT_Coupler will check whether the device 

identification codes in index 0xF030 match those in index 0xF050. If they match, the system can start 

normally; if they do not match, an error will be reported. 

The device identification codes for the modules are as follows: 

Expansion module Module ID identification code 

FK1100_ECT_Coupler 0x16315000 

FL1001-1600DI 0x16315052 

FL1002-3200DI 0x16315053 

FL2201-0008DR 0x16315069 

FL2102-0016DN 0x1631505A 

FL2002-0016DP 0x16315062 

FL3003-4AD 0x16315081 

FL4003-4DA 0x16315089 

FL3101-4PT 0x163150A1 

FL3201-4TC 0x163150A9 
 

9.5 Fault diagnosis 

Indicator Description Handling method 

PWR Off 
Coupler 24V power supply 

exception 

1. Check whether the module power connection is 

secure. 

2. Assess whether the power supply capacity is 

sufficient. 

RUN 

Off 
No data in EtherCAT 

communication 

1. Check whether the physical connection between 

the master and slave is secure. 

2. Check whether the slave node address matches. 

Blinking 
EtherCAT communication 

not in OP state 

1. The SDO data volume is large, and the master 

node's performance in sending SDO data is 

insufficient, causing the slave node to remain in 

the Pre-Operational state for a long period of time. 

2. Check whether the configuration is consistent. 

SF Blinking Configuration mismatch 

1. Check whether the physical configuration and 

network configuration are consistent. 

2. Perform an automatic scan to check whether the 

scanned physical configuration matches the actual 

physical configuration and network configuration. 

This can help determine whether any module is 

damaged. 
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Appendix A Address mapping table 

descriptions 

A.1 Function code planning 

Supported function codes: 01, 02, 03, 04, 05, 06, 15, 16, 23 

A.1.1 Function codes in Modbus standard 

Function 

code 
Name Definition Operation type 

1 Read Coils Read coils Bit operation (multiple) 

2 Read Discrete Inputs Read discrete inputs Bit operation (multiple) 

3 Read Holding Registers Read holding registers Word operation (multiple) 

4 Read Input Registers Read input registers Word operation (multiple) 

5 Write Single Coil Write a single coil Bit operation (single) 

6 Write Single Register Write a single holding register Word operation (single) 

15 Write Multiple Coils Write multiple coils Bit operation (multiple) 

16 Write Multiple Registers Write multiple holding registers Word operation (multiple) 

23 Read/Write Multiple 
Registers Read/Write multiple holding registers Word operation (multiple) 

A.1.2 BIT access 

A.1.2.1 BIT read 

02: Read Discrete Inputs / Read discrete input status/bit operation (multiple) 

This function code allows for bitwise read operations on all digital input modules configured, with address 

offsets starting from 0 and following the configuration order. 

A.1.2.2 BIT write 

 01: Read Coils / Read coil status/bit operation (multiple) 

 05: Write Single Coil / Write single coil/bit operation (single) 

 15: Write Multiple Coils / Write multiple coils/bit operation (multiple) 

These three function codes allows for bitwise write operations or read back on all digital output modules 

configured, with address offsets starting from 0 and following the configuration order. 
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A.1.3 WORD access 

A.1.3.1 WORD read 

 04: Read Input Registers / Read input registers/word operation (multiple) 

 23: Read/Write Multiple Registers / Read/Write multiple holding registers/word operation (multiple) 

Note: The read and write operations for function 23 do not map to the same address. 

These two function codes allows for word-wise read operations on the input data of all configured modules. 

The digital input module can perform bit operations using function code 02, as well as word operations here 

(offset address 4096). The error diagnostic information for all modules is also mapped to address 8192. 

 The parameters of the analog modules are offset sequentially from address 0 according to the 

configuration order. 

 The parameters of the digital modules are offset sequentially from address 4096 according to the 

configuration order. 

 The error diagnostic information parameters for all modules are offset sequentially from address 8192 

according to the configuration order. 

A.1.3.2 WORD write 

 03: Read Holding Registers / Read holding registers/word operation (multiple) 

 06: Write Single Register / write single holding register/word operation (single) 

 16: Write Multiple Registers / Write multiple holding registers/word operation (multiple) 

 23: Read/Write Multiple Registers / Read/Write multiple holding registers/word operation (multiple) 

Note: The read and write operations for function 23 do not map to the same address. 

These four function codes allows for word-wise write operations or read back the output data of all 

configured modules. The digital input module can perform bit operations using function code 15, as well as 

word operations here (offset address 4096). The master node should not perform both bit write operations 

and word write operations on the same digital output simultaneously, as this will cause conflicts. 

 The parameters of the analog output modules are offset sequentially from address 0 according to the 

configuration order. 

 The parameters of the digital output modules are offset sequentially from address 4096 according to 

the configuration order. 

A.2 Address mapping table 

A.2.1 Address allocation 

A.2.1.1 Area 

The address space is divided into four address regions according to the planned access method. 

1. BIT read:  

0–2048; Digital input module 

2. BIT write: 
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0–2048; Digital output module 

3. WORD read: 0–12288;  

0–4095: Corresponding to the analog input module 

4096-8191; Corresponding to the digital input module 

8192–12287: Corresponding to diagnostic information, including error codes for the module 

4. WORD write: 0–8192; 

0–4095: Corresponding to the analog output module 

4096-8191; Corresponding to the digital output module 

A.2.1.2 Module address count table 

No. 

Function code 02 
01, 05, 

and 15 
04, 23 

03, 06, 16, 

23 
04, 23 

03, 06, 

16, 23 
04, 23 

Offset address 0 0 0 0 4096 4096 8192 

Function 

Input Bit 
Output 

Bit 

Input 

Word 

Output 

Word 

Input 

Word 

Output 

Word 

Input 

Word 

DI DO AI AO DI DO Diag 

0 FK1400  

1 FL1001_1600DI 16 - - - 1 - 1 

2 FL1002_3200DI 32 - - - 2 - 1 

3 FL2002_0016DP - 16 - - - 1 1 

4 FL2003_0032DP - 32 - - - 2 1 

5 FL2102_0016DN - 16 - - - 1 1 

6 FL2103_0032DN - 32 - - - 2 1 

7 FL2201_0008DR - 16 - - - 1 1 

8 FL5005_1616DP 16 16 - - 1 1 1 

9 FL5105_1616DN 16 16 - - 1 1 1 

10 FL3003_4AD - - 4 - - - 4 

11 FL3404-8ADV - - 8 - - - 8 

12 FL3504-8ADI - - 8 - - - 8 

13 FL3103_4PT - - 8 - - - 4 

14 FL3203_4TC - - 8 - - - 4 

15 FL4003_4DA - - - 4 - - 4 

16 FL6112_2EI - - 17 9 - - 2 

17 FL6121-1EI - - 11 7 - - 1 

18 FL6002-2ES - - 17 5 - - 2 
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A.2.1.3 Example 

Configuration: total number of modules: 18 

No. 

Function code 02 
01, 05, 

and 15 
04, 23 

03, 06, 

16, 23 
04, 23 

03, 06, 

16, 23 
04, 23 

Offset address 0 0 0 0 4096 4096 8192 

Function 

Input 

Bit 
Output Bit 

Input 

Word 

Output 

Word 

Input 

Word 

Output 

Word 

Input 

Word 

DI DO AI AO DI DO Diag 

0 FK1400  

1 FL1001_1600DI 0–15 - - - 0 - 0 

2 FL1002_3200DI 16–47 - - - 1–2 - 1 

3 FL2002_0016DP - 0–15 - - - 0 2 

4 FL2003_0032DP - 16–47 - - - 1–2 3 

5 FL2102_0016DN - 48–63 - - - 3 4 

6 FL2103_0032DN - 64–95 - - - 4–5 5 

7 FL2201_0008DR - 96–111 - - - 6 6 

8 FL5005_1616DP 48–63 112–127 - - 3 7 7 

9 FL5105_1616DN 64–79 128–143 - - 4 8 8 

10 FL3003_4AD - - 0–3 - - - 9–13 

11 FL3404-8ADV - - 4–11 - - - 14–21 

12 FL3504-8ADI - - 12–19 - - - 22–29 

13 FL3103_4PT - - 20–27 - - - 30–33 

14 FL3203_4TC - - 28–35 - - - 34–37 

15 FL4003_4DA - - - 0–3 - - 38–41 

16 FL6112_2EI - - 36–52 4–12 - - 42–43 

17 FL6121-1EI - - 53–63 13–19 - - 44 

18 FL6002-2ES - - 64–80 20–24 - - 45–46 

 

A.3 Additional notes 

The address range for accessing the above function codes is calculated based on the configuration. If it 

exceeds the actual configured address range, an 'Illegal data address' error will be reported during access. 

Function code 23 reads data from the 'WORD read' area, not from the 'WORD write' area. Therefore, if the 

master node supports function code 23, it can read and write input and output data simultaneously, 

improving communication efficiency. 
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